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We take pride in providing you the perfect sewing
experience!

BERNINA has represented exceptional quality since 1893. As a traditional Swiss company,
we use high quality materials to manufacture our products and have them extensively
tested, ensuring high performance and a long life. Over the years, we have always
remained true to our company philosophy - we are personally committed to offering our
customers an exceptional sewing experience.

Every BERNINA is characterized by state-of-the-art technology paired with innovations in
both hardware and software. This is because we truly want you to enjoy the creative
process to the fullest - after all, creativity is turning your ideas into something that makes
you and others happy.

With this in mind, | wish you many joyous moments with your BERNINA 990.

/(P/dww‘a/{

Sincerely, yours
Hanspeter Ueltschi
Owner, BERNINA
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Please be aware of the following basic safety
instructions when using your machine. Before
using this machine, read instruction manual
carefully.

DANGER

To protect against electric shock, the
following instructions must be observed:

» Never leave the machine unattended
when it is connected to the power supply.
Immediately after use and before cleaning,
switch off the machine and disconnect the
power cable from the outlet.

In order to protect against injury, the
following instructions must be adhered to:

» Do not look directly into the laser beam or
view it with optical instruments (e.qg.
magnifying glasses).

If the laser is damaged or defective, have
the laser checked or repaired by your local
BERNINA dealer.

» Do not look directly into the LED lamp
with optical instruments (e.g. magnifying
glass).

If the LED lamp is damaged or defective,
have the LED lamp checked or repaired at
your local BERNINA dealer.

» Switch off the machine before working in
the needle area.

» Before starting the machine, close all
covers.

WARNING

To reduce the risk of burns, fire, electric shock
or personal injury, the following instructions
must be observed.

General Facts

» This machine may only be used for the
purpose described in this instruction
manual.

Working Environment

» Do not use the machine outdoors.

» Only use the machine in dry rooms.

» Do not use the machine in a humid area.

» Do not use the machine in rooms where
aerosol products (sprays) are being used.

» Do not use the machine in rooms where
oxygen is dispensed.

Technical Condition
» Never use the machine when it is damp.

» Do not use the machine if it is not working
properly.

» Do not use the machine if a cable or the
plug is damaged.

» Do not use the machine if it has been
dropped, damaged or has fallen into
water.

» If the machine is damaged or does not
work properly, have the machine checked
or repaired by your local BERNINA dealer.

» Keep all ventilation openings of the
machine and the foot control free of lint,
dust and loose cloth.

Do not use the machine if the ventilation
openings are blocked.

Accessories and Supplies

» Only use the accessories recommended by
the manufacturer.
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Always use an original BERNINA Stitch
Plate.

An incorrect stitch plate can result in
needle breakage.

Use only straight needles of good quality.
Bent or damaged needles can cause
needle breakage.

The machine is double-insulated.
Only use original spare parts. See
instructions for servicing of double-
insulated products.

To lubricate the machine, only use oil
recommended by BERNINA.

Risk of chemical burns and ingestion. Keep
the battery out of the reach of children.
This machine contains a lithium button cell
battery. If a new or used lithium button
cell battery is swallowed or ingested, this
can cause serious internal injuries and can
be fatal within two hours. The battery
compartment must therefore always be
kept securely closed. If it is not possible to
securely close the battery compartment,
stop using the machine, remove the
battery and keep it out of the reach of
children. If you suspect that batteries have
been swallowed or ingested, consult a
doctor immediately.

Appropriate Use

>

>

The machine may be used, cleaned and
maintained by children older than eight or
by people with reduced physical, sensory
or mental capabilities or if there is a lack
of experience and knowledge.
Furthermore, these persons must be
supervised while working with the
machine, or they must know the safe
operation of the machine and be aware of
resulting hazards.

Children are not allowed to play with the
machine.

Special care should be taken when the
machine is operated by or in the presence
of children.

Only use the machine with the supplied
power cable.

USA and Canada only: Do not connect
power plug NEMA 1-15 to circuits
exceeding 150 volt-to-ground.

If the machine is to be used in a country
other than the country of origin, obtain a
power cable suitable for this country from
a BERNINA dealer.

Only use this machine with the supplied
foot control of type LV-1.

Do not insert any objects into the
openings of the machine.

Do not place any objects on the foot
control.

While sewing, guide the fabric gently.
Pulling and pushing the fabric can cause
needle breakage.

Keep fingers away from all moving parts.
Special care is required in the needle area.

Only lift the machine by the handle.

For activities in the needle area — such as
threading the needle, changing the
needle, threading the looper or changing
the presser foot — switch off the machine.

To switch off, set the power switch to «0».

When protective covers are removed,
when the machine is oiled or when other
cleaning and maintenance operations
mentioned in this instruction manual are
carried out, switch off the machine and
disconnect the power plug from the
outlet.

Pull the plug out of the outlet by pulling
on the plug. Do not pull on the cable.
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SAFE THESE
INSTRUCTIONS

Safety Signs on the
Machine

Sign Purpose

Attention: Close the doors, lids and
covers before operating the
machine.

Caution; moving parts. To reduce
the risk of injury, switch off the
machine before maintenance work.
Attach the covers.

Warning regarding chemical burns
Chemical Burn Hazard Swallowing the batteries may result

Kaap batteries away froe childran.

b in severe internal chemical burns.

Make sure that the batteries do not
fall into the hands of children.

FCC Declaration of Conformity

(For USA and Canada)

Responsible Company: BERNINA International AG,
Seestrasse 161, 8266 Steckborn, SCHWEIZ

Product Name: BERNINA 990

This device satisfies the provisions of Section 15 of the
guidelines of the American Federal Communications
Commission (FCC). Operation of this device is subject
to the following conditions: (1) This device must not
cause harmful interference, and (2) this device must
accept any interference received, including interference
that may cause undesired operation.

This device has been tested and, according to the speci-

fications in Paragraph 15 of the FCC regulations, is

compliant with the limit values for a digital Class B

device. These specifications define appropriate

protection against such interference in closed rooms.

This device can generate, use and radiate HF energy.

Therefore, if not installed and used properly, it may

cause harmful interference to radio communications.

There is, however, no guarantee that interference will

not occur in certain situations. If this device does cause

harmful interference to radio or television reception,
which can be determined by turning the device off and
on, the user should try to correct the interference by
one or more of the following measures:

m Reorient the antenna or set it up at a different
location.

m Increase the spacing between the equipment and
receiver.

m  Connect the equipment into an outlet on a circuit
different from that to which the receiver is
connected.

m  Contact your BERNINA dealer or an experienced
radio/television technician.

Any change or modification to the device that has not
been expressly approved by BERNINA can invalidate the
electromagnetic compatibility (EMC) and result in the
revocation of the operating license for this device.
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Availability of the Instruction
Manual

BE The instruction manual is supplied with the

. machine.

m  Keep the instruction manual safe at a
suitable place near the machine to have it at hand
in case that you need to look up something.

m If you pass the machine to a third party, always
include the instruction manual.

m The latest version of the instruction manual can be
downloaded at www.bernina.com/990-support.

Proper Use

Your BERNINA machine is conceived and designed for
private household use. It is intended for sewing fabrics
and other materials as described in this instruction
manual and on the machine. Any other use is not
considered proper. BERNINA assumes no liability for
consequences resulting from improper use.

Equipment and Scope of Delivery

E Example images are used in these instructions
i for the purposes of illustration. The machines
# and the accessories shown in the images
therefore do not always match the actual items
included with your machine. The supplied accessory
can vary depending on the country of delivery. Acces-
sories mentioned or shown, which are not included in
the scope of delivery, can be purchased as optional
accessories from a BERNINA dealer. Further accessories
can be found at www.bernina.com/990#!accessories.

For technical reasons and in order to improve the
product, changes may be made to the equipment of
the machine and the scope of delivery at any time and
without prior notice.

Of2

BERNINA Quality Control

All BERNINA machines are assembled with utmost care
and are subjected to an extensive functionality test. The
integrated stitch counter therefore indicates that the
machine has already sewn stitches, which were
performed exclusively for test purposes and quality
control. The subsequent thorough cleaning does not
exclude the possibility that thread remnants may still be
found in the machine.

Servicing of Double-insulated
Products

In a double-insulated product two systems of insulation
are provided instead of grounding. No grounding
means is provided on a double-insulated product nor
should a means for grounded be added to the product.
Servicing a double-insulated product requires extreme
care and knowledge of the system and should only be
done by qualified service personnel. Replacement parts
for a double-insulated product must be identical to the
original parts in the product. A double-insulated
product is marked with the words: Double-Insulation or
double-insulated.

[0 The symbol may also be marked on the product.

Environmental Protection

BERNINA International AG is committed to environ-
mental protection. We strive to minimize the environ-
mental impact of our products by continuously
improving product design and our manufacturing
technology.

The machine is labeled with the symbol of the
ﬁ crossed-out wastebin. This means that the
EEEE  machine should not be disposed of in
household waste when it is no longer needed.
Improper disposal can result in dangerous substances
getting into the groundwater and thus into our food
chain, damaging our health.
The machine must be returned free of charge to a
nearby collection point for electrical waste and
electronic equipment or to a collection point for the
reuse of the machine. Information on collection points
can be obtained from your local administration. When
purchasing a new machine, the dealer is obliged to
take back the old machine free of charge and dispose
of it properly.
If the machine contains personal data, you are
responsible for deleting the data yourself before
returning the machine.
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Explanation of Symbols

Designates a danger with a high risk which can lead to
serious injuries or even death unless it is avoided.

Designates a medium-risk hazard which can lead to
serious injuries if not avoided.

/\ CAUTION

Designates a low-risk hazard which can lead to minor
or moderate injuries if not avoided.

NOTICE

Designates a hazard which can lead to material
damage if not avoided.

TIP
Tips from the BERNINA sewing experts.
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With your BERNINA 990 you can sew, embroider and
quilt. Fine silk or satin fabrics as well as heavy linen,
fleece and denim fabrics can be sewn on this machine
with no problem at all. Numerous practical as well as
decorative stitches, buttonholes and embroidery
designs are at your disposal.

Further Information

mation products are also enclosed.

The current version of your manual as well as
further information about the machine and the acces-
sories can be found on our website.

bernina.com

"Made to Create" is the BERNINA slogan. Not only do
our machines support you as you make your ideas a
reality, we offer additional suggestions and instructions
for projects and the opportunity to exchange ideas with
other sewing, quilting and embroidery enthusiasts. We
hope you have a great pleasure in doing so.

Egm In addition to your BERNINA 990, further infor-

BERNINA YouTube Channel

i On YouTube we offer a wide range of how-to
Hi videos and support concerning the most
important functions of our machines. You can
also find detailed explanations of presser feet and

accessories that make your projects successful.
youtube.com/Berninalnternational
Available in English and German.

"inspiration” - the Creative Sewing Magazine and
Online Store with Sewing Patterns

#E Are you looking for ideas, sewing patterns and
i instructions for great sewing projects? If so, the
BERNINA magazine “inspiration” is just the
right thing for you. Three times a year, “inspiration”
offers you great sewing and embroidery ideas. From
seasonal fashion trends to trendy accessories and
practical tips to original decorations for your home or
cute sewing ideas for children.
The magazine is available in English, German, Dutch,
and French.

In our online shop you can purchase "inspiration" as an
e-magazine or as a print version, either as individual
issues or as a subscription. Furthermore, there are many
individual downloadable patterns to discover! Why not
take a look at:

inspiration.bernina.com

And follow us on Instagram (@inspi-
ration.sewing.magazine).

BERNINA Blog

£E Sophisticated instructions, free sewing patterns
E;} and embroidery designs as well as many new

¥ ideas can be found weekly on our BERNINA
Blog. Our experts give useful tips and step by step
instructions to achieve your desired results. In the
community you can upload your own projects and
exchange experiences and ideas with other sewing and
embroidering enthusiasts.

bernina.com/blog
Available in English, German, Dutch and French.

BERNINA Social Media

events, exciting projects and tips and tricks all
about sewing, quilting and embroidering. We
will keep you informed and are looking forward to
sharing highlights from the world of BERNINA.

bernina.com/social-media

BERNINA World App

E@E Download the BERNINA App to your

. smartphone and enjoy direct access to all
product information. The accessory organizer
gives you an overview of your accessories and those
you would like to have. Furthermore, you have direct
access to the customer portal, the blog and the "inspi-
ration" online store, and you can always find a
BERNINA dealer near you. The app is available in the
Apple App Store and the Google Play Store.

bernina.com/app

s

BERNINA Stitchout App

wE WiFi enabled BERNINA embroidery machines
i# can be used together with the BERNINA

" Stitchout App. Once the machine is connected
to the app, the embroidery process can be tracked and
monitored via the smartphone. The app shows how far
the embroidery design has progressed, which color will
be next and how long the embroidery process will take
in total. Furthermore, messages are displayed for the
case that the thread is broken or the embroidery is
finished. The app is available in the Apple App Store
and the Google Play Store.

bernina.com/stitchout-app



https://www.bernina.com
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2.1 Machine

Front

1 Embroidery Module Connection 2 Bobbin Cover 3 Needle Area 4 Thread Cutter 5 Thread Take-up Lever
Cover 6 Speaker 7 Connection for Slide-on Table 8 Knee Lifter Connection

Needle Area Bobbin Area

BERNINA

= N

1 Needle Threader 2 Lighting 3 Needle Holder 1 Bobbin Case 2 Thread Cutter 3 Bobbin Case
4 Needle 5 Presser Foot 6 Connection for Sewing Holder 4 Bobbin Thread Indicator
Accessories 7 Stitch Plate 8 Feed Dog
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Right Side

1
- I— 5
: l 6
L I 7

|

1 Magnetic Holder for Touchscreen Pen 2 Handwheel 3 Air Vents 4 Power Switch 5 Connection for Power
Cable 6 USB Port, Type C 7 USB Port, Type A 8 Connection for Foot Control

Back

w bh oo

1 Air Vents 2 Connection for Multiple Spool Holder 3 Spool Pin Unit, Vertical 4 Spool Pin, Horizontal 5 Bobbin
Winding Unit with Thread Cutter 6 Retractable Thread Guide 7 Carry Handle 8 Thread Guide, Winder

9 Opening for Thread Lubrication Unit 10 Thread Guide, Rear 11 Connection for Accessory 12 BSR Connection
13 BERNINA Dual Feed 14 Connection for Darning Hoop
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Controls

= e —

BERNINA

1 External Buttons above the Needle 2 Left Controls 3 Display 4 Right Controls

External Buttons above the Needle

1 Automatic Needle Threader 2 Start/Stop 3 Thread
Cutter 4 Presser Foot Up/Down 5 Quick Reverse
Sewing

Thread Cutter

You can use the Thread Cutter >< button to cut the
upper thread and the bobbin thread automatically.

If necessary, the machine is stopped, the needle and
presser foot are lowered, the upper thread and lower
thread are cut.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Automatic Needle Threader

You can use the Automatic Needle Threader
button to thread the needle automatically.

The Start/Stop ce button is deactivated and lights up
red. The upper thread is threaded into the needle.

If the needle is in the incorrect position, the needle will
first be moved to the correct position.

Start/Stop
You can use the Start/Stop ©e button to start or stop
the machine.
Lights up green when the machine is ready.
m Lights up red when the machine is not ready.
m  Does not light up when the machine is sewing or
embroidering.

Presser Foot Up/Down

You can use the Presser Foot Up/Down {{? button to
raise or lower the presser foot.

Depending on the starting position, the presser foot is
either raised all the way up or lowered to the hover
position.

You can define the hover position height in the
Settings.
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Quick Reverse Sewing

You can use the Quick Reverse Sewing |J button to
sew in reverse while the button is pressed.

In the Settings, you can program whether the Reverse
option or the Backstep option should be executed.

In the following applications, you can program the
length by pressing the Quick Reverse Sewing |J
button:

m  Buttonhole Programs

Darning Programs

Tapering Stitches

Stitch Counter Program
Stitches with Securing Program

Left Controls

2

1
|
i

1 Needle position Up/Down 2 Securing Stitches
3 Pattern Begin 4 Pattern End 5 Speed Control

Securing Stitches

You can use the Securing Stitches ©5- button to sew
a programmable number of securing stitches.

If you press the button before sewing, securing stitches
will be sewn at the beginning of the seam.

If you press the button during sewing, securing stitches
will be sewn immediately and the machine will stop.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Needle position Up/Down

You can use the Needle position Up/Down [/}
button to raise or lower the needle.

Depending on the starting position, the needle will be
raised or lowered. If the presser foot is raised, the
presser foot will first be lowered.

Pattern Begin

You can use the Pattern Begin 4 button to return to
the beginning of a stitch pattern or a stitch pattern
combination.
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With some functions, e.g., buttonholes, darning,
tapering, the machine starts the pattern at the first
segment.

Pattern End

You can use the Pattern End 4 _ button to stop the
machine automatically at the end of a stitch pattern or
a stitch pattern combination.

If you press the button before sewing, the button is
activated and the Stop @ icon is displayed in the stitch
preview.

If you press the button during sewing, the machine will
stop at the end of the pattern. If the machine is
stopped in the middle of a pattern the pattern will
complete when sewing is resumed. If Repeat 4 x has
been set, the machine will stop at the end of the set
repeat.

TIP

In the Sewing Settings External Buttons, you can
assign additional functions to the button.

Speed Control

You can regulate the sewing speed via the speed
control.

For a better monitoring while sewing, you can adjust
the maximum sewing speed in the settings.

Right Controls

1 Upper Multi-function Knob 2 Lower Multi-function
Knob 3 Needle Position Left/Right

Upper Multi-function Knob

You can use the Upper Multi-function Knob for setting
the Stitch Width and the values of a function.

Lower Multi-function Knob

You can use the Lower Multi-function Knob for setting
the Stitch Length and the values of a function.
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Needle Position Left/Right

You can use the Needle Position Left/Right
buttons to move the needle to the left or to the right.
The needle position is shown on the sewing screen.
Negative values indicate a movement to the left,
positive values a move to the right.

2.2 Accessories

@ Further information and application notes on
the supplied and optional accessories can be
found under:

www.bernina.com/990#!accessories

22
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Accessories Purpose

Foot Control To start and stop the machine.

To control the sewing speed.

Included Accessories

Accessories Purpose

Dust Cover To protect the machine from

dust and contamination.

Slide-on Table To increase the sewing

surface.

BERNINA Acces- To store supplied and optional

Seam Guide for
Slide-on Table

To aide in guiding the fabric
along the Slide-on Table.

sories Box accessories.
—
EEEE |
=¥
H -
Power Cable To connect the machine with

the power supply.

Knee Lever/Free For raising and lowering the
Hand System (FHS)  presser foot free hand.

Retractable Thread  To guide the thread correctly
Guide when threading.
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Accessories

Touchscreen Pen

—
9 BERNINA j-

Purpose

For precise operation of the
touchscreen.

Accessories

Thread Spool Net

16

Purpose

To regulate threads that
unwind too quickly from the
spool, e.g. nylon, rayon, silk or
metallics.

Spool Cap D12

l.{

Secures the thread spool in
place and allows it to unwind
consistently while sewing.

Spool Cap D27

Secures the thread spool in
place and allows it to unwind
consistently while sewing.

5x Bobbin for B9/
BERNINA Hook

To wind the bobbin thread.

Spool Cap D43

Secures the thread spool in
place and allows it to unwind
consistently while sewing.

Straight and
CutWork Stitch
Plate with Sensor

For straight stitch and
embroidery projects.

For CutWork and CrystalWork
projects.

4x Foam Pad

The foam pad prevents the
thread from slipping, tangling
or breaking on the spool pin.

5.5 mm BISR Stitch
Plate with Sensor

&0

A

+

For sewing with the BERNINA
Integrated Stitch Regulator
(BISR).

Spool Stabilizer

To support large spools on the
vertical spool holder.

To avoid vibrations from the
spool.

Height Compen-
sation Tool

To level an angled position of
the presser foot sole when
sewing over thick seams.
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Accessories Purpose

Seam Ripper To undo seams and to cut

buttonholes open.

".r"

id

Right Seam Guide

e

Accessories

Screwdriver, gray,
Torx

17

Purpose

To change the needle.

To align even seam distances.

Needle Assortment  For the most common sewing

Thread Lubrication

Unit

For sewing and embroidering
metallic threads.

applications.
e
Brush To clean the feed dog and the
bobbin area.

Sewing Machine
QOil

To oil the machine.

Screwdriver, red, To loosen and tighten slotted

slot screws.

|
RN
USB Stick To save and transfer data,
stitch and embroidery designs
and update files.
T
| f—

Sewing Thread Set

For sewing.
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Included Presser Feet

Presser Foot

Reverse Pattern
Foot #1C

e,
N, i )

Presser Foot

Purpose Zipper Foot #4D

For forward and backward
feeding utility and decorative
stitches.

For materials such as
corduroy, denim or wool.
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Purpose

For sewing in zippers,
topstitching next to raised
seams.

For sewing on braids, piping
and hook and loop fastener.

Use only with the BERNINA
Dual Feed.

Reverse Pattern
Foot #1D

S TR

For forward and backward
feeding utility and decorative
stitches.

For materials such as
corduroy, denim or wool.

For sewing blindstitch hems,
edgestitching and topstitching
on either side of the foot.

To work with the BERNINA
Dual Transport.

Button-Sew-on
Foot #18

-~ )

For visible seams on stretch
fabrics.

For overlock and neatening
seams.

For sewing on buttons, hooks
and eyelets/rings.

Open Embroidery
Foot #20C

Buttonhole Foot
with Slide #3A

. a
,--:T

For automatic buttonholes
with a maximum length of
30 mm, with or without cord.

For decorative sewing
applications and stitch
patterns.

Sideways-Motion
Foot #40C

Buttonhole
Foot #3C

-

Ao

For the sewing of manual and
stitch counted buttonholes,
with or without a filler cord.

For gathering using thread or
elastic thread (smocking).

For sewing Sideways Motion
patterns and stitches in
various directions.
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Embroidery Module

/

BERNIn

M

i 2
3
[

1 Embroidery Arm 2 Coupling for Securing the Hoop
3 Guide Rails 4 Connection to the Machine

Accessories

Large Oval
Embroidery Hoop
(incl. embroidery
template)

C %
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Purpose

For embroidering designs and
design combinations.

Max. Embroidery Area: 145 x
255 mm (5.7 x 10.0 in)

Included Embroidery Accessories

Accessories

Purpose

Medium
Embroidery Hoop
(incl. embroidery
template)

W . 5
\g\ e

e

For embroidering designs and
design combinations.

Max. Embroidery Area: 100 x
130 mm (3,9 x 5,1 in)

Dust Cover To protect the Embroidery
Module from dust and
contamination.

Embroidery For embroidering, darning and

Foot #26L free hand quilting.

s
v

Small Embroidery

Hoop (incl.
embroidery
template)
2N
D o -
T

To embroider small
embroidery designs.

For free arm embroidering
with closed sewing projects
such as sleeves, trouser legs or
socks.

Max. Embroidery Area: 72 x
50 mm (2.8 x 2.0 in)

Giant Hoop (incl.
embroidery
template)

To embroider embroidery
designs, embroidery design
combinations or endless
embroidery.

Max. Embroidery Area: 305 x
410 mm (12.0 x 16.1 in)

6x Template Holder

To fix the template in the
embroidery hoop.

4x Fabric Clamp

For fixing the fabric to the
outer frame of the Giant
Hoop.
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Accessories Purpose

Embroidery Needle
Assortment

For embroidering.
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Operation with Touch Gestures

Thread Spool Net To regulate threads that
unwind too quickly from the
spool, e.g. nylon, rayon, silk or

metallics.

Gestures with Application

One Finger

Tap m  Select functions, stitch

i pattern or embrodery

db design

Tap and Hold m  Open context menu in the

mo File Manager and

@ Embroidery Design
Overview

Drag m  Scrolling in Menus,

&

Windows and Bars

m  Drawing Stitches in the
Stitch Designer

High Thread Increase the lower thread
Tension Bobbin tension for machine
Case

embroidery and free-motion
quilting.

Embroidery Thread

Set
=
Al
m

For embroidering.

2.3 User Interface Overview

User Interface Operation

The software can be operated with the touch-sensitive
screen using touch gestures or the included touch-
screen pen.

Tap and Hold and
Drag
o

O

= Move or delete selected
stitches in Combi Mode

m  Move selected layers in
the Embroidery Screen

m  Delete layers from the
layer bar in Embroidery
Mode

Gestures with Application

Two Fingers

Move Apart m  Zoom the preview in, e.g.
IQ\«B in the Stitch Designer
Move Together m Zoom the preview out,
*Q{B e.g. in the Stitch Designer
Move m  Move the preview of the

embroidery design in the
embroidery screen

Operation with Mouse

You can also operate the user interface with a mouse
connected into a USB connection.

= Single Left-click

A single left-click works in the same way as tapping
with a finger throughout the entire user interface.
You can click to select elements, menus and

windows.

m Left-click and Hold

By pressing and holding the left mouse button on
an embroidery design, you can open the context

menu.
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By pressing and holding the left mouse button on a
stitch pattern or embroidery design in the file
manager, you can display further information
about the stitch pattern or embroidery design.

m  Right-click and Hold and Move
By holding down the right mouse button and
moving the mouse, you can move the preview in
the Embroidery Screen, in the Stitchout and in the
Stitch Designer.

= Mouse Wheel

You can use the mouse wheel to zoom and scroll in
the Sewing and Embroidery Screen, in the
Stitchout, in the Stitch Designer, in the File
Manager and other screens with a scroll bar.

Navigation

To go back step by step to a previous screen use the
Navigation Path located on the Navigation Bar. Find
Navigation Paths in the Help Center, Settings and File
Manager. With the Back <— function, you can go
back step by step.

Activating/Deactivating Functions
You can switch functions on and off as follows:
m  Tap the Switch

«

= Green: Function is switched on.

= White: Function is switched off.
m  Tap lcons

= Blue: Function is switched on.

= Gray: Function is not available.

= Yellow Bar: Function or value deviates from the
default value.

= Red: Warning.

Setting Values
You can set values as follows:
m  Slider

N\
{ —

Set the value with the slider control or reset the
value to the default by tapping the small bullet.
= Plus and Minus Icons
+ —

= Multi-function Knobs

The knob icon that appears solid white identifies
which knob modifies the value.
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Modified values are marked in yellow. You can reset a
modified value to the default by tapping the yellow
field.

Selection Options

With the Selection Options [ ][~] function, you can
define whether you want to select an individual object,
multiple objects or all objects.

1 Single Selection 2 Multiple Selection 3 Select All

Home Screen

Main Menu — » Home Screen ()

1 2 3 4 5 6

BERNINA

1 Sewing 2 BERNINA Integrated Stitch Regulator
3 Embroidery 4 Help Center 5 Settings 6 Main
Menu

Modes

The main modes give you quick access to the most
important functions of your machine.

Sewing
In Sewing [z] mode, you will find the functions you
need for practical and creative sewing.

BERNINA Integrated Stitch Regulator

In BERNINA Integrated Stitch Regulato mode,
you can sew and quilt with the integrated stitch
regulation. [P see page 72]

Embroidery

In Embroidery () mode, you will find functions for
creative machine embroidery and computerized
quilting. [» see page 79]
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Help Center

In Help Center &5 mode, you will find frequently
requested instructions and information, the Onboard
Manual and Creative Consultant for various sewing,
embroidery and quilting techniques. Connect to your
device with WiFi connectivity to use the Help Center on
an external device. [P see page 24]

Settings

In Settings 14t mode, you can adjust various functions
in sewing and embroidery, carry out simple
maintenance operations and update the machine
firmware.

Main Menu

The Main Menu provides shortcuts to quickly navigate
to the following modes from any screen.

Home Screen
Main Menu — » Home Screen )

With the Home Screen (Y menu entry, you can return
to the Home Screen. [P see page 21]

Clear
Main Menu — » Clear CLR

The Clear C| R menu entry resets the following settings
to the default values:

Sewing Mode

m  Stitch Length and Stitch Width of the Selected
Stitch

Needle Position

Mirroring

Long Stitch

Pattern Repeat

Balance

Directional Sewing

Jumbo Stitch

Stitch Density

Upper Thread Tension
Programmed Buttonhole Length
Darning Program Settings
Tapering Stitches
Backstepping

Stitches with Stitch Counter
Presser Foot Selection
Continuous Reverse
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Embroidery Mode

Design Position

Rotation

Scaling

Mirroring

Stitch Density

Presser Foot Selection
Shape Designer

Thread Color Modifications

Quick Help
Main Menu = » Quick Help (®
With the Quick Help (?) function, you can tap any

screen element and receive help on its use. [P see
page 23]

Lock
Main Menu — » Lock &

With the Lock (& function, you can lock the screen and
the sewing functions. With the Lock Sewing
Functions function, the motor will be blocked and the
machine cannot be started.

1. To lock the screen, tap Lock & .
2. To unlock the screen, swipe up and tap Unlock & .

Settings
Main Menu = » Settings tit

With the Settings 74t function, you can open the
Settings directly. [» see page 43]

Sewing
Main Menu = » Sewing

With the Sewing i function, you can open sewing
mode. [P see page 49]

BERNINA Integrated Stitch Regulator
Main Menu — » BERNINA Integrated Stitch

With the BERNINA Integrated Stitch Regulator &
menu entry, you can open the BISR Mode. [P see
page 72]

Embroidery
Main Menu = » Embroidery

With the Embroidery () function, you can open
embroidery mode. [» see page 79]
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Help Center
Main Menu = » Help Center &F

With the Help Center 55 function, you can open the
Help Center. [P see page 24]

File Management

In the File Manager, you can manage your own stitch
patterns and designs in the Personal Folder © and
USB Stick f folders. You can create folders and move,
copy, rename and delete files and folders.

Renaming a File or Folder

1. Tap the Fullscreen ] icon in the toolbar to
display the management options.

2. Tap the Selection (¢ icon.
3. Tap the desired object.
= The object is marked with a check mark.
4. Tap the Options : Rename icon.
5. Enter the name and confirm.

Copying or Moving a File or Folder

1. Tap the Fullscreen ] icon in the toolbar to
display the management options.

2. Tap the Selection (¢ icon.

3. Tap the desired objects.
= The objects are marked with a check.

4. Tap the Options : » Copy or Options ¢ » Cut
icons.

5. Navigate to the target folder.

6. Tap the Options $ » Paste icon.

= As soon as the process is complete, a message
appears.
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Delete Files or Folder

1. Tap the Fullscreen ] icon in the toolbar to
display the management options.

2. Tap the Selection [? icon.
3. Tap the desired objects.
= The objects are marked with a check.
4. Tap the Options ¢ » Delete icon.
5. Confirm the query.

2.4 Help and Consultant

Quick Help
Main Menu = » Quick Help (®

You can use the Quick Help () function to open the
Quick Help for many screen elements, such as icons,
buttons or entire screen areas.

1. Tap the Quick Help () menu item.

2. Tap the screen element for which help is required.
= The Quick Help for the screen element appears.
= If there is further information on the screen

element in the operating instructions, a link is
displayed that calls up the Help Center.
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Help Center

Quick Start

Main Menu = » Help Center &) » Quick Start 4

Prepa:

1 Search 2 Navigation Bar 3 Selection of Topics

You can use the Quick Start 4 function to access
frequently searched instructions and information.

Instruction Manual

Main Menu = » Help Center &F » Instruction
Manual (&
1 2 3 4 5

Threading the Single Neodle

1 Search 2 Navigation Bar 3 Table of Contents
4 Content Area 5 QR Code

You can use the Instruction Manual [ function to
access the contents of your machine's user manual.

If your tablet is on the same WiFi network as your
machine, you can display the content on the tablet by
tapping the QR Code icon and scanning the QR code.
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Consultant
Main Menu = » Help Center 8 » Consultant 8
1 2 3 4 5 6 78

1 Search 2 Navigation Bar 3 Fabric Selection
4 Supplies 5 Preparations 6 Tutorial 7 QR Code
8 Apply Settings

You can use the Consultant 8 function to obtain
recommendations for preparing and setting the
machine and corresponding tutorials for various
sewing, embroidery and quilting techniques. Settings
with a white circle can be applied automatically using
Apply Settings / icon.

If your tablet is on the same WiFi network as your
machine, you can display the content on the tablet by
tapping the QR Code icon and scanning the QR code
on the machine's screen.
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3.1 Prior to Machine's First Use

TIP

BERNINA recommends lubricating the hook before
using the machine for the first time or after a longer
period of non-use. [» see page 100]

Lubricating the hook keeps the machine running
smoothly and quietly.

Removing the Protective Film on the
Battery

Your BERNINA 990 contains a battery, which ensures
that the clock continues to run, even if the machine is
switched off and disconnected from the power supply.
The protective film must be removed before the battery
can be used.

1. Carefully set down the machine on its back.

2. Pull the protective film on the battery out of the
battery compartment.

@ -

3. Set Up the machine.

3.2 Working Area

A stable table with a secure stand is a good prereq-
uisite for optimal sewing results. Ergonomics of the
sewing table is important to protect the muscles and
joints of the back, shoulder, arms and hands. The
recommendation for optimal ergonomics includes
matching the table height with the body posture. Avoid
remaining in the same position for long periods.

The machine can also be operated when standing.

Correct Sitting Position

With the arms bent (90°), the fingertips can touch the
stitch plate in a comfortable sitting position.

3.3 Connecting the Machine and
Switching it On

1. Insert the cable into the machine.

E
|
|-\

Ll . |

—

2. |Insert the power plug of the power cable into the
socket.

3. Switch on the machine using the power switch.

3.4 Preparing the Machine for
Sewing

For your sewing project, you must prepare and set the
machine accordingly.
Prerequisite:
m  The machine is switched on.
m  The sewing settings have been made. [} see
page 44]
m  The foot control is connected. [P see page 26]

1. Attach the Slide-on Table if required. [P see
page 27]

2. Attach the Knee Lifter. [» see page 29]

3. |If the Embroidery Module is connected and is not
to be removed, move the embroidery hoop to the
sewing position. [P see page 43]

4. Remove the embroidery hoop. [P see page 42]

5. Select Sewing Mode via the main menu or the
Home Screen. [P see page 21]

= The Sewing Screen appears. [» see page 49]
6. Use a suitable stitch plate. [» see page 29]
Use a suitable sewing needle. [} see page 32]
8. Attach and select a suitable presser foot. [P see
page 40]
9. Prepare and edit stitch pattern. [» see page 61]
10. Thread a suitable bobbin thread. [» see page 38]
11. Thread a suitable upper thread. [ see page 34]

N
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TIP

For special sewing techniques and fabrics, the
Consultant will recommend a presser foot, stitch
plate and needles as well as fabrics and sewing
settings. [P see page 24]
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TIP

You can perform additional functions via the heel
pressure. You can configure the functions in the
Sewing Settings. [» see page 46]

Connecting the Foot Control

3.5 Preparing the Machine for
Embroidery

N

For your embroidery project you must prepare and set
the machine accordingly.

Prerequisite:

The machine is switched on.

The embroidery settings have been made. [P see
page 47]

1.

Unwind the cable of the foot control to the desired
length.

Insert the plug of the cable into the foot control
socket of the machine.

-

Fi 1’_‘-

1. Select Embroidery Mode via the main menu or the
Home Screen. [P see page 21]
= The Embroidery Screen appears. [P see
page 79]
2. Remove the Knee Lifter.
3. Insert the Straight Stitch Plate. [» see page 29]
4. |Insert a suitable embroidery needle. [» see 3.
page 32]
5. Attach and select a suitable embroidery foot. [P see 4.
page 40]
6. Attach the Embroidery Module. [» see page 42]
7. Attach the suitable hoop. [P see page 42]
8. Prepare and edit embroidery designs. [P see
page 83]
9. Thread a suitable bobbin thread. For a higher

bobbin thread tension, use a bobbin case with a
high thread tension. [P see page 38]

10. Thread a suitable upper thread. [P see page 34]

TIP

For special embroidery techniques and fabrics, the
Consultant will recommend an embroidery foot,
stitch plate and needles as well as fabrics and
embroidery settings. [P see page 24]

3.6 Foot Control

You can operate the front foot control with the ball of
your foot and the rear foot control with your heel. With
the ball pressure, you can start and stop the machine.
Depending on the force you apply to the foot control,
you can regulate the sewing speed. With the heel
pressure, you can raise or lower the needle.

Place the Foot Control on the floor in a
comfortable position for sewing.

If the cable is too long, roll up excess length.
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3.7 Storing Accessories

The accessories box provides tidy storage for your
accessories.

123 4

1 Holder for Needle Sets 2 Holder for Presser Feet
without Lens 3 Bobbin Holder with Spring Button
4 Compartment for Buttonhole Foot with Slide #3A
5 Holder for Presser Feet with Lens 6 Drawer, Small
7 Drawer, Large

1. Unfold the feet and stand up the accessories box.
2. Open the doors.

-
-
/ﬁ. SR L
K3
l |

1 i

/

—

3. If necessary, insert the holders into the grooves in
the accessories box.

NOTICE

Incorrect storing of the bobbin

Scratched or dirty sensor surfaces on the bobbins can

cause malfunctions of the lower thread indicator.

» Always position the bobbins in the bobbin holder
with the silver sensor surface to the right.
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4. Place your accessories in the appropriate holders
and compartments.

5. To remove a bobbin, press the spring button down.
6. Store small parts in the drawers.

3.8 Slide-on Table

The slide-on table allows you to enlarge the sewing
area. This makes it easier to position and work on your
sewing project. The viewing window allows for visual
access to the bobbin area while changing the bobbin
without having to remove the table. The table has a
printed ruler in both centimeters and inches to aide in
aligning various projects. The zero center is aligned
with the center needle position when attached.

= D W=aN-=

)

1 Adjustable Leg with Adjusting Screw 2 Viewing
Window 3 Ruler 4 Unlock Button

Attaching the Slide-on Table

1. Raise the needle.
2. Raise the presser foot.

3. Release the adjustable legs on the Slide-on Table.
Make sure that the adjusting screws are not turned
out too far.



My BERNINA

3 Set Up the machine

4. Slide the table over the freearm under the needle
and foot to the right until it engages on the right
side.

5. Fully extend the legs of the table.

6. Adjust the height by turning the screw at the feet.
Ensure the table is flat and supported on the
surface below without raising it above the freearm.

7. To remove the Slide-on Table, press the release
button down and remove the Slide-on Table from
right to left under the needle and presser foot.

F-___ e .——

8. Lock the legs into place for storage.
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Using the Seam Guide

The Seam Guide for the Slide-on Table allows you to
sew along the guide for unifom seams.

1 Release Button

Prerequisite:
m The Slide-on Table is attached.

1. To attach the Seam Guide, press the release button
and engage the Seam Guide from the front to the
back on the Slide-on Table.

2. Press the release button down once attached and
position in place as desired.

3. To remove the Seam Guide, press the release
button and pull the Seam Guide away to the front.

3.9 Knee Lifter / Free Hand
System

With the Knee Lifter, you can raise and lower the
presser foot without taking your hands away from your
sewing project.

If the presser foot is raised, you can also lower the
presser foot using the Knee Lifter.
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Working with the Knee Lifter offers the following

advantages:

m  When the presser foot is raised with the Knee
Lifter, the feed dog is lowered at the same time
and the thread tension is released, enabling you to
easily move or remove your sewing project.

m  When the presser foot is lowered using the knee
lever, the feed dog is raised after the first stitch
and, if necessary, the thread tension is activated so
that you can continue sewing quickly and easily.

Using the Knee Lifter

Attaching the Knee Lifter of the Free Hand System

1. Insert the Knee Lifter into the Knee Lifter
Connection as far as it will go.

2. Adjust the sitting height so that the Knee Lifter can
be comfortably operated with the knee.

TIP

The lateral position of the lever can be adjusted by
your local BERNINA dealer if required.

Raising the Presser Foot

1. Push the Knee Lifter to the right and hold it there
with your knee.

= The presser foot is raised and the feed dog is
lowered.

2. Release the Knee Lifter slowly to lower the presser
foot.

= The presser foot is lowered and the feed dog is
raised.

Lower the Presser Foot

» When the presser foot is raised, push the Knee
Lifter all the way to the right and slowly release it.
= The presser foot is lowered, the feed dog is

raised and the thread tension is activated.

3.10 Stitch Plate

The supplied 9 mm stitch plate is suitable for most
sewing work. For specific applications, e.g. PunchWork,
special stitch plates are used. The special stitch plates
are marked with a color code.

=  Without color code: 9 mm Stitch Plate

m  Orange: Straight and CutWork Stitch Plate
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m  Yellow: PunchWork Stitch Plate
m  Blue/purple: 5.5 mm BISR Stitch Plate

Vertical lines are engraved on each stitch plate, which
you can use as a ruler for guiding the fabric in a
straight line. You can use the diagonal lines to align the
fabric at a precise 45° angle. You can use the
horizontal lines to lay the fabric at the specified
distance from the needle.

N O
NN
N\ N\ 2%

\\\\ J] ///

1 Pressure Point for Release 2 Fabric Placement
3 Needle Position 4 Ruler in cm 5 Ruler in inches
6 Color Code 7 Sensor

Changing the Stitch Plate

Prerequisite:
m  The needle and the presser foot are raised.

1. Lock screen and sewing functions.
2. Remove the needle and presser foot.
3. Press the stitch plate down at the pressure point for

release on the right until it tips.

4. Remove the stitch plate.
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5. Place the openings of the new stitch plate above
the corresponding guide pins and press the stitch
plate down until it clicks into place.

BERNINA

6. Unlock sewing functions and screen.

= The machine recognizes the new stitch plate
and displays it in the Status Bar.

= The machine checks the compatibility of the
stitch plate with the attached needle and the
selected stitch. If the stitch cannot be sewn
with the attached stitch plate, the stitch is
shown in red in the stitch preview and the
machine will not start.

3.11 Needle

Only use needles from the 130/705 system for your

machine. Select a needle thickness that is suitable for

the selected fabric: Fine needles for fine fabrics, thick

needles for heavy fabrics.

m  Needle sizes 70, 75: Lightweight fabrics

m  Needle sizes 80, 90: Medium fabrics

m  Needle sizes 100, 110 and 120: Heavyweight
fabrics

There are different needle types for different sewing
projects. You can identify the needle type and needle
size by the needle name, e.g. 130/705 H-S/70:

1 2 5 3 4

1705 =shank 2130 =shank length 3 H = groove
4 S = Point Type 5 70 = Needle Size

Detailed information on needles and their applications
can be found in the BERNINA Needle Brochure.
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Needles become worn over time. Needles should be
replaced regularly, as a clean stitch can only be made
with a sharp tip.

Needle/Thread Combination

The needle/thread combination is correct if
the thread is guided exactly into the long
groove and through the eye of the needle.

4
If the thread is too thin for the needle, it will
have too much room to move in the long
groove and in the eye of the needle. This
L can result in the thread breaking or skipping

A stitches.

If the thread is too thick for the needle, it
will be difficult to guide it through the eye
of the needle and it may rub along the edge
of the long groove. This can result in the
thread breaking and sticking in the needle.

Needle Overview

Needle Purpose

Universal Needle  For woven fabrics (light,
130/705 H medium, heavy-weight),
60/8 — 120/19 knitwear, leather, vinyl, jeans/

— denim. For natural and
. synthetic fabrics.

, _ For general sewing, sewing on
With a sllgh.tly buttons and buttonholes,
rounded point. zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Stretch Needle For knitwear (jersey, tricot,

130/705 H-S knit and stretch material).

75/11 —90/14 For general sewing, sewing on

————c 5> — buttons and buttonholes,
zippers, hems and
topstitching, decorative

With a medium ball sewing, embroidery.

point.
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Needle

Jersey/
Embroidery
Needle

130/705 H SUK
80/12
T
|

With a medium ball
point.

Purpose

For woven fabrics (light,
medium, heavy-weight),
knitwear, vinyl.

For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery.

Jeans Needle
130/705 H-J

80/12 - 110/18
= —
[ |

With a slim sharp
point.

Woven fabrics (light, medium,
heavy-weight), leather, jeans/
denim.

For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Needle

Embroidery
Needle

130/705 H-E

75/11 -90/14
o> =
|

With a light ball
point and a partic-
ularly wide eye and
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Purpose

For woven fabrics (light,
medium, heavy-weight),
knitwear. For thicker threads.
For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery.

Leather Needle
130/705 H LR
90/14, 100/16
N G —
[ |

With cutting tip.

For leather, imitation leather
and similar materials.
For zippers, hems and

topstitching, materials that
tend to stick.

wide groove.
Fine Fabrics For fine, delicate materials,
Needle such as velvet.

130/705 H SES
70/10 - 90/14
I T —
=

With a light ball
point.

For general sewing, sewing on
buttons and buttonholes,
zippers, hems and
topstitching, decorative
sewing, embroidery,
patchwork, quilting.

Sharp Microtex
Needle

130/705 H-M
60/8 - 110/18
- ——
|

With a very slim
sharp point.

For woven fabrics (light,
medium, heavy), plastics,
materials that are difficult to
glide such as silk, microfiber
fabrics, vinyl, coated materials.

For general sewing, sewing on
buttons and buttonholes, zips,
hems and topstitching and
decorative sewing. For straight
stitches when topstitching
edges.

Metafil Needle

130/705 H METAFI
L

80/12
I ———
|

With medium ball
point and long eye
(2 mm).

For woven fabrics (light,
medium, heavy-weight),
knitwear. For sewing with
special effects and fancy
threads, especially metallic
threads.

For embroidery with metallic
thread. For hems and
topstitching, decorative
sewing and embroidery.

Quilting Needle
130/705 H-Q

75/11 -90/14
R G e —
|

With a very slim,
slightly rounded
point.

For woven fabrics (light,
medium and heavy-weight).
Decorative sewing,
patchwork, quilting. For
stitching/topstitching tasks,
such as quilting and
patchwork.

Topstitch Needle
130/705 H-N

80/12 - 100/16
= T > —

With medium ball
point and long eye
(2 mm).

For woven fabrics (light,
medium and heavy-weight).

For hems and topstitching,
decorative sewing and
embroidery. For decorative
and quilting work with several
sewing threads and also for
embroidery.

Felting needle
PUNCH
T
With small barbs.

For woven fabrics (light,
medium, heavy-weight), jeans/
denim.

For felting a variety of yarns
and threads into base fabrics.
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Needle Purpose

Hemstitch Needle For woven fabrics (light,
130/705 H WING medium and heavy-weight).

100/16, 120/20 For special effects in
decorative sewing and

embroidery with hemstitching.

=

With a "wing" on
each side of the
needle.

Universal Twin For visible hems in stretch

Needle fabrics, pintucks, decorative
130/705 H ZW!I sewing.
70-100
[
;ug
X

Needle distance:
1.0/ 1.6/ 2.0/ 2.5/
3.0/4.0/6.0/8.0

For visible hems in stretch
fabrics, pintucks, decorative
sewing.

Stretch Twin
Needle

130/705 H-S ZWI
75

'_,

;|JQ
X

Needle distance:
2.5/4.0

Hemstitch Twin
Needle

130/705 H ZWIHO
100

—
C I

L_F
=
Needle distance:
2.5

For special effects with
hemstitch embroidery.

For visible hems in stretch
fabrics, decorative sewing.

Universal Triple
Needle

130/705 H DRI
80

—

—] e
]

Needle distance:
3.0
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Changing the Needle

1. Raise the needle.

2. Lock screen and sewing functions.

3. Loosen the screw on the needle using the gray Torx
Screwdriver and pull the needle out in a downward
direction.

4. Insert and push the new needle with the flat side to
the back as far up as it will go into the needle
holder and hold it in place.

5. Tighten the screw.

6. Unlock sewing functions and screen.

7. In the Status Bar, tap Stitch Plate and Sewing
Needle (2§ and select the fitted needle in the
Needle Overview section. [P see page 32]

Stitch Plate and Sewing Needle
Sewing {f » Stitch Plate and Sewing Needle (0§

1 2 3 4 56

Single Needle

1 Detected Stitch Plate 2 Selected Needle 3 Needle
Overview 4 Stitch Plate Overview 5 Needle Minder
6 View Recommended

The attached Stitch Plate is automatically recognized
and shown in the Status Bar and in the Detected
Stitch Plate section.
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The stitch plates and needles compatible with the 1. Insert the retractable thread guide into the opening
machine are displayed in the Stitch Plate Overview provided and press it down firmly until it sits
and Needle Overview sections. securely.

Recommended stitch plates and needles are shown
with the Recommended vy icon.
In order to verify the compatibility of the stitch plate,
presser foot and needle, you must select the attached
needle in the Needle Overview section. The selected ll
needle is shown in the Selected Needle section and in =
the Status Bar. If the selected needle can no longer be Z
used with the stitch plate or the presser foot, an error S 1
message is dsiplyed. I | — h !'—i-=
liananian?

Recommended

With the Recommended Y% function, you can filter

the overview by recommended stitch plates and 2. Flip over the guide and engage it in the groove.

needles. Align the thread guide in such a way that the three
rear eyelets lie exactly above the three vertical spool

Needle Minder pins.

With the Needle Minder sz function you can note the
needle type and needle size of the attached needle. If
you have forgotten which needle is attached, you can
look it up at any time.

Needle Position

You can adjust the position of the needle in various

ways:

m Button Needle position Up/Down [} : To raise or
lower the needle.

= Buttons Needle Position Left/Right . : To move

the needle 5 positions to the left or to the right of 3. Pullthe thread guide up as far as it will go. While
the center. doing so, rotate the rod slightly so that the locking

cams engage.

m  Status icon Needle Stop § : To adjust the needle
position up or down when stopping the machine in I

sewing mode. ~dla

s« U

Uso

J

3.12 Attaching the Retractable
Thread Guide

BERNINA recommends using the two left vertical spool
pins for sewing and stitching in conjunction with the
retractable thread guide. The retractable thread guide
ensures a clean unwinding of the thread from the
spools.
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3.13 Upper Thread

The quality, thickness and material of the thread must
be suitable for the selected fabric. BERNINA
recommends purchasing high-quality threads to
achieve optimum sewing results.

m  Cotton threads are particularly suitable for sewing
decorative projects on cotton fabric, such as quilts.
As cotton threads are not particularly tear-resistant,
they can also be used for basted seams that are
later undone. They should not, however, be used
for seams that need to be particularly hard-
wearing.

m  Mercerized cotton threads have a slight sheen that
remains even after washing.

m Polyester threads have a high tensile strength and
are particularly colorfast. Polyester threads are more
flexible and are recommended where a strong and
elastic seam is required.

m  Rayon/viscose threads are characterized by their
bright sheen. Rayon threads are suitable for
decorative stitches and create a more beautiful
effect.

Threading the Single Needle

In order to get a proper stitch and prevent threads from
becoming tangled, the upper thread must be threaded
correctly.

The direction in which the thread should be threaded is
marked on the machine with solid arrows and is
numbered according to the correct sequence.

Prerequisite:

m The retractable thread guide is attached. [P see
page 33]

m A foam pad is attached to each of the vertical spool
pins.

1. Raise the presser foot so that the thread tension
discs are open and the thread can slide easily
between them.

2. Raise the needle so that the thread can be easily
inserted into the thread take-up lever.

3. Lock screen and sewing functions.
4. Place the spool on the center vertical spool pin.
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5. Pull the thread upward and through the two thread
guides lying vertically above it in the thread guide.

i | / ’ ')/

6. Guide the thread through the thread eyelet from
right to left.

At

7. Hold the thread with your right hand and, with
your left hand, pull the thread taut under and
through the thread guide to the front of the
machine.
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8. Guide the thread on the right downward past the
thread tension disc.

9. Guide the lower thread upward around the thread
take-up lever cover.

10. Guide the thread through the thread take-up lever
and guide it downward. Make sure that the thread
is guided under the left side panel.
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11. Guide the thread behind the two thread guides in
the needle area.

Damage to the Automatic Needle Threader or the

Needle

Thin needles can break when using the automatic

needle threader.

The threading hook of the automatic needle threader

can be damaged.

» Only use the automatic needle threader with
needles of size 70 and above.

» Always thread size 60 needles by hand.

12. Guide the thread from back to front around the
thread cutter and trim the thread.

13. Unlock sewing functions and screen.
14. Press the Automatic Needle Threader < button.
= The thread is threaded into the needle.

Notes on the Automatic Needle Threader

m  The Automatic Needle Threader is only suitable for
threading a single needle. Always thread twin
needles and triple needles by hand.

m  The Automatic Needle Threader is suitable for
needles of size 70 and above. Thread thinner
needles by hand.

m  The Automatic Needle Threader is not compatible
with the following presser feet. If you are using one
of these presser feet, thread the needle by hand.



My BERNINA

3 Set Up the machine

= Punch Tool #45

= Walking Foot #50

= Leather Roller Foot #55

= Adjustable Ruler Foot #72

= Binder Attachment #85

= Ruffler #86

= Foot for Cut 'n’ Sew Attachment #90

Threading the Twin Needle

To thread a twin needle, thread both threads one after
the other according to the instructions for the single
needle. Start with the left needle. [» see page 34]

Note the following differences:

Prerequisite:

m A foam pad is attached to each of the vertical spool
pins.

1. Place the spool for the right needle on the center
spool pin and the spool for the left needle on the
left spool pin.

2. Guide both upper threads up to the thread tension
disc in the same way as threading the single
needle.

3. At the thread tension disc, guide the thread for the
left needle down the left and the thread for the
right needle down the right of the thread tension
disc.

4. Guide the threads up to the needle in the same
way as threading the single needle.

5. Thread both needles by hand.

Threading the Triple Needle

To thread a triple needle, thread the three threads one
after the other according to the instructions for the
single needle. Start with the left needle. [P see

page 34]
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Note the following differences:

Prerequisite:

m A foam pad is attached to each of the vertical spool
pins.

1. Place the spool for the left needle on the left spool
pin, the spool for the center needle on the center
spool pin and the spool for the right needle on the
right spool pin.

2. Guide the threads up to the needle in the same
way as threading the single needle.

3. At the thread tension disc, guide the thread for the
left needle down to the left and the threads for the
right and center needle down to the right of the
thread tension disc.

4. Guide the threads up to the needle in the same
way as threading the single needle.

5. Thread all needles by hand.

Threading Special Threads

Special threads such as loosely twined threads and
metallic threads can be difficult to thread and use. The
Thread Lubrication Unit and the special silicone fluid
prevent delicate threads from tearing or breaking and
making them easier to use.

1. Insert the Thread Lubrication Unit in the opening
provided and moisten the felt surfaces with a little
silicone fluid.
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2. Insert the thread between the felt surfaces of the
Thread Lubrication Unit.

3. Guide the thread to the needle in the same way as
threading the single needle. [ see page 34]

4. Thread the needle by hand.

Using the Horizontal Spool Pin

On the horizontal spool pin, a foam pad and a spool
cap ensure that the thread is unwound properly. The
foam pad prevents the spool from rotating too quickly.
The spool cap ensures that the spool pin is held in place
and the thread is unwound from the spool without
becoming tangled. Spool caps are available in different
sizes.

1 Foam Pad 2 Thread Spool 3 Spool Cap

1. Place the foam pad on the spool pin.
2. Place the thread spool on the spool pin.

3. Select a spool cap with the same diameter as the
spool and place it on the spool pin. The spool
should not rotate. The thread should unwind

properly.
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4. For slippery threads put a spool net over the spool
as an additional measure.

5. Guide the thread directly to the rear thread guide
and continue threading. [P see page 34]

3.14 Bobbin Thread

For general sewing, we recommend using the same
thread for the upper thread and the lower thread.
Consult the Creative Consultant for thread recommen-
dations with various applications and fabrics.

Bobbin Winding

The direction in which the bobbin thread should be
spooled is indicated on the machine with broken lines
and numbered accordingly.

1. Place an empty bobbin on the bobbin winder so
that the silver sensor surface is facing downward.

U\{
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2. Place the spool on the right vertical spool pin. 6. Wind the thread 2 — 3 times around the bobbin in
3. Pull the thread upward and insert it from back to the direction of the arrow and cut it using the
front in the two thread guide eyelets directly thread cutter on the engaging lever.

above.

4. Guide the thread through the thread eyelet from
right to left.

X \ﬁ' lll

= As the bobbin starts to wind, the speed can be
adjusted on the screen.

= The winding indicator is displayed in the Status
Bar.

5. Guide the thread around the bobbin winder pre-

tension in the direction of the arrow. o . '
= The winding will stop automatically when the

bobbin is full.
8. To stop before the bobbin is full, simply engage the
lever to the right to pause.
9. Remove the bobbin and cut the thread using the
thread cutter.

Threading the Bobbin Thread

Raise the needle.

Raise the presser foot.

Lock screen and sewing functions.
Open the bobbin cover.

PwWN =
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5. Press the latch on the right of the bobbin case and 9. Pull the thread through under the spring and under
remove the bobbin case. the two thread guides.

a;

—

o

6. Remove the bobbin from the bobbin case. 10. When inserting the bobbin case, hold the bobbin
7. Insert the new bobbin so that the silver sensor case so that the wire of the thread guide points
surface lies inside the bobbin case. upward.

11. Insert the bobbin case. Press the left side of the
bobbin case until the bobbin case engages.

8. Guide the thread through the slot to the left.

13. Close the bobbin cover.
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3.15 Presser Foot

Raising/Lowering the Presser Foot

The presser foot is automatically lowered at the start of
sewing.
» Press the Presser Foot Up/Down {{? button.

= Depending on the starting position, the presser
foot is either raised or lowered to the hover
position.

TIP

If the presser foot is raised, you can also lower the
presser foot using the Knee Lifter.

Changing the Presser Foot

Raise the needle.
Raise the presser foot.
Lock screen and sewing functions.

Press the clamping lever up and pull the presser
foot downward to the side.

PWN =

5. Guide the new presser foot into the holder from
below and press the clamping lever down.

6. Unlock sewing functions and screen.

7. Tap the Presser Foot | icon and select in the
Presser Foot Overview the attached presser foot.
[» see page 40]

Attach the BERNINA Stitch Regulator
(BSR)

Prerequisite:
m  The screen and sewing functions are locked.

40

1. Attach the BSR Presser Foot.

T T

2. |Insert the cable of the presser foot into the BSR
connection.

3. Unlock sewing functions and screen.

= The BSR Mode function is switched on and
the BSR Settings are displayed.

Presser Foot Selection
Sewing # » Presser Foot {I_

1 23 4

1 Selected Presser Foot 2 Search 3 Recommended
4 Presser Foot Overview
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The presser foot recommended for the selected stitch
or embroidery design is displayed in the status bar.

The presser feet compatible with the machine are
displayed in the Presser Foot Overview section.

Recommended presser feet are marked with the
Recommended Yy icon.

In order for the machine to check the compatibility of
the stitch, presser foot, needle and stitch plate, you
must select the attached presser foot in the Presser
Foot Overview section. The selected presser foot is
shown in the Selected Presser Foot section and in the
Status Bar.

If the stitch pattern or the embroidery design is not
compatible with the selected presser foot, this can lead
to collisions - an error message will appear, the stitch in
the stitch preview is shown in red and the machine
does not start.

Search

With the Search O function, you can search for the
attached presser foot by entering the presser foot
number.

Recommended

With the Recommended Y% function, you can filter
the overview by recommended presser feet.

Presser Foot Pressure
Sewing #§ » Presser Foot Pressure ¥

The presser foot pressure has a default setting for
working with medium fabrics. When working with
thick fabrics, a reduced presser foot pressure enables
the fabric to be moved more easily beneath the presser
foot. When working with thin fabrics, a higher presser
foot pressure prevents the fabric from slipping easily.
We recommend testing the setting before you start. If
the fabric moves with some resistance, you can reduce
the presser foot pressure. If the fabric slips easily
beneath the presser foot, you can increase the presser
foot pressure.

Help on finding the optimum presser foot pressure for
various fabric types and sewing techniques can be
found in Consultant in the Help Center.
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3.16 Fabric Feed

Feed Dog

The feed dog moves the fabric under the presser foot.
To ensure that the fabric is fed evenly, the presser foot
must be positioned horizontally. To compensate for the
seam height, you can place one or more height
compensation plates behind or in front of the needle
under the presser foot as required.

The feed dog can be lowered for applications in which
the fabric is to be guided freely.

In sewing mode, you can lower and raise the feed dog

In embroidery, BISR and BSR mode, the feed dog is
lowered automatically.

Dual Feed

The BERNINA Dual Feed feeds the upper fabric while
the feed dog controls the bottom layer. This ensures a
more even feed for many applications, including:

m  Sewing seams and zippers

Managing difficult fabrics such as: velvet, satins
Matching pattern repeats, stripes and checks
Knits and Fleece

Patchwork: Accurate piecing, quilting and binding

Note: The BERNINA Dual Feed can only be used with
presser feet with the designation D.

Switching On/Off the BERNINA Dual Feed

Engaging the BERNINA Dual Feed

1. Raise the presser foot.
2. Attach a D presser foot.
3. Push the dual feed down until it engages.
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Disengaging the BERNINA Dual Feed

1. Raise the presser foot.

2. Pull the dual feed downward and let it slide
backward and up.

3.17 Embroidery Module

Connecting and Removing the
Embroidery Module

Connecting the Embroidery Module

Prerequisite:

m  The work area is large enough and has sufficient
load-bearing capacity for the machine and the
embroidery module.

m  There is enough space for the embroidery arm to
move freely.

1. Lift the embroidery module on the left side.

2. Push and lower the embroidery module carefully
from left to right into the embroidery module
connection of the machine.
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NOTICE

Lifting or moving the machine when the

Embroidery Module is connected

Damage to the embroidery module connection and

machine.

» Before lifting or moving the machine, detach the
embroidery module.

Removing the Embroidery Module

» Lift the embroidery module on the left side and
carefully pull it to the left.

Preparing the Embroidery Hoop

Prepare the embroidery hoop according to the hoop
instructions. You can download the instructions for
embroidery hoops at www.bernina.com.

Attaching and Removing the Hoop

Attaching the Hoop

1 Attaching Mechanism 2 Hoop

1. Raise the needle.
2. Raise the presser foot.

3. Hold the hoop with the right side of the fabric up
with the attaching mechanism to the left.

4. Position the hoop below the presser foot.
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5. Squeeze both attaching mechanisms of the hoop
towards each other.

6. Position the embroidery hoop above the bracket of
the embroidery arm.

7. Press the hoop down until it clicks in position.

8. Release the attaching mechanism.

9. Select the embroidery hoop on the machine. [P see
page 43]

10. Before using the embroidery hoop for the first time
or if the needle position and the center of the
embroidery hoop are not aligned, calibrate the
embroidery hoop on the machine. [P see page 47]

Removing the Embroidery Hoop

1. Squeeze both attaching mechanisms of the hoop
towards each other.

2. Remove the hoop.

Hoop Overview
Embroidery (O » Hoop O

1 Selected Hoop 2 Hoop Relocation 3 Hoop
Selection

Selected Hoop

The attached hoop is automatically recognized and
shown against a dark background in the Status Bar and
in the Selected Hoop section.

If no embroidery hoop has been attached, an
embroidery hoop matching the size of the embroidery
design is preselected in the Hoop Selection section.
The selected hoop is shown against a light background.
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Hoop Relocation

In the Hoop Relocation area, you can move the

attached hoop to certain positions.

s Centered (-) : For easier threading of the needle.

= Sewing Position () : For sewing without having
to remove the embroidery module. If a hoop is
attached, you will be prompted to remove the
hoop.

m At the Rear () : To easily access the bobbin area.

Hoop Selection
The hoops compatible with the machine are displayed
in the Hoop Selection section.

To prepare the embroidery design, you can select a
suitable embroidery hoop before attaching the hoop.

3.18 Machine Settings

Machine Name
Settings 4+ » Machine &F » Information » Identifi-
cation » Machine Name

With the setting you can enter the name under which
the machine is displayed in a WiFi network.

Data Usage

Settings 41 » Machine &) » Information » Data
Usage

With the setting Data Usage you can agree or object

to the use of anonymized usage data by BERNINA for
product improvement.

Monitoring Functions
Settings 4t » Machine 8 » Monitoring Functions

The machine has monitoring sensors that warn you if
the upper or bobbin thread has broken or run out.
With the Monitoring Functions setting, you can
switch the Upper Thread Indicator and the Bobbin
Thread Indicator on or off.

Sound
Settings 4t » Machine &T » Sound

With the setting Sound, you can generally activate and
deactivate the acoustic signals.

If acoustic signals are activated in general, you can

make the following adjustments:

= Sound <) : To adjust the volume of the signals.

m Stitch Selection [7]) : To select different acoustic
signals and to switch the acoustic signal on and off.
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m  Functions and Icons // : To select different
acoustic signals and activate and deactivate the
acoustic signal.

m  Stitch Regulatio
acoustic signal.

. Activate and deactivate the

Display Brightness
Settings 4 » Machine & » Display and Lighting
» Display

With the setting Display Brightness, you can adjust
the brightness of the screen.

Lighting

Settings it » Machine &I » Display and Lighting

» Lighting

With the settings Free Arm &5 and Needle Area 57
you can switch the sewing light above the free arm and

the needle area on and off independently of each other
and adjust the brightness of the sewing lights.

Date and Time
Settings td » Machine &} » Date, Time and Alarm

With the Date and Time setting, you can select the
time format and set the date and time manually or
automatically.

Alarm
Settings it » Machine & » Date, Time and Alarm

With the Alarm £ setting, you can switch on a
reminder and set the following information:

s Alarm Time ©

= Sound <

= Alarm Message [=]

WiFi Connection
Settings it » Machine 8F » WiFi Connection

You can connect the machine to a WiFi network. This
allows you to transfer embroidery designs from the
BERNINA Embroidery Software onto the machine, to
track the progress of the stitching on the BERNINA
Stitchout App or display content from the Help Center
on a tablet.

With the WiFi setting, you can switch the WiFi
connection on and off. The machine indicates the
network to which it is connected.

All available networks are displayed in the Available
Networks (2.4 GHz) list. You can connect the
machine to any available network. In the case of
protected networks, you must sign in with a password.
Once you have set up the WiFi connection, you can
switch the WiFi connection on and off via the status
bar.
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3.19 Personal Settings

Welcome Message
Settings 41 » Personal O » Welcome Message

With the Welcome Message setting, you can enter a
text to be displayed when the machine is switched on.

Background Color
Settings 41 » Personal &0 » Background Color

With the Background Color setting, you can select a
color scheme for your screen.

Language
Settings 4t » Personal O » Language

With the Language setting, you can set the language
of the user interface.

My Dealer Information
Settings tit » Personal ¥ » My Dealer Information
With the My Dealer Information setting, you can

enter the address of your BERNINA dealer for quick
reference at any time.

3.20 Sewing Settings

Upper Thread Tension
Settings 4t » Sewing if » Upper Thread Tension

The upper thread tension is optimally set in the
BERNINA factory. Mettler Metrosene/Serlon thread size
100/2 is used for the upper and bobbin thread.

If you use different types of sewing threads, the upper
thread tension may vary. You can override the default
setting based on thread and fabric you are using in the
Upper Thread Tension in the Sewing Settings. This
modification is made to all sewing patterns and kept
until changed again in the Settings, even after a
machine restart.

The higher the upper thread tension, the more the
upper thread is tensioned and the bobbin thread is
pulled more strongly into the fabric. The lower the
upper thread tension, the less the upper thread is
tensioned and the bobbin thread is pulled less strongly
into the fabric.

Perfect Stitch Formation
== T1he thread knotting is in the

”'. ' center of the fabric.
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mﬁ: Upper thread tension too
tight
This pulls the bobbin thread
more strongly into the fabric.

=,

Upper thread tension too
loose

This pulls the upper thread more
strongly into the fabric.

—

-\

TIP

If the sewing test shows that the upper thread
tension is not optimal for a stitch pattern, you can
modify the upper thread tension for the selected
stitch pattern using the Upper Thread Tension -{-*
function in the Status Bar.

Sewing Speed

Settings it » Sewing i » Sewing Speed

With the Sewing Speed function, you can limit the
maximum sewing speed. The setting is saved when the
machine is switched off.

The sewing speed is specified in stitches per minute.

The maximum sewing speed is 1200 stitches per
minute.

Securing Stitches
Settings 4 » Sewing # » Securing Stitches

With the Securing Stitches function, you can set
whether securing stitches should be sewn automatically
upon starting sewing.

Presser Foot Hover Position
Settings fit » Sewing {§ » Presser Foot Hover Position

With the Presser Foot Hover Position function, you

can set how high the presser foot is raised when the

machine stops with the needle position down. The

following options are available:

m  Low: The presser foot remains lowered.

m  Medium: The presser foot is raised to medium
height.

m  High: The presser foot is raised.
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External Buttons

Settings it » Sewing i » External Buttons

With the External Buttons function, you can program
additional functions for the following buttons:

= Pattern End

Securing

Presser Foot Up/Down

Thread Cutter

Quick Reverse

Pattern End

Settings 4 » Sewing i » External Buttons » Pattern
End

You can use the setting Pattern End to specify which
additional functions are performed when the button
Pattern End 4  is pressed. The following functions
are available:

= Securing
m Cut Upper and Lower Thread
m Raise Presser Foot

You can combine the functions with each other.

Securing

With the Securing ©9- function, you can switch the
sewing of securing stitches on and off.

Securing Stitches

If the function Securing is activated, you can define

the way how the securing stitches are sewn. The

following options are available:

m Secure in Place: The securing stitches are sewn on
the spot.

= Running Stitches: Short securing stitches are
sewn one after the other.

If you have selected the Running Stitches |
setting, you can set the count of securing stitches.

Cut Upper and Lower Thread

With the Cut Upper and Lower Thread .,/ function,
you can switch the thread cut on and off.

Raise Presser Foot

With the Raise Presser Foot &* function, you can
switch the raising of the presser foot on and off.
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Securing Stitches

Settings it » Sewing i§ » External Buttons » Securing
Stitches

You can use the setting Securing Stitches to specify

which function is performed when the button

Securing Stitches <9- is pressed. The following

functions are available:

m  Secure in Place: The securing stitches are sewn on
the spot.

m  Running Stitches: Short securing stitches are
sewn one after the other.

If you have selected the Running Stitches | setting,
you can set the count of securing stitches.

Presser Foot Up/Down

Settings it » Sewing {i » External Buttons » Presser
Foot Up/Down

With the Presser Foot Height function, you can set
the height to which the presser foot is raised when the
Presser Foot Up/Down {{? button is pressed.
Depending on the material thickness, you can raise the
presser foot to 0 — 7 mm.

Thread Cutter

Settings tit » Sewing i » External Buttons » Thread
Cutter

You can use the setting Thread Cutter to specify
whether additional securing stitches are sewn when the
button Thread Cutter >< is pressed.

Securing

With the Securing 29- function, you can switch the
sewing of securing stitches on and off.

Securing Stitches

If the function Securing is activated, you can define

the way how the securing stitches are sewn. The

following options are available:

m  Secure in Place: The securing stitches are sewn on
the spot.

= Running Stitches: Short securing stitches are
sewn one after the other.
If you have selected the Running Stitches |
setting, you can set the count of securing stitches.
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Quick Reverse

Settings 4t » Sewing if » External Buttons » Quick
Reverse

With the Quick Reverse function, you can set how the
machine sews in reverse when the Quick Reverse |1
button is pressed. The following functions are available:
m  Reverse |7 : The machine sews in reverse.

m  Backstep: The machine sews the stitch pattern in
reverse stitch by stitch according to the stitches
sewn. This setting is particularly suitable for
decorative stitches.

Foot Control
Settings 4 » Sewing # » Foot Control

The default setting Needle Up/Down [} is set for the
back kick on the foot control. You can switch the
standard function off and on or switch on and set a
combination of the following functions:

Securing

With the Securing <9- function, you can switch the
sewing of securing stitches on and off.

Securing Stitches

If the function Securing is activated, you can define

the way how the securing stitches are sewn. The

following options are available:

m  Secure in Place: The securing stitches are sewn on
the spot.

= Running Stitches: Short securing stitches are
sewn one after the other.
If you have selected the Running Stitches !
setting, you can set the count of securing stitches.

Cut Upper and Lower Thread

With the Cut Upper and Lower Thread ..’ function,
you can switch the thread cut on and off.

Raise Presser Foot

With the Raise Presser Foot i’ function, you can
switch the raising of the presser foot on and off.

Buttonhole Foot Calibration

Settings 4 » Sewing i » Buttonhole Foot Calibration

The Buttonhole Foot with Slide #3A is calibrated to the
machine and they should always be used together. A
new buttonhole foot must be calibrated with the
machine in the sewing settings before its first use.
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Prerequisite:
= The needle is not threaded.

1. Open the Buttonhole Foot Calibration setting.
2. Attach and lower the Buttonhole Foot with

Slide #3A.
3. Push the Start/Stop ©e button.

= The machine moves the buttonhole foot with

slide forward and backward and displays
successful calibration.

3.21 Embroidery Settings

Upper Thread Tension
Settings it » Embroidery'Q » Upper Thread Tension

The upper thread tension is set optimally at the
BERNINA factory. Mettler Metrosene/Serlon thread size
100/2 is used for the upper and bobbin thread.

If you use different types of sewing threads, the upper
thread tension may vary. You can override the default

setting in the Embroidery Settings. This modification is

made to all embroidery designs and kept until changed
again in the Settings, even after a machine restart.

The higher the upper thread tension is set, the tighter
the upper thread is tensioned, and the bobbin thread is
pulled deeper into the fabric. The lower the setting the
lower the upper thread is tensioned, and the bobbin
thread is pulled less deeply into the fabric.

TIP

If the embroidery test shows that the upper thread
tension is not optimal for an embroidery design, you
can modify the upper thread tension for the selected
embroidery design using the Upper Thread
Tension {1+ function in the Status Bar.

For a higher bobbin thread tension, use a bobbin
case with a high thread tension (HTTBC).

Embroidery Speed

Settings tit » Embroidery O » Embroidery Speed

The embroidery speed is specified in stitches per
minute. The maximum embroidery speed is 1000
stitches per minute.

With the Embroidery Speed setting, you can limit the
maximum embroidery speed. The setting is saved when
the machine is switched off.
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TIP

You can also modify the embroidery speed during
stitching using the foot control or the slide speed
control. You can switch on the maximum embroidery
speed for the current embroidery design while
embroidering using the function High Speed &> .

Design Position
Settings 4t » Embroidery (J » Design Position

With the Design Position setting, you can set the
standard positioning of the embroidery design in the
hoop.

Embroidery designs can be positioned either in the
center of the hoop (default) or at the saved position.
The saved position corresponds either to the position of
the embroidery design when saved in your Personal
Folder or to the position saved in BERNINA Embroidery
Software. The setting is saved when the machine is
switched off.

Calibrating the Hoop
Settings 41 » Embroidery ) » Hoop Calibration
Hoops must be calibrated when new and after every

machine firmware update.

With the Hoop Calibration function, you can calibrate
all hoops.

1. Hoop the fabric with non-woven material.

2. Place the template in the inner hoop onto the
fabric.

3. Attach the hoop.

= The machine recognizes the attached
embroidery hoop and displays it in the Status
Bar.

4. Activate the Hoop Calibration function.
5. Switch on the Camera (@) and Laser . functions.

= The laser indicates the exact position of the
needle.

6. If the needle is not positioned exactly at the center
of the template, center the needle using the arrow
buttons.

7. Confirm the hoop calibration.

The setting is saved when the machine is switched off.

With the Reset Calibration function, you can delete
an existing calibration.
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Cut and Secure
Settings tit » Embroidery'Q » Cut and Secure

Quilt Settings

With the Quilt Settings & function, you can switch
on and off special quilt settings for thread cutting and
securing.

Quilt Settings:

m  Quilt Securing Stitches.

m Thread Cut Disabled.

m  Thread Away Disabled.

Thread Cut After Start

If the Thread Cut After Start .} function is switched
on, the machine stops after a few stitches and you can
cut the thread end by hand.

Securing
With the Securing 29- function, you can switch the
sewing of securing stitches on and off.

Securing Stitches

If the function Securing is activated, you can define
the way how the securing stitches are sewn. The
following options are available:

m  Secure in Place: Securing Stitches in Place.

= Running Stitches: Running Stitches.

Secure at Beginning

With the Secure at Beginning <>-- function, you can
switch the sewing of securing stitches at the beginning
of the embroidery design on and off.

If an embroidery design has programmed securing
stitches, the programmed securing stitches are sewn.

Secure at End

With the Secure at End --2o- function, you can switch
the securing stitches at the end of the embroidery
design.

If an embroidery design has programmed securing
stitches, the programmed securing stitches are sewn.

Unit of Measurement
Settings t4# » Embroidery ) » Unit of Measurement

With the Unit of Measurement function, you can set
the preferred measurement, either mm or inches. The
embroidery size is shown in the selected measurement
unit. The setting is saved when the machine is switched
off.

SPI (Customizable Quilt Designs)

Settings tit » Embroidery J » SPI (Customizable Quilt
Designs)

With the SPI (Customizable Quilt Designs) setting,
you can set the stitch length for Customizable Quilt
Designs in stitches per inch (SPI).
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Main Menu = » Sewing

1 2 3 4 5 6 7

é—- Sewing / Practical Stitches / 1

et

HEE

1 Status Bar 2 Undo/Redo 3 Stitch Length 4 Presser Foot Preview 5 Stitch Width 6 Needle Position 7 Stitch
Preview 8 Edit 9 File Manager 10 Save 11 Reset 12 Combi Mode 13 View

Undo

With the Undo <— function, you can undo the most
recent actions.

Redo

With the Redo —> function, you can redo undone
actions.

Stitch Length
With the Stitch Length function, you can adjust the
length of the current stitch.

Presser Foot Preview

A preview of the recommended or selected presser foot
is displayed in the presser foot preview.

Stitch Width

With the Stitch Width function, you can adjust the
width of the current stitch.

Edit
With the Edit ./ function, you can open the stitch
pattern editing functions. [» see page 61]

Needle Position

If the needle has been moved to the left or right, the
value of the needle position is displayed. You can move
the needle position back to the middle position by
tapping the icon Needle Position & .

Stitch Preview

The Stitch Preview shows a preview of the current
stitch or stitch pattern combination, along with the
selected presser foot. In Combi Mode, you can select
and move the individual stitches in the stitch preview.

Save

With the Save [\, function, you can save a modified
stitch pattern as a new stitch or with new default
settings. [P see page 69]
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Reset

With the Reset (x) you can reset the saved settings of
the loaded stitch to the factory default. [» see

page 70]

The function is only displayed if you have loaded a
stitch pattern with new default settings.

Combi Mode

With the Combi Mode # you can switch the Combi-
mode on and off. [» see page 68]

View

With the View © function, you can adjust the view on

the Sewing Screen.

m Rotate - []: Rotate the view by 90°, e.g. to make it
easier to design texts.

m  Presser Foot On/Off 1 : Show and hide the
presser foot.

= Grid On/Off 4+ : Show and hide the grid.

m  Zoom In/Zoom Out © : Zoom the view in or out.

m  Zoom Factor: Reset the view to the default.

4.1 Status Bar

The Status Bar displays the state of various functions.
Some functions can be set directly with the respective
status, e.g. the needle position, the feed dog or the
laser. For other functions, you can open the settings
with the status, e.g. the upper thread tension or the
presser foot pressure.

The color of the icon shows the current state of the
function.

m  White: Default setting

m  Blue: Active setting

m  Yellow: Modified setting
m Red: Warning

WiFi, Time and Alarm

The WiFi = icon displays the WiFi connectivity, the
current time and alarm if active.

By tapping the icon, you open the settings for WiFi,
Time and the Alarm function. In the Settings, you can
switch the WiFi connection on or off or set up the WiFi
connection. [P see page 44]

You can also set a reminder. [ see page 44]

Needle Stop

The Needle Stop § icon shows the needle position
when the machine is stopped.

m 0§ :Needle Stop Up.

s -{-: Needle Stop Down.

You can set the needle position to stop up or down by
toggling the icon.

Upper Thread Tension

The Upper Thread Tension -{-{- icon shows the
recommended upper thread tension for the selected
stitch.

You can modify the upper thread tension for the
selected stitch by tapping the Upper Thread Tension
icon. [P see page 44]

Presser Foot
The Presser Foot [ _ status shows the recommended
or selected presser foot.

You can open presser foot selection by tapping the
icon. In the presser foot selection, you can select the
attached presser foot and display details about the
presser foot. [P see page 40]

Presser Foot Pressure

The Presser Foot Pressure it¥ icon shows the presser
foot pressure.

You can open and change the presser foot selection by
tapping the Presser Foot Pressure icon. [P see
page 41]

Stitch Plate and Sewing Needle

The Stitch Plate and Sewing Needle (=§ status
shows the selected needle and the attached stitch
plate. The attached stitch plate is automatically
recognized.

You can open the needle overview and select the
attached needle by tapping the icon. [P see page 32]

Feed Dog

m  Feed Dog ~wi (yellow): Feed Dog is down.

You can lower and raise the feed dog by tapping the
icon.

Bobbin Thread

The Bobbin Thread ® status shows the fill capacity of
the lower thread bobbin.

= White: Good

s Yellow: Low or Empty

You can open the Bobbin Thread Status by tapping the
Bobbin Thread © icon. In the setting, the bobbin fill
capacity is shown and you can visualize the animation
and step-by-step instructions to insert the Bobbin Case.
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TIP

Toggle the light on/off to make it easier to insert the
Bobbin Case when the Slide-on Table is attached.

Camera

The Camera (@) icon shows the status of the camera.
= White: Camera off.

m  Yellow: Camera on.

m  Red: Camera not available.

You can switch the camera on and off for a live image
of the sewing area by tapping the icon.

Laser

The Laser . icon shows the status of the laser.
m  White: Laser off.

= Yellow: Laser on.

By tapping the icon, you can switch the laser on and
off.

The laser indicates the next stitch point in sewing mode
and the exact needle position in embroidery mode.
Depending on the presser foot and needle position, the
entry point may be concealed by the presser foot. To
avoid the deflection of the laser with transparent
presser feet, you can lower the presser foot before the
sewing start, e.g. with the Knee Lifter.

4.2 File Manager

In the File Manager, you can load and manage stitch

patterns. The File Manager is opened when you tap a
stitch patttern category, the tabs Personal Folder O
and USB Stick f} in the Quick Access Bar.

1 Toolbar 2 Navigation Bar 3 Quick Access Bar
4 Selection Area

Toolbar

In the toolbar, you will find functions for searching for
files, adjusting the view and managing your own files in
your Personal Folder and on a USB stick.

Search

With the Search O function, you can search for stitch
patterns by stitch number.

Selection

With the Selection 9 function, you can select folders
or files that you wish to manage using a function from
the Options 3 menu.

The Selection ¥ function is only available for the
Personal Folder () and USB Stick i folders.

Options
With the Options ¢ menu, you can manage the
selected file(s) or folder(s) using the Selection ¢
function.

m  Rename: Renaming a File or Folder [» see page 23]
m  Cut: Cut File(s) or Folder(s). [» see page 23]

m  Copy: Copy File(s) or Folder(s). [» see page 23]

m Paste: Paste cut or copied File(s) or Folder(s). [» see
page 23]

New Folder: Create New Folder.

m Information: Show preview and further infor-
mation on the stitch pattern.

m  Select All: Select all displayed File(s) and Folder(s).
m Delete: Delete File(s) or Folder(s). [» see page 23]

The Options ¢ menu is only available for objects in
the Personal Folder ) and USB Stick f folders.

View

With the View £ function, you can switch the view
in the selection area between grid and list view. In the
grid view, you can choose between large and small
icons.

History

With the History 5 function, you can display and
choose the most recently sewn stitch patterns. The
History is retained after restarting the machine.

USB Stick

With the USB Stick f function, you can switch
between your Personal Folder and the USB Stick in the
selection area.

This function is only available if a USB stick is inserted.
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Fullscreen

With the Fullscreen ] function, you can expand the
File Manager to fill the entire screen and show
additional functions.

Navigation Bar

The navigation bar shows the path to the selected
stitch pattern. With the Back <— function, you can
go back step by step.

Quick Access Bar

You can use the Quick Access Bar to directly access the
categorized stitch folders, Personal Folder and USB as
well as the Stitch Designer.

Practical Stitches

In the Practical Stitches § folder, you will find all
practical stitches. [» see page 53]

Decorative Stitches

In the Decorative Stitches $ folder, you will find all
decorative stitches collated into folders by categories.
[» see page 56]

Alphabets
In the Alphabets A folder, you will find all sewing
alphabets. [» see page 57]

Buttonholes

In the Buttonholes £ folder, you will find all
buttonholes, eyelets and the Button Sew-on Program.
[» see page 57]

Quilt Stitches

In the Quilt Stitches (57 folder, you will find all quilt
stitches. [» see page 59]

Personal Folder

In the folder Personal Folder (), you can save and
load your own stitch pattern. You can organize the
stitch patterns in folders.

USB Stick

In the USB Stick {§ folder, you can save or load your
own stitch patterns on a USB stick. You can organize
the stitch patterns in folders.

Stitch Designer

With the Stitch Designer __# icon, you can open the
Stitch Designer function and modify existing stitch
patterns or design your own stitch pattern. [P see

page 74]

Selection Area

In the Selection Area, you can navigate through the
folders and load a stitch pattern. Each stitch pattern is
displayed with a preview image. Stitch pattern combi-
nations are also marked.

If you press and hold a stitch pattern or stitch pattern
combination, a preview of the stitch pattern or the
entire combination and further information is
displayed. If you tap the icon Load [ in the preview,
the stitch pattern or combination is loaded.
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5.1 Practical Stitches

Sewing {} » Practical Stitches i

B b

= = "
C => :
= = i

- > -
§ % J = :j:
~ = =

< L2

Stitch Stitch Name Purpose
patterns number

i 1 Straight Stitch For joining seams, for topstitching and basting.

|

% 2 Zigzag For finishing, sewing knit seams, sewing on lace
inserts and elastic bands.

i 3 Vari-Overlock For finishing edges, sewing together and finishing
knit fabrics.

§ 4 Running Stitch For darning and reinforcing fabric edges or
attaching lace or elastic tape.

M} 5 Securing Program For automatic securing at the start of the seam

" with forward and reverse stitches.

i 6 Triple Straight Stitch For reinforced seams on heavy fabrics,

! topstitching and decorative effects.

§ 7 Triple Zigzag For durable seams on strong fabrics, visible hems
and decorative seams.

% 8 Honeycomb Stitch For visible and decorative seams on knits and
wovens.

% 9 Blind Stitch For blind hems on most fabric types and for shell
edging on soft jerseys and fine fabric.

E 10 Double Overlock For sewing together and finishing knit fabrics.

i 11 Superstretch Stitch For very stretchy open seams.
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Stitch Stitch Name Purpose
patterns number

§ 12 Gathering Stitch For gathering with heavier threads and for flat
joining seams on medium-weight fabrics.

E 13 Stretch Overlock For sewing together and finishing knit fabrics as
well as for flat joining seams.

% 14 Tricot Stitch For visible hems and seams in lingerie and
sweaters and for mending tricot fabric.

g 15 Universal Stitch For flat joining seams, visible hems and decorative
seams in heavy fabrics such as felt and leather
and for attaching elastic tape.

;f> 16 Stitched Zigzag For finishing and reinforcing fabric edges, for

- sewing on elastic tape and for decorative seams.

§ 17 Lycra Stitch For flat joining seams, visible hems on lycra fabric
and for stitching over seams in undergarments.

§ 18 Stretch Stitch For stretchy seams and hems in woven and knit
fabrics.

E 19 Reinforced Overlock For overlock seams or flat joining seams on
medium-weight knit fabrics and toweling.

E 20 Knit Overlock For stretchy seams and hems in woven and knit
fabrics.

{ 21 Basting Stitch For tacking seams, hems and for quilting projects.

H\N“M 22 Simple Darning Program For automatic darning in fine to heavy fabrics.

23 Reinforced Darning For automatic darning in heavy materials.
Program

g 24 Bartack Program For reinforcing pocket openings, buttonholes and
sewing belt loops.

B 25 Bartack Program For reinforcing pocket openings and securing
seam ends.

% 26 Large Fly Stitch For reinforcing pocket openings, zippers and slits
in medium-weight to heavy fabrics.

* 27 Small Fly Stitch For reinforcing pocket openings, zippers and slits

in fine to medium-weight fabrics.
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Stitch Stitch Name Purpose
patterns number
% 29 Narrow Blind Stitch For blind hems and shell edging in fine and soft
fabrics.
I 31 Triple Straight Stitch with  For durable seams in heavy fabrics, e.g. visible
! Long Stitch and decorative seams.
32 Single Straight Stitch As a connecting stitch in a combination of one
straight stitch.
i 33 Three Single Straight As connecting stitches in a combination of three
Stitches individual straight stitches.
§ 34 Darning Stitch For darning.
% 35 Open Overlock Stitch For sewing together and finishing knit fabrics
with a reinforced edge.
% 36 Overlock For medium-weight knit fabrics.
% 37 Reinforced Overlock Stitch ~ For sewing together and finishing knit fabrics.
% 38 Chain Stitch For decorative and reinforcing stitches on most
woven fabrics.
% 39 Cover Stitch Effect To sew decorative seams and hems in heavy knits
and woven fabrics.
E 40 Cover Stitch Effect To sew decorative seams and hems in heavy knits
and woven fabrics.
% 41 Open Overlock Stitch For sewing together and finishing knit fabrics
with a reinforced edge.
% 42 Cover Stitch Effect To sew decorative seams and hems in heavy knits

and woven fabrics.
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5.2 Decorative Stitches

Sewing i » Decorative Stitches $

3 o

EREEDR

BRERBEER
nEBERED

Category Name

1000 Children Sideways Motion

1100 Special

:\77‘%:

I

1200 Filigree

1400 Tapering

1500 Banner

1600 Quilt Stitches Sideways
2 Motion

1700 International

(o]
o
(@]

Geometric Sideways Motion

2000

¥

Seasons

Category Name

100 Nature
L

200 Nature Sideways Motion
2

300 Cross Stitches
z

400 Satin
¥

500 Satin Sideways Motion
Y

600 Geometric

¥

700 Heirloom
%

800 Heirloom Sideways Motion
;

900 Children

2200 Sport and Hobby
i
2500 Constellations
B
2600 Emojis
@®
2700 Emojis Sideways Motion
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5.3 Alphabets
Sewing } » Alphabets A

B b

I I 3 I I
Ennn

Stitch Patterns Name

ABCabc

MM m e

Stitch Patterns Name
ABC a bC Comic
ABCGbC Calibri Italic
ABC abc Agency

ABC/ Abo

Hand of Sean

,/43\ @@@Hﬂ@ Double Block
e PN ]

,efﬁ)bﬂa/&o Script Italic
BCche ™"
u&\\q:; (P Art Deco

@%cﬁ% Monogram

HBE ah[] Long Thin

EE)L\’B Hiragana

74 '7 Katakana

ABBGGB Cyrillic

ABB aba Cvilicalic
Kanji

Kepsg

5.4 Buttonholes
Sewing  » Buttonholes E

B b

I 0 1

r/_ ™
N/
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Stitch Stitch Name Purpose
patterns number
§ 51 Standard Buttonhole For light to medium-weight fabrics. e.g. blouses,
dresses and bed linen.
g 52 Narrow Standard For light to medium-weight fabrics, e.g. blouses,
Buttonhole dresses, children's and baby clothes, crafts.
53 Stretch Buttonhole For all knit fabrics.
54 Round Buttonhole with For medium-weight to heavy fabrics. e.g. dresses,
Normal Bartack jackets, coats and rainwear.
55 Round Buttonhole with For medium-weight to heavy fabrics, with a
Horizontal Bartack reinforced bar, e.g. dresses, jackets, coats and
rainwear.
]l 56 Keyhole Buttonhole For heavy woven fabrics, e.g. jackets, coats and
leisure wear.
[l 57 Keyhole Buttonhole with For stronger, woven fabrics, e.g. jackets, jeans
Pointed Bartack coats and leisurewear.
u 58 Keyhole Buttonhole with For heavy woven fabrics, e.g. jackets, coats and
Horizontal Bartack leisurewear.

59 Straight Stitch Buttonhole  For staystitching and reinforcing buttonholes and
as buttonhole edging, especially for buttonholes
in leather and imitation leather.

§E 63 Heirloom Buttonhole For handlook stitching effects on clothes and

handicrafts on light to medium-weight fabrics.

g 64 Double-rounded For medium-weight to heavy fabrics.
Buttonhole

% 65 Double-rounded Heirloom  For light to medium-weight, woven fabrics. e.g.
Buttonhole blouses, dresses and bed linens.

g 66 Narrow Buttonhole with For decorative buttonholes in medium-weight
Double Pointed Bartack fabrics, e.g. dresses and jackets.

ﬁ 67 Round Buttonhole with For medium-weight woven fabrics, e.g. blouses,
Bartack dresses and jackets.

ﬂ 68 Decorative Keyhole For stronger, woven fabrics, e.g. jackets, coats

Buttonhole with
Horizontal Bartack

and leisurewear.
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Stitch Stitch Name Purpose
patterns number
ﬁ 69 Decorative Buttonhole For decorative buttonholes in firmer woven
with Double Pointed fabrics.
Bartack
70 Decorative Stretch For decorative buttonholes in light to medium-
Buttonhole weight knit fabrics.
60 Button Sew-on Program Sews buttons with 2 or 4 holes.
ﬁ? 61 Small Zigzag Eyelet Openings for cords or narrow ribbons and for
decorative work.
{ 62 Straight Stitch Eyelet Openings for cords or narrow ribbons and for

decorative work.

5.5 Quilt Stitches

Sewing

¥ » Quilt Stitches [

a_g
§

Stitch Number Name Purpose
3 No. 1301 Quilting, Securing Program To secure at the sewing start and end with short
3 stitches forward.
i No. 1302 Quilting, Straight Stitch For machine quilting using a straight stitch with
‘ a 3 mm stitch length.
| No. 1303 Piecing Stitch/Straight Stitch For piecing quilt blocks together using a straight

stitch with a 2 mm stitch length.

Hand-look Quilt Stitches

For imitating the look of hand quilting with
monofilament thread.

Blanket Stitch

For appliqué.
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Stitch Number Name Purpose

i Blanket Stitch For sewing on the edge between two areas in
crazy patchwork.

E No. 1315 Satin Stitch For appliqué with more distinct seams.

% No. 1316 Narrow Blind Stitch For edging and appliqué with minimally visible
seams.

§ Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and
finishing.

% No. 1331 Stippling Stitch For quilting, crazy patchwork, embellishing and
finishing.

:t Feather Stitch For quilting, crazy patchwork, embellishing and
finishing.

ﬁ Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and
finishing.

; Decorative Quilting Stitches For quilting, crazy patchwork, embellishing and

finishing.
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Bar with the Presser Foot 1] _icon. If the stitch cannot
be sewn with the selected presser foot and the
attached stitch plate, the stitch is shown in red.

6.1 Load Stitch Pattern

TIP

You can also modify the stitch width during sewing
with the Upper Multi-function Knob.

With the 5.5 £f function, you can set the stitch
width directly to 5.5 mm, e.g. if you are using a
narrow presser foot.

Stitch Length

we

1 Selection Area 2 Quick Access Bar 2.00 F

1. Tap the stitch category in the Quick Access Bar.
2. Find and load the desired stitch pattern in the File
Manager.

= The stitch pattern is displayed in the stitch
preview.

Further information on the selection area can be found
in the File Manager. [» see page 51]

The recommended stitch length is indicated for each
stitch. You can modify the stitch length for most
6.2 Stitch Pattern Editing stitches, alphabets angl but.tonholes.
In the case of decorative stitches and alphabets, the
pattern length is shown instead of the stitch length.

Stitch Width
TIP

You can also modify the stitch length during sewing
with the Lower Multi-function Knob.

%

The recommended stitch width is indicated for each
stitch. You can modify the stitch width for most
stitches, alphabets and buttonholes. The stitch width
depends on the needle used, the presser foot and the
stitch plate.

The machine checks the compatibility between the
needle, presser foot, stitch plate and stitch. To do this,
the attached presser foot must be selected in the Status
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Editing Functions
Sewing {i » Edit &/

4 4 ~

4 ® ]
4 i

&3 L

- . =

With the Edit ./ function, you can view the editing
functions for the selected stitch. Associated functions
are grouped together. The Edit and Optimize
submenus are always available. For some stitch
categories, e.g. buttonholes, additional submenus are
shown.

Repeat

Sewing {f » Edit &/ » Edit » Repeat 4 x

With the function Repeat 4 x, you can set the number
of repeats of a stitch pattern or a stitch pattern combi-
nation after which the machine should stop. You can
set up to 99 repeats. The number of repeats still to be
sewn is displayed on the Sewing Screen.

Mirror Left/Right
Sewing i » Edit &/ » Edit » Mirror Left/Right 4|\

With the Mirror Left/Right 4|\ function, you can
mirror a stitch pattern along the vertical axis.

Mirror Up/Down
Sewing {i » Edit &# » Edit » Mirror Up/Down &

With the Mirror Up/Down = function, you can mirror
a stitch pattern along the horizontal axis.

Jumbo Stitch
Sewing {f » Edit & » Edit » Jumbo Stitch 4

With the Jumbo Stitch 4] function, you can enlarge or
decrease the size of the stitch pattern. When increased
over 9 mm in width the stitch becomes a Sideways
Motion pattern and stitches with the Presser

Foot #40C.

TIP

Jumbo Stitch is better suited for patterns that are not
too complex.

Bring the Jumbo Stitch into Embroidery to embellish
embroidered projects.

TIP

To adjust satin stitches so that they can be sewn
larger, also change the stitch density. [» see
page 64]

Long Stitch
Sewing # » Edit #/ » Edit » Long Stitch |

With the Long Stitch | function, the machine only
sews every second stitch.

You can use the Long Stitch | function to create new
stitch patterns. Satin stitches are not changed. If you
combine the Long Stitch | function with the straight
stitch, you can easily create basted seams. At a stitch
length of 6 mm, the machine sews 12 mm long basting
stitches.

Directional Sewing

Sewing # » Edit &/ » Edit » Directional Sewing &
With the Directional Sewing @ function, you can
sew stitch patterns in any direction without having to
rotate the fabric.

The #40C presser foot must be attached in order to use
the Directional Sewing @ function.

TIP

Stabilize the fabric.
Guide the fabric lightly with your fingertips.

m  Use the guide lines on the Slide-on Table to guide
the fabric in a straight line.

m  Draw parallel guide lines to keep the fabric
parallel to the presser foot.

TIP

You can also modify the sewing direction in 0.5°
increments during sewing using the multi-function
knobs.

Stitch Counter
Sewing # » Edit &/ » Edit » Stitch Counter j»s

With the Stitch Counter {=s function, you can save the
length of a seam for some stitch patterns based on the
count of stitches sewn. The number of stitches counted
is displayed on the Sewing Screen and saved until the
machine is switched off. [» see page 63]
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Distort
Sewing #§ » Edit & » Edit » Distort 4
With the Distort 4 , function, you can distort stitch

patterns in a horizontal and vertical direction. For
example, sewing a straight font in italics.

Reverse
Sewing i » Edit &/ » Edit » Reverse U

With the Reverse (3 function, you can sew in reverse
without pressing and holding the Quick Reverse
Sewing |J button.

Backstep

Sewing # » Edit #/ » Edit » Backstep £a

With the Backstep $a function, you can perform
precise backwards stitching. The machine ensures that
the stitches sewn in reverse are sewn precisely over the
stitches sewn forward. This allows you to secure
decorative stitches or make individual stitch patterns
bolder by sewing over them several times.

Using the Stitch Counter

Sewing # » Edit &/ » Edit » Stitch Counter jn

Prerequisite:
m A stitch pattern is selected.

1. Tap the Stitch Counter | icon.
= In the info bar the Stitch Counter [ and
Repeat 4 x icons are shown and the Quick
Reverse Sewing |y icon flashes.

2. Sew the desired length.
3. Press the button Quick Reverse Sewing |J .

= The Stitch Counter j= display changes to
AUTO and shows the length of the saved
seam.

= As soon as the stitch pattern is sewn again, the
machine stops after the saved stitch number.

= The stitch count is saved until it is overwritten
or cleared.

4. To access the saved stitch count after deactivating
the function, tap the Stitch Counter i icon
twice, until AUTO appears.

Optimization Functions
Sewing # » Edit & » Optimize

d| ~

The optimization functions for stitch patterns are
grouped together in the Optimize submenu.

Balance
Sewing i » Edit #/ » Optimize » Balance 52

With the Balance £ function, you can fine tune any
stitch patterns that are not sewn correctly due to the
selected fabric.

Compare a sewn sample with the display in the Stitch
Preview section and adjust the balance so that the
preview corresponds to the incorrectly sewn stitch
pattern.
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Dual Feed Balance
Sewing {f » Edit &/ » Optimize » Dual Feed
Balance Y&,

If the fabric layers are not fed evenly despite the fact

that the Dual Feed is engaged, you can use the Dual

Feed Balance .y, function to optimize the Dual Feed.

m If the upper fabric becomes increasingly longer
than the lower fabric, set a positive value.

m If the upper fabric becomes increasingly shorter
than the lower fabric, set a negative value.

Stitch Density

Sewing {f » Edit &/ » Optimize » Stitch Density

With the Stitch Density 7 function, you can modify

the stitch density for some decorative satin stitches

(e.g. No. 401).

m If you increase the stitch density, the stitch spacing
is reduced and the threads become closer.

m If you reduce the stitch density, the stitch spacing is
increased and the threads are further away.

The length of the stitch pattern is not affected.

6.3 Buttonholes

For buttonholes, you can adjust the buttonhole length
as well as the width of the slit. As soon as a buttonhole
stitch is loaded, the Buttonhole Options submenu
appears in the editing menu.

m  Length [ : Program the buttonhole length.

= Slit Width T : Adjust the width of the slit.

Buttonhole Length

Sewing {f » Edit / » Buttonhole Options

» Length D3

To set the buttonhole length, the following modes are

available:

m  Record mm |« : Program the buttonhole length in
mm. [P see page 64]

s Auto Length D¢ : Adjust the buttonhole length to
the button size. [» see page 65]

m Stitch Counter j : Program the buttonhole
length with the stitch counter. [» see page 65]

s Sew Manually | : Sew the buttonhole manually.
[» see page 65]

Record the Buttonhole Length in mm

Sewing {f » Edit / » Buttonhole Options » Length
» Record mm =

In the mode Record mm |+, the machine measures
the sewn length of the first bead and saves it. The
machine finishes the buttonhole automatically.
Prerequisite:

m A buttonhole is loaded.

m Buttonhole Foot #3A is attached.

1. Tap the Record mm |« icon.

= The Reverse |J icon flashes on the Sewing
Screen.
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2. Sew the first bead and press the Quick Reverse
Sewing |7 button at the desired length.
= The machine will complete the buttonhole.
= The machine switches to Button Size D! mode
and all additional buttonholes are automatically
sewn to the displayed length in mm.
= The buttonhole length remains saved until it is

overwritten, cleared or the machine is switched
off.

Adjusting the Buttonhole Length to the
Button Size

Sewing # » Edit &/ » Buttonhole Options
» Length D} » Auto Length [f

In the mode Auto Length [}, you can measure the
diameter of the button. The machine automatically
adjusts the length of the buttonhole to the size of the
button.

Prerequisite:
= A buttonhole is loaded.
m  Buttonhole Foot #3A is attached.

1. Tap the Auto Length D¢ icon.

2. Place the button in the measuring circle on the
screen and adjust the size of the measuring circle
to the size of the button.
= The measured buttonhole length is displayed in

the Sewing Screen.

3. Sew the buttonhole.
= The buttonhole length remains saved until it is

overwritten, cleared or the machine is switched
off.

Programming the Buttonhole Length with the
Stitch Counter

Sewing {{ » Edit &/ » Buttonhole Options
» Length D: » Stitch Counter jre

Using the Buttonhole Foot #3, you can program the
buttonhole length in mode Stitch Counter | . The
machine sews the left bead forward, the lower bartack,
the right bead in reverse and finally the upper bartack.
The length of the right bead is not automatically
adjusted to the length of the left bead, but must be
separately programmed.

Prerequisite:

m A buttonhole is loaded.

m  Buttonhole Foot #3 is attached.

1. Tap the Stitch Counter | icon.

2. Sew the left bead and stop at the desired length.
= The Reverse |J icon flashes on the Sewing

Screen.

3. Press the Quick Reverse Sewing |7 button.

= The machine sews the lower bartack and starts
to sew the right bead in reverse.

= The Reverse |J icon flashes on the Sewing
Screen.

4. Stop the left bead at the height of the first stitch
and press the Quick Reverse Sewing | button.
= The machine sews the upper bartack.
= The lengths of the beads are saved.
= All additional buttonholes are sewn with the

saved count of stitches.

= The buttonhole length remains saved until it is
overwritten, cleared or the machine is switched
off.

TIP

Detailed step-by-step instructions on this topic can
also be found in the Consultant on your machine.

Sewing a Buttonhole Manually

Sewing {f » Edit / » Buttonhole Options
» Length D » Sew Manually {%

In the mode Sew Manually i, you can sew
buttonholes segment by segment. The individual
segments of the buttonhole are displayed in the
Buttonhole bar. Every time you have sewn a segment,
you can move to the next segment by pressing the
Quick Reverse Sewing |7 button.
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Prerequisite:
m A buttonhole is loaded.
m  Buttonhole Foot #3 is attached.

1. Tap the Sew Manually {% icon.

= The individual segments are displayed in the
Buttonhole bar.

= Segment 1 is active.

2. Sew the left buttonhole bead and stop the machine
at the desired length.

= Segment 2 is active during sewing.

3. To switch to the next segment, tap the Quick
Reverse Sewing |5 button or stop the machine
and select the next segment in the buttonhole bar.

4. Finish sewing the buttonhole segment by segment.

Slit Width

Sewing {i » Edit &/ » Buttonhole Options » Slit
Width ©

With the Slit Width T function, you can set the width
of the slit between 0.1 and 2.0 mm. If you make a

significant change to the slit width, you may also have
to adjust the stitch width and the stitch length.

TIP

Set a wide slit width for thick buttons on heavy
fabrics. To reinforce the buttonhole, increase the
stitch width and shorten the stitch length.

Set a narrow slit width for thin buttons on light
fabrics. To make the buttonhole lighter, reduce the
stitch width and increase the stitch length.

6.4 Tapering Stitches

Tapering stitches are decorative stitches that taper off
at the beginning and at the end. You can edit the tips
and the length of the tapering stitches. As soon as a
tapering stitch is loaded the Tapering Options
submenu appears in the editing menu.

= Tips 400 : For modifying the style of the tips.

m Length &] : Adjust the overall length.

Tips
Sewing {f » Edit / » Tapering Options » Tips 400

With the Tips 00 function, you can adjust the tips of
the tapering stitches. You can choose from 4
predefined tips 1 — 4 and use the Adjust

Manually manN function to adjust the lateral position
and the angle of the selected tip.
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Tip

Sewing {f » Edit / » Tapering Options » Tips 400
» Adjust Manually MAN

With the Tip setting, you can move the tips of the

tapering stitches to the side from the far left to the far
right.

Angle
Sewing {i » Edit & » Tapering Options » Tips 400
» Adjust Manually MAN

With the Angle setting, you can adjust the angle of the
tips between 0° and 90°.

Length
Sewing {i » Edit &/ » Tapering Options » Length &]

With the Length @] function, you can adjust the
overall length of stitch pattern. The following functions
are available:

= Record mm |

m  Adjust Length ©]

= Sew Manually |}

Record mm
Sewing i » Edit / » Tapering Options » Length &]
» Record mm [

With the Record mm |+ function, you can sew the
desired length and save it with the Reverse |s button.
Additional tapering stitches with this stitch pattern are
sewn at the same length. The setting remains saved
until it is overwritten, cleared or the machine is
switched off.

Adjust Length
Sewing {i » Edit &/ » Tapering Options » Length &]
» Adjust Length &]

With the Adjust Length & function, you can adjust
the desired overall length im mm. The machine
automatically sews the tapering stitch.

Sew Manually
Sewing {i » Edit &/ » Tapering Options » Length &]
» Sew Manually i

With the Sew Manually {3 function, you can sew the
middle section freely for each tapering stitch. The
machine sews the first tip and automatically switches to
the middle section. As soon as you press the

Reverse |y button, the machine sews the second tip.
The sewn length is not saved.

6.5 Darning Program

The darning program No. 23 allows you to set the
darning length. As soon as the darning program is
loaded, the Darning Options submenu appears in the
editing menu.

= Darning Length 3] : Program the darning length.

&1

Darning Length

Sewing # » Edit &/ » Darning Options » Darning

Length b1

To set the daring length, the following modes are

available:

m  Record mm |+ : Program the darning length in
mm. [P see page 67]

s Auto Length &t : Set the auto darning length.
[» see page 68]

Record the Darning Length in mm

Sewing {f » Edit &/ » Darning Options » Darning
Length #1 » Record mm

In the mode Record mm (=, the machine measures
the sewn length and saves it. The machine finishes the
darning program automatically.

Prerequisite:

m The Darning Program No. 23 is loaded.

m Buttonhole Foot #3A is attached.

1. Tap the Record mm [+ icon.
= The Reverse | icon flashes on the Sewing
Screen.
2. Sew the first row and press the Quick Reverse
Sewing |7 button at the desired length.
= The machine will complete the darning
program.
= The darning length remains saved until it is

overwritten, cleared or the machine is switched
off.
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Sew the Darning Length Automatically

Sewing {i » Edit & » Darning Options » Darning
Length #1 » Auto Length ¢kl

In the mode Auto Length ], you can set the
darning length in millimeters. The machine automat-
ically finishes the darning program with the set darning
length.

Prerequisite:

m  The Darning Program No. 23 is loaded.

m  Buttonhole Foot #3A is attached.

1. Tap the Auto Length & icon.
2. Set the darning length.
3. Sew the darning program.
= The machine will complete the darning
program.
= The darning length remains saved until it is
overwritten, cleared or the machine is switched
off.

6.6 Stitch Pattern Combination

Combi Mode

In combination mode, you can combine stitch patterns
and letters to create stitch pattern combinations or
lettering. Stitch pattern combinations can be saved and
sewn out as one stitch pattern.

1 Combi Mode 2 Save 3 Combination Bar
4 Selection Options

Creating Stitch Pattern Combinations

Sewing #§ » Combi Mode

1. Tap the Combi Mode » icon in the Sewing
Screen.

2. Combine the desired stitch patterns or letters from
the File Manager, in sequence to form a combi-
nation.
= The stitch patterns are inserted in the combi-

nation bar, after the stitch selected, and
displayed in the Stitch Preview.
= The combination can be sewn and/or saved.

Combination Options
Sewing {f » Combi Mode @ » Edit &/

The additional functions for editing individual stitch
patterns, several stitch patterns or the complete stitch
pattern combination are summarized in the submenu
Combination Options.

(=)}
&

w'}
()

TIP

For stitch patterns in combinations, you can also use
the functions in the Edit and Optimize submenus.

Move
Sewing {f » Combi Mode 8 » Edit & » Combi-
nation Options » Move -

With the Move |- function, you can move individual
stitch patterns in combination horizontally and
vertically. Connectors are inserted between the moved
stitch pattern and the stitch pattern combination. These
connectors are not stitched but are movements of the
feed dog. When these are inserted the combination is
now a Sideways Motion pattern.

TIP

You can also drag and drop a stitch pattern in the
Sewing Screen to move it.
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Duplicate
Sewing i » Combi Mode ¢ » Edit &/ » Combi-
nation Options » Duplicate [(]

With the Duplicate (7 function, you can duplicate
individual stitch patterns, multiple stitch patterns or the
entire combination. The duplicated stitch patterns are
inserted after the selected stitch patterns. If the "Select
All" option is selected, the entire sequence is inserted
at the end.

Unify Width

Sewing i » Combi Mode ¢ » Edit &/ » Combi-
nation Options » Unify Width £-2

With the Unify Width s-5 function, you can set the
width of all stitch patterns in the combination to match
the widest stitch pattern. The Unify Width ¢ -5
function is only available if the entire combination is
selected.

Unify Length
Sewing i » Combi Mode ¢ » Edit &2 » Combi-
nation Options » Unify Length 8-8

With the Unify Length G- function, you can set the
length of all stitch patterns in the combination to
match the longest stitch pattern. The Unify

Length G- function is only available if the entire
combination is selected.

Stop
Sewing i » Combi Mode ¢ » Edit &/ » Combi-
nation Options » Stop @

With the Stop © function, you can stop the machine
automatically after any stitch pattern in the combi-
nation. The Stop @ function is only available in single
selection mode.

Tie-Off
Sewing {i » Combi Mode 8 » Edit #Z » Edit Combi-
nation at Cursor Position » Tie-Off 29-

With the Tie-Off 29- function, you can automatically
insert securing stitches after any stitch pattern in the
combination. The Tie-Off ©9- function is only available
in single selection mode. The Tie-Off ©9- function can
be combined with the Stop @ and Thread Cut .}
functions.

Thread Cut
Sewing i » Combi Mode & » Edit &/ » Combi-
nation Options » Thread Cut ok

With the Thread Cut .l function, you can stop the
machine after any stitch pattern in the combination
and cut the threads automatically. The Thread Cut .;
function is only available in single selection mode.

TIP

Examples of Application:

m  Create combination with lettering types and sew
it onto various different labels.

m  Prepare lettering, interrupt it at a specific point
and continue sewing it on a new line.

m  Sew a stitch pattern in a different color.

Delete

Sewing # » Combi Mode & » Edit & » Combi-
nation Options » Delete £

With the Delete {5 function, you can remove the

selected stitch pattern from the combination or remove
the entire combination.

TIP

You can also drag and drop selected stitch patterns
out of the combination bar to the left to remove
them.

6.7 Save

With the Save (!, function, you can save a modified

stitch pattern as follows:

m  New Stitch [ : Save stitch pattern as new stitch
pattern. [» see page 70]

s New Default J,: Save stitch pattern with new
default settings. [» see page 70]
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New Stitch
Sewing {i » Save 1\, » New Stitch [

With the New Stitch [ function, you can save
modified stitch patterns in the folder Personal

Folder C» or on a USB stick. To do this, you must
name the new stitch and select the folder in which the
stitch is to be saved. [P see page 51]

New Default
Sewing § » Save (v, » New Default Y,

With the New Default 1, function, you can save a
modified stitch pattern as the new standard setting.
Each time you select the stitch pattern in the File
Manager, it will be opened with the new settings.

Reset
Sewing # » Reset

If you load a stitch with new default settings, the
Reset (x) function is displayed on the Sewing Screen.
With the Reset (xj function, you can reset the saved
settings to the factory default.
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The machine offers various options for securing the
thread at the beginning and end of the seam.

At the Beginning of the Seam

m  Thread with the needle threader or press the
Thread Cutter >< button.
If the Securing Stitches function is switched on in
the sewing settings, the machine secures.

m  Manually sew a few stitches forward, then
backward, then forward again.

m  Press the Securing Stitches ©9- button before
starting to sew.

m  With a back-kick on the foot control, if the
Securing ©9- function is switched on for the back-
kick.

At the End of the Seam

m  Manually sew a few stitches backward, then
forward again.

m  Press the Securing Stitches ©5- button when
securing is to be carried out.

m  Press the Pattern End 4 button. The Stop @
icon appears in the stitch preview.
If the button for the Securing -29- function is
activated in sewing settings, the machine stops and
secures at the end of the pattern.

m  Press the Thread Cutter >< button.
If the button for the Securing ©5- function is
activated in sewing settings, the machine secures
when the button is pressed and cuts the thread.

m  With a back-kick on the foot control, if the
Securing ©9- function is switched on for the back-
kick.
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Free-motion quilting often results in varying stitch
lengths due to freely guiding the fabric. The stitch
regulation compensates for these differences in stitch
length.

Integrated sensors register the movement of the fabric
and adjust the speed of the machine to suit the
movement of the fabric. The faster you guide the
fabric, the faster the machine sews. If you move the
fabric more slowly, the machine will sew equally slowly.
This ensures that all stitches are sewn to equal length,
resulting in regular stitch formation.

To use the stitch regulation, choose between the
BERNINA Integrated Stitch Regulator (BISR) and various
presser feet or the BERNINA Stitch Regulator (BSR) #42.

TIP

Detailed step-by-step instructions on this topic can
also be found in the Consultant on your machine.

8.1 Stitch Regulation

. — m °©
1 Stitch Regulation On/Off 2 Sound 3 Stitch
4 Mode 5 Settings 6 KickStart

Stitch Regulation On/Off

With the Stitch Regulation On/Off function, you can
switch the stitch regulatoin on or off. When the
function is switched off, the stitch length will not be
corrected, even if BISR mode is activated or the BSR
presser foot is attached.

For the BISR Mode function, the BERNINA
Integrated Stitch Regulator % mode must be called
up via the main menu and the 5.5-mm BISR Stitch Plate
must be attached.

The BERNINA Stitch Regulator (BSR) must be attached
in order to use the BSR Mode function [P see page 40]

Sound

With the Sound function, you can activate an audible
warning. The warning tone sounds if you feed the
fabric too quickly and the machine reaches the
maximum speed and therefore is no longer able to
correct the stitch length.

Stitch

In BISR and BSR mode, you can choose between
straight stitch and zigzag options.

The straight stitch option is suitable for free-motion
quilting, embroidery and thread painting.

The zigzag option can be used in free-motion
embroidery or thread painting.

Mode

In the Mode area, you can select the desired BSR
mode:

m  BSR 1: The needle continues sewing in place if the
fabric is not being moved. [P see page 72]

m  BSR 2: The needle stops when you stop moving the
fabric. [P see page 73]

s BSR 3: Basting Mode [P see page 73]

You can edit the settings associated with each mode.

KickStart

With the KickStart function, you can quilt without
continuously pressing down the foot control. [P see
page 73]

BISR 1/BSR 1 Mode

In this mode, the machine runs continuously at a low
speed once you press the foot control or the Start/
Stop oe button. As you move the fabric, the machine
speeds up or slows down in order to keep to the set
stitch length.

This mode is well-suited to quilt designs with many
points or with micro-stippling, where the fabric stops
briefly with each change in direction. If the machine
continues sewing slowly when doing so, quilting feels
smoother. Sewing in place also enables you to secure
the thread without pressing an additional button.
The following settings can be selected for this mode:
m Stitches per Inch (SPI)

= Revolutions per Minute (RPM)

Stitches per Inch (SPI)

With the Stitches per Inch (SPI) setting, you can set
the desired stitch length in stitches per inch.
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Revolutions per Minute (RPM)

With the Revolutions per Minute (RPM) setting, you
can set the speed at which the machine sews when the
fabric is not being moved. The set speed is the
minimum speed when the machine is sewing.

BISR 2/BSR 2 Mode

In this mode, the machine starts sewing as soon as you
press the foot control and move the fabric. The
machine stops as soon as you are no longer moving the
fabric or no longer pressing the foot control.

To secure the thread, you can move the fabric back and
forth in place or press the Securing Stitches -
button.

Stitches per Inch (SPI)

With the Stitches per Inch (SPI) setting, you can set
the desired stitch length in stitches per inch.

BISR 3/BSR 3 Mode

This mode is intended for basting. You can choose
between two basting stitch lengths. To ensure that the
stitches are sewn correctly, move the quilt more slowly
when basting.

Using KickStart

With the KickStart .= function, you can quilt without
continuously pressing down the foot control.

1. Tap the KickStart .= icon.
= The KickStart screen will appear.
2. To start the machine, press the foot control with
your heel.
= Once the fabric is moved, the machine starts
sewing with the selected settings.
3. To stop the machine, press the foot control with
your heel.
= The machine will stop, but the KickStart \=
function will remain active.
4. To end the KickStart w2 function, tap the screen
or press the foot control with the ball of your foot.
= The KickStart screen will disappear.

Please Note

As long as the KickStart 2 function is active, the
function programmed for the back-kick will be
deactivated. In this case, the back-kick is instead
used to start and stop the machine.

If no sewing is being carried out in the BSR

modes 2 and 3, the machine will switch to standby
mode after 7 seconds. This means that the machine
will not start sewing automatically if the fabric is
moved. You can end standby mode with another
back-kick.

The KickStart W= function is automatically
stopped in the following cases:

= |f the active monitoring function reports an
error, e.g. thread break or bobbin empty.

= |f the foot control cable is removed.

= |f no sewing takes place for 60 seconds.
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9.1 Stitch Designer Screen
Sewing i » Stitch Designer ../

Stitch Designer

1
ct w]
- 2
W
b .,I
T .
6

1 Edit 2 Stitch Design Area 3 Stitch Preview 4 Forward/Backward 5 Cancel 6 Apply 7 View 8 Move
9 Draw 10 Selection Options 11 Stitch Information 12 Undo/Redo

You can use the Stitch Designer to modify existing
stitch patterns or create your own stitch patterns.
Stitches created in the Stitch Designer can be saved in
the folder Personal Folder ) or on an USB stick.

Undo

With the Undo <— function, you can undo the most
recent actions.

Redo

With the Redo —> function, you can redo undone
actions.

Stitch Information

The stitch information displays information about the

stitch pattern, depending on the selection.

m  Width «— : Horizontal distance between two
points.

= One point selected: Distance between the
selected point and the centerline. Points with a
negative value are to the left of the centerline,

while points with a positive value are to the right

of the centerline.

= Multiple points selected: Distance between the
two points farthest from one another.

= All points selected: Width of the stitch pattern.
Length [ : Vertical distance between two points.

= One point selected: Distance between the
selected point and the previous point.

= Multiple points selected: Distance between the
two points farthest from one another.

= All points selected: Height of the stitch pattern.

Number of Stitches oo : Number of selected
points.

If only one point is selected, this display is hidden.

Selection Options

With the Selection Options v function, you can
select individual points, multiple points or the entire
stitch pattern.

Single Point ‘v : Select a single point.
Multiple Points :v : Starting from the currently
selected point, select multiple connected points.
All Points iy : Select all points.
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Draw

With the Draw “# function, you can draw a new stitch
pattern directly on the screen. The points are automat-
ically set in the Stitch Design Area. Once you have
drawn the stitch pattern, you can edit the individual
points.

Move

With the Move <> function, you can move the
selected points within the Stitch Design Area.

TIP

You can also move points using the multi-function
knobs.

View

With the View © function, you can adjust the view on

the Stitch Designer Screen:

m Rotate []: Rotate the view by 90°, e.g. to make it
easier to design texts.

s Limit Width s v~ Limit the width of the stitch
design area.

s Zoom In/Zoom Out &) : Zoom the view in or out.

m  Zoom Factor: Reset the view to the default.

Forward/Backward

With the Forward/Backward function, you can run
the stitch pattern point by point to select a stitch point.

9.2 Editing Functions

Sewing {i » Stitch Designer ... » Edit &/

With the Edit »~ function, you display and hide the
Edit Menu.

New

Sewing {f » Stitch Designer ... » Edit / » New [}
When you start the Stitch Designer, the selected stitch
is displayed in the stitch design area. With the New [

function, you can clear the stitch design area and start
a new stitch design.

Delete
Sewing {f » Stitch Designer ... » Edit /
> Delete {7

With the Delete {5 function, you can delete the
selected points.

Add Stitch

Sewing # » Stitch Designer ... » Edit / » Add
Stitch 1

With the Add Stitch { function, you can add a stitch

or a stitch pattern from any stitch category to the stitch
design. The stitch is inserted after the selected point.

Duplicate

Sewing  » Stitch Designer ... » Edit &/

» Duplicate [

With the Duplicate (5 function, you can duplicate the
selected points.

Mirror Left/Right
Sewing {i » Stitch Designer ... » Edit & » Mirror
Left/Right 4|\

With the Mirror Left/Right 4|\ function, you can
mirror the selected points along the vertical axis.

Mirror Up/Down

Sewing i » Stitch Designer ...# » Edit &/ » Mirror
Up/Down &

With the Mirror Up/Down = function, you can mirror
the selected points along the horizontal axis.

Triple Stitch

Sewing i » Stitch Designer .../ » Edit &/ » Triple
Stitch ||

With the Triple Stitch{!! function, you can sew the
selected points or the stitch before a selected point
with a triple stitch.

Invert
Sewing {f » Stitch Designer ... » Edit / » Invert (]

With the Invert |1 function, you can reverse the
sewing order of the selected points.
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Sew Virtually
Sewing i » Stitch Designer .../ » Edit &/ » Sew
Virtually >

With the Sew Virtually [> function, you can virtually
sew the created stitch pattern.

Sew Virtually enables you to recognize potential errors
or problems such as uneven stitch lengths or
overlapping stitches in order to rectify them.

Snap to Grid
Sewing # » Stitch Designer ... » Edit &/ » Snap to
Grid T

With the Snap to Grid ?i/ function, you can snap the
points into place at the displayed points on the grid.
The grid helps you to align the stitch patterns symmet-
rically and maintain uniform spacing.
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Embroidery File Format

Your machine can read embroidery designs that have
been created using the BERNINA Embroidery Software
and exported as EXP files. When they are exported, a
BMP file and an INF file are created alongside the actual
embroidery file. The BMP file provides a preview of the
embroidery design and the INF file provides the infor-
mation on the thread colors. If the INF file is missing,
the embroidery design cannot be displayed in the
correct thread colors and will instead be displayed in
default colors. You can set the colors manually in the
editing functions.

The built-in embroidery alphabets are a unique format
to this machine. Once saved they are converted to an
EXP format. Some editing functions are then no longer
available.

In addition to the BERNINA embroidery file format, your
machine can also read the following embroidery file
formats: BQM, HQF, PAT, PLT, QLI, TAP, SEW, PES,
PEC, XXX, PCS, JEF and DST.

BERNINA International AG cannot guarantee that
embroidery designs that have not been created or
converted using the BERNINA Embroidery Software will
be correctly read and embroidered.

Design Size

You can increase or decrease the size of embroidery
designs by up to 20 % without loss of quality on the
machine or on a PC using the BERNINA embroidery
software. Embroidery Lettering can be resized greater
than 20 % and stitches are recalculated.
Customizable Quilt Designs (BQM, HQF, PAT, PLT, QLl,
TAP) are vector-based embroidery designs. You can
adjust the size of such quilt designs in almost any way.
The stitch length set in the embroidery settings remains
when the pattern size is adjusted.

Upper Thread

Select high-quality embroidery threads for the upper

thread, as these have an even thickness and are less

prone to breaking. Embroidery created with glossy, fine
embroidery thread is particularly beautiful. Thread
manufacturers offer a comprehensive range of thread
types and colors.

m  Polyester with a sheen is durable, break-resistant
and colorfast. Polyester with a sheen is suitable for
all types of embroidery.

m  Rayon is a fine, silk-like fiber with a glossy effect.
Rayon is suitable for fine embroidery that is not
subject to heavy stress.

m  Metallic thread is a glossy thread available in fine to
medium thicknesses, and is suitable for special
effects in embroidery.

When using metallic threads, switch off the
automatic thread cutter and reduce the embroidery
speed and upper thread tension.

To reduce thread breakage, you can use the Thread
Lubrication Unit.

Bobbin Thread

Special bobbin thread for embroidery is usually only

available as black or white thread. If both sides of the

embroidery will be visible, you can also use the upper
thread in the same color or another normal embroidery
thread as the bobbin thread.

m  Embroidery bobbin thread is an especially soft and
light polyester thread which is suited to be used as
bobbin thread. This special bobbin thread ensures a
steady thread tension and an optimal intertwining
of the upper and bobbin thread.

Stabilizers

Use a stabilizer to stabilize the fabric during stitching.
Light weight and knit fabrics are difficult to hoop and
tend to deform. A stabilizer prevents the fabric moving
or puckering during stitching.

There are various types of stabilizers for various appli-
cations.
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Stabilizer Scope of Application

Cut-away Stabilizer Necessary: Knit fabrics
Possible: Woven fabrics

Fabric/Application

Jersey, sweater, knitwear, stretch fleece
Embroidery designs with high stitch density

Tear-away Stabilizer Woven fabrics

Denim, cotton, linen, felt, wool, silk

Water-soluble Stabilizer Washable fabrics

Projects where there must
not be any visible stabilizer

Organza, net, chiffon
Freestanding embroidery

residue
Topping Fabrics with a pile or texture Velvet, fleece, plush, knit fabrics, corduroy,
broadcloth
Adhesive Stabilizer Fabrics or projects that Leather, imitation leather, cork, velvet, velour,

cannot be hooped

neoprene, fur, corduroy
Collar corners, pockets, cuffs

Leather, imitation leather, cork, velvet, velour,
neoprene, fur, corduroy

Collar corners, pockets, cuffs

Hydro Stabilizer For most embroidery appli-
cations
Iron-on Stabilizer Iron-on fabrics

Stabilizers can be fixed onto the fabric with adhesive
spray or starch spray before hooping. Starch spray can
be used to stiffen the fabric before embroidering.

Embroidery Test

For important projects it is recommended to test sew

the embroidery design on the same or similar fabric

using the same stabilizer, threads and needle.

m  An embroidery test enables you to recognize
potential errors or difficulties in advance so that
you can make appropriate adjustments.

m  The embroidery test enables you to check the
selected embroidery threads and colors appear on
the fabric and adjust as needed.

m  The embroidery test enables you to determine the
ideal stitch density and apply the correct settings.

Appligues and patches
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Main Menu = » Embroidery ()
1 2 3

IS

1 Status Bar 2 Undo/Redo 3 Info Box 4 Design Preview 5 Edit 6 Layer Bar 7 Stitchout 8 Save 9 View

Undo

With the Undo <— function, you can undo the most
recent actions.

Redo

With the Redo —> function, you can redo undone
actions.

Info Box

In the Info Box, you can find the following information

about the embroidery design:

m  Embroidery Time (O : Estimated time required to
stitchout the selected layer(s).

m  Embroidery Size /" : Overall width and height of
selected layer(s).

= Number of Colors | [] : Number of colors used in
the selected layer(s).

Design Preview

The Design Preview shows a preview of the current
embroidery designs in the attached or selected hoop.

Edit
With the Edit ./ function, you can show editing
functions for the embroidery designs. [» see page 84]

Stitchout

With the Stitchout _§ function, you can open the
Stitchout Summary window und start stitchout.
[» see page 94]

Save

With the Save [\, function, you can save the
embroidery design in your Personal Folder or on a USB
stick. [» see page 93]

View

With the View @ function, you can adjust the view on

the Embroidery Screen.

m  Background () : Adjust the background of the
hoop. [P see page 83]

m  Background On/Off (7 : Display or hide the
background of the hoop.

m  Grid £ : Display the center of the hoop, display a
grid and hide the center point and grid.
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s Zoom In/Zoom Out &) : Zoom view in or out.
m  Default: Reset the view to the default.

Context Menu

You can tap and hold an object to open a context
menu with the following functions:

m  Edit Text: Change selected text.
m  Lock: Lock selected object for editing. The layer is
marked with the Lock & icon. You can unlock the

object by tapping the Lock & icon in the layer bar.

m Delete: Delete selected objects.
m Delete All: Delete all objects.

= Mirror Left/Right: Mirror the selected object on a
vertical axis.

= Mirror Up/Down: Mirror the selected object on a
horizontal axis.

m  Select All: Select all objects.

11.1 Status Bar

The Status Bar displays the state of various functions.
Some functions can be set directly with the respective
status, e.g. the needle position or the laser. For other
functions, you can open the settings via the status
display, e.g. upper thread tension.

The color of the icon shows the current state of the
function.

m  White: Default setting

m  Blue: Active setting

= Yellow: Modified setting

m  Red: Warning

WiFi, Time and Alarm

The WiFi = icon displays the WiFi connectivity, the
current time and alarm if active.

By tapping the icon, you open the settings for WiFi,
Time and the Alarm function. In the Settings, you can
switch the WiFi connection on or off or set up the WiFi
connection. [P see page 44]

You can also set a reminder. [P see page 44]

Upper Thread Tension

The Upper Thread Tension -+ status shows the
recommended upper thread tension for the selected
embroidery design.

You can modify the upper thread tension for the
selected embroidery design by tapping the status.

[» see page 44]

Presser Foot

The Presser Foot 1]  status shows the recommended
or selected presser foot.

You can open presser foot selection by tapping the
icon. In the presser foot selection, you can select the
attached presser foot and display details about the
presser foot. [P see page 40]

Hoop

The Hoop () status displays the attached hoop. If no
hoop has been attached, the status shows the recom-
mended hoop for the selected embroidery design.

m  White/Bue: Default and/or selected hoop.
m  Yellow: Attached and recognized hoop.

m  Red: Incompatible hoop or design does not fit
inside the hoop area.

You can select the attached hoop and display details
for the hoop by tapping the status. [» see page 43]

Stitch Plate and Sewing Needle

The Stitch Plate and Sewing Needle (=) status
shows the selected needle and the attached stitch
plate. The attached stitch plate is automatically
recognized.

You can open the needle overview and select the
attached needle by tapping the icon. [P see page 32]

Feed Dog

feed dog. In embroidery mode, the feed dog is lowered
automatically.

Bobbin Thread

The Bobbin Thread ® status shows the fill capacity of
the lower thread bobbin.

= White: Good
m  Yellow: Low or Empty

You can open the Bobbin Thread Status by tapping the
Bobbin Thread @ icon. In the setting, the bobbin fill
capacity is shown and you can visualize the animation
and step-by-step instructions to insert the Bobbin Case.

TIP

Toggle the light on/off to make it easier to insert the
Bobbin Case when the Slide-on Table is attached.

Camera

The Camera (@) icon shows the status of the camera.
m  White: Camera off.

m  Yellow: Camera on.

m  Red: Camera not available.

You can switch the camera on and off for a live image
of the embroidery area by tapping the icon. You can
only switch on the camera if a hoop is attached.
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Laser

The Laser . icon shows the status of the laser.
m  White: Laser off.

m  Yellow: Laser on.

By tapping the icon, you can switch the laser on and
off.

The laser indicates the next stitch point in sewing mode
and the exact needle position in embroidery mode.
Depending on the presser foot and needle position, the
entry point may be concealed by the presser foot. To
avoid the deflection of the laser with transparent
presser feet, you can lower the presser foot before the
sewing start, e.g. with the Knee Lifter.

11.2 Layer Bar

1 Add Design 2 Embroidery Design Layers
3 Embroidery Designs Combined 4 Selection Options

In the layer bar, the individually added embroidery

designs or elements of an embroidery design are

displayed as layers. The most recently added

embroidery design is shown at the top. The lowest

layer shows all added embroidery designs combined.

The order of the layers affects the embroidery.

The following functions are available in the layer bar:

m  Add Design + : Add embroidery designs from the
File Manager. [P see page 83]

= Selection Options [ ][] : You can select a single
layer, multiple layers or all layers for editing. [P see
page 21]

m  Change the order of the layers by moving them or
delete layers by dragging them out. [} see page 20]

11.3 File Manager

In the File Manager, you can load and manage
embroidery designs. The File Manager is shown when
the Add Design - function is tapped in the layer bar.

1 Toolbar 2 Navigation Bar 3 Quick Access Bar
4 Selection Area

Toolbar

In the toolbar, you will find functions for searching for
files, adjusting the view and managing your own files in
your Personal Folder and on a USB stick.

Search

With the Search O function, you can search for
embroidery designs by name in the currently selected
folder.

Selection

With the Selection ¢ function, you can select folders
or files that you wish to manage using a function from
the Options ¢ menu.

The Selection [§¢ function is only available for the
Personal Folder C) and USB Stick {i folders.

Options

With the Options ¢ menu, you can manage the

selected file(s) or folder(s) using the Selection ¢

function.

m  Rename: Renaming a File or Folder. [» see
page 23]

m  Cut: Cut File(s) or Folder(s). [» see page 23]

m  Copy: Copy File(s) or Folder(s). [» see page 23]

m Paste: Paste cut or copied File(s) or Folder(s). [ see
page 23]

m  New Folder: Create New Folder.

m Information: Show preview and further infor-
mation on the stitch pattern.

m  Select All: Select all displayed File(s) and Folder(s).
m Delete: Delete File(s) or Folder(s). [» see page 23]
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The Options ¢ menu is only available for objects in
the Personal Folder » and USB Stick f} folders.

View

With the View £2 function, you can switch the view
in the selection area between grid and list view. In the
grid view, you can choose between large and small
icons.

USB Stick

With the USB Stick i function, you can switch
between your Personal Folder and the USB Stick in the
selection area.

This function is only available if a USB stick is inserted.

Fullscreen

With the Fullscreen (] function, you can expand the
File Manager to fill the entire screen and show
additional functions.

Navigation Bar

The Navigation Bar shows the path to the selected
folder. With the Back <— function, you can go back
step by step.

Quick Access Bar

With the Quick Access Bar you can directly access the
various embroidery design folders, your Peronal Folder
and a USB stick.

Embroidery Designs
In the Embroidery Designs 7 folder, you will find all

embroidery designs that are supplied with the machine.

The embroidery designs are collated into folders by
subjects. [P see page 119]

Lettering

In the Lettering A folder, you will find alphabets
which you can use to create your own texts. [P see
page 91]

Sewing

In the Sewing {{ folder you will find all the sewing
stitches and can use them as embroidery designs.
[» see page 53]

Personal Folder

In the folder Personal Folder (), you can save and
load your own embroidery designs. The stitch pattern
last used in the sewing mode is displayed in the My

Folder and can be uploaded for embroidering. You can
organize the embroidery designs in folders. [ see
page 23]

USB Stick

In the folder USB Stick , you can save or load your
own embroidery designs on a USB stick. You can
organize the embroidery designs in folders.

Selection Area

In the Selection Area, you can navigate through the
folders and load an embroidery design. Each
embroidery design is displayed with a preview image
including details of the file format.

If you press and hold on an embroidery design, a
preview and further information is displayed, such as
the number of stitches, the recommended hoop or the
embroidery motif size. If you tap the icon Load 7 in
the preview, the embroidery design is loaded.
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12.1 Loading the Embroidery
Design

m  The thread is removed from the needle and is
outside the embroidery area.

1. Select the Scanned Image option in the
Background () function.

= The last scanned image is displayed.

1 Add Design 2 Selection Area 3 Quick Access Bar

1. If the File Manager is not open, tap the Add
Design | function in the layer bar.
2. Tap the embroidery design category in the Quick
Access Bar.
3. Find and load the desired embroidery design in the
File Manager.
= The embroidery design is displayed in a hoop in
the design preview that is closest to the size of
the design.

Further information on the selection area can be found
in the File Manager. [» see page 81]

12.2 Hoop Background

Embroidery (J » View © » Background 0

With the Background () function, you can select a
hoop background.

= None: Show white background.

m  Scanned Image: Scan the hoop and show as a
background image. [» see page 83]

m  Color: Set the background color. [» see page 83]

Scan Hoop

If you wish to position an embroidery design precisely
on patterned fabric, a quilt or a project, simply hoop
the fabric and scan it as a background image.
Prerequisite:

m A hoop with the hooped project is attached.

= An embroidery foot or no presser foot is attached.

2. Tap the Scan Hoop @ icon.
= The hoop is scanned and the image is
displayed.
= With the Delete {j function, you can delete
the scanned image.
= With the Scan Hoop @ function, you can scan
the hoop again.
3. To use the scanned image as the background,
confirm the image.

Setting the Background Color

You can use a colored hoop background to simulate
the color of the fabric, so that you can better visualize
how the embroidery design will appear on the project.
Embroidery designs with light colors in particular are
easier to see on a dark background.

1. Select the Color option in the Background ()
function.

2. Set the hue, saturation and brightness to your
preferences and confirm.
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12.3 Embroidery Design Editing

Embroidery O » Edit &

With the Edit ,~ function, you can view the editing
functions. The editing functions are summarized in the
Edit, Arrange and Position submenus.

The results of editing are shown in real time in the
design preview in the selected hoop.

Editing Functions

The editing functions for embroidery designs are
grouped together in the Edit submenu. The editing
functions are applied to the currently selected layers.

Move
Embroidery (O » Edit ## » Edit » Move <>

With the Move <> function, you can move the
selected layers horizontally and vertically. With the
Center -- function, you can position the layers in the
center of the hoop.

TIP

You can also move the layers directly in the design
preview, e.g. using finger gestures or the multi-
function buttons.

Rotate
Embroidery (O » Edit / » Edit » Rotate (¥

You can use the Rotate (¥ function to rotate the
selected layers in 1° or 45° increments.

TIP

You can also rotate the layers directly in the design
preview, e.g. using finger gestures or the multi-
function buttons.

Resize
Embroidery () » Edit // » Edit » Resize &7

With the Resize 7 function, you can modify the size
of the selected layers. With the default setting, the
length and width is changed proportionally. With the
Proportional & function, you can unlink the length
and width, enabling you to set the values separately.
You can also modify the size of the layers directly in the
design preview. Moving the corner points will change
the size of the layers proportionally. Moving the side
points will change the size of the layers non-propor-
tionally.

TIP

For best results, do not enlarge or reduce the layers
by more than 20%.

Duplicate
Embroidery () » Edit #/ » Edit » Duplicate [

With the Duplicate ‘(7 function, you can duplicate the
selected layers.

Mirror Image Left/Right

Embroidery () » Edit &/ » Edit » Mirror Image Left/
Right 4l

With the Mirror Left/Right 4|\ function, you can
mirror the selected layers along the vertical axis.

TIP

You can also access this function by pressing and
holding an embroidery design.

Mirror Up/Down
Embroidery (O » Edit ## » Edit » Mirror Up/Down &

With the Mirror Up/Down = function, you can mirror
the selected layers along the horizontal axis.

TIP

You can also access this function by pressing and
holding an embroidery design.

Stitch Density
Embroidery O » Edit &/ » Edit » Stitch Density &

With the Stitch Density (7} function, you can set the
density of stitches in the selected layers. This change is
only shown in the design preview once you have
confirmed the modified value. Depending on the size
and complexity of the embroidery design, processing
time to calculate the preview may be required.
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Colors
Embroidery (O » Edit // » Edit » Colors ll

With the Colors [Iil function, you can display and

modify the colors and thread brands of the selected

layers.

The following functions enable you to edit the thread

brand and the color:

m Change Color < : Modify the color and thread
brand of the selected color. [» see page 87]

= Back to Default (%) : Reset all changes to default
settings.

s Color Wheel =, : Modify all colors at the same
time or modify colors individually. [> see page 87]

m Change Brand 2~< : Modify the thread brand for
all colors simultaneously. [P see page 87]

Shape Designer

Embroidery (O » Edit // » Edit » Shape Designer
With the Shape Designer € function, you can
arrange the selected layers around a shape, e.g. around
a circle. You can change the arrangement to create
unique embroidery design combinations. [P see

page 88]

Delete
Embroidery (O » Edit ## » Edit » Delete {J

With the Delete {7 function, you can delete the
selected layers.
TIP

You can also drag and drop selected layers out of the
layer bar to the left to remove them.

Arranging Functions

L5, AN o
o & ]
]

= -

The arranging functions for embroidery designs are
grouped together in the Arrange submenu.

Group
Embroidery () » Edit &/ » Arrange » Group '©!

With the Group (@ function, you can group together
the selected layers. The group is displayed in place of
the lowest selected layer in the layer bar.

Ungroup
Embroidery O » Edit &/ » Arrange » Ungroup

Multi-colored embroidery designs are saved as a single
group, where each color forms its own layer. With the
Ungroup (& function, you can split up an embroidery
design into its color layers and up to its connecting
stitches. The layers are displayed separately in the layer
bar and can be edited separately.

Embroidery designs that have previously been grouped
together can also be split up again with the

Ungroup (& function.

Move Up

Embroidery () » Edit » Arrange » Move Up (&
With the Move Up (&J function, you can move the
selected layer upward step by step in the layer bar.
Moving layers upward will cause them to be stitched
later. The top layer is stitched last.

TIP

You can also move a layer within the layer bar with
finger gestures.

Move Down
Embroidery (O » Edit » Arrange » Move Down (&

With the Move Down (L. function, you can move the
selected layer downward step by step in the layer bar.
Moving layers downward will cause them to be stitched
earlier. The bottom layer is stitched first.

TIP

You can also move a layer within the layer bar with
finger gestures.

Align
Embroidery (O » Edit » Arrange » Align &

With the Align [ function, you can align multiple
selected layers with each other, center multiple selected
layers together, or distribute multiple selected layers
evenly.
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Match Start/Stop
Embroidery (O » Edit &/ » Arrange » Match Start/
Stop o2+

With the Match Start/Stop :~¢ function, you can
combine two embroidery designs, e.g. BQM Quilt
Designs or sewing stitches. The last stitch of a selected
embroidery design is merged with the first stitch of the
next selected embroidery design in the layer bar. The
second embroidery design is moved to the last stitch of
the first embroidery design.

This function is particularly useful in the following
applications:
m Borders

m  Shape Designer
m  Duplicate

m  Assembling Customizable Quilt Designs

In combination with the Reduce Thread Changes

function, the embroidery designs are joined together
without sewing stitches and stitched out seamlessly.

Positioning Functions

The positioning functions for embroidery designs are
grouped together in the Position submenu.

Center Design
Embroidery () » Edit » Position » Center Design -}-

With the Center Design -- function, the needle
position is moved to the center of the embroidery
design.

This function is only active if a hoop is attached.

Check Design
Embroidery () » Edit » Position » Check Design i,

With the Check Design ;-5 function, you can check
the four corners and the center of the selected layer
and move the embroidery design if necessary. [ see
page 88]

Virtual Positioning

Embroidery (Q » Edit » Position » Virtual
Positioning '@

With the Virtual Positioning /@ function, you can
move the hoop such that the needle is at the selected
position in the design preview. With this function you
can check the position of an embroidery design stich-
by-stitch.

This function is only active if a hoop is attached.

TIP

You can use the laser to precisely check the virtual
positioning.

Pinpoint Placement

Embroidery () » Edit » Position » Pinpoint
Placement [

With the Pinpoint Placement [, function, you can

position an embroidery design at a specific position in
the hoop. You can also rotate and modify the size of
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the embroidery design while doing so in order to
ensure that it is correctly stitched, even if the fabric is
not clamped straight. [P see page 88]

Endless Embroidery
Embroidery (O » Edit » Position » Endless
Embroidery 8

With the Endless Embroidery ¥ you can stitch combi-
nations that are longer than the hoop. Reference
markings can be programmed and stitched, which are
useful for repositioning the hoop after re-hooping. You
can also create combinations of designs and stitch
patterns, duplicate them and use them to fill the area
of the hoop, e.g. as a patterned background for an
embroidery project. [» see page 90]

Show Start/Stop

Embroidery (O » Edit » Position » Show Start/
Stop +0+

With the Show Start/Stop ;. function, you can
display the first and the last stitch of each individual
embroidery design in the design preview.

m  Green: First stitch

m  Red: Last stitch

Flip Start/Stop
Embroidery () » Edit » Position » Flip Start/Stop ¢

With the Flip Start/Stop ¢ function, you can reverse
the stitch sequence of Customizable Quilt Designs.

Changing the Colors
Embroidery (O » Edit ¢/ » Edit » Colors Il

12 34 5

1 Color 2 Embroidery Sequence 3 Color Number
4 Thread Brand 5 Change Color 6 Back to Default
7 Color Wheel 8 Change Brand

There are the following options available for changing

a color in an embroidery design:

m  Change Color {J : Select a color from a color
palette.

s Change Color ) : Use the Search O function to
search for a color by color number.

m  Color Wheel <, : Modifying colors with the color
wheel.

Modifying Colors with the Color Wheel

1 Color Bar 2 Slider Hue 3 Selected Color
4 Brightness

With the Color Wheel . function, you can change all
the colors in an embroidery design simultaneously or
modify each color separately.

1. Select the color to be changed in the color bar.
= The selected color is highlighted in the color

wheel.

2. To modify the hue of all colors, turn the color
wheel with the Hue control.

3. To change the hue of an individual color, pull the
highlighted color in the color wheel to the desired
point.

4. To change the brightness of the selected color,
move the Brightness control.
= The changes are displayed in the color bar and

in the design preview.

Change Thread Brand
Embroidery () » Edit /2 » Edit » Colors

The embroidery designs are programmed with the
Isacord 40 thread brand. If you would rather work with
embroidery threads from other brands, you can change
the thread brand.

1. To change the thread brand for all threads in the
layer, tap the Change Brand 2-£ icon and select
the thread brand from the list.
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2. To change the thread marker for an individual
color, select the color, tap the Change Color
» Change Palette icon, select the thread
marker from the list and tap the desired color.

Arranging Embroidery Designs
Embroidery (O » Edit // » Edit » Shape Designer

With the Shape Designer > function, you can create
unique embroidery design combinations.

Prerequisite:
m A layer or multiple layers are loaded.

m The size and colors of the embroidery designs have
been adjusted.

Activate the Shape Designer > function.

Select the shape form for arranging the motifs.

Set the number of motifs.

Set the size of the shape.

Align the motifs with the shape.

Mirror motifs and/or rotate in 45° steps if required.
= Every second motif is mirrored.

7. To reset the arrangement, tap the selected shape
again.

o U A WN-=

Check Design

Embroidery (O » Edit &/ » Position » Check
Design

With the Check Design ;-5 function, you can check
the intended position of your embroidery design in the
hoop before you start stitching out.

Prerequisite:

m A hoop with the hooped project is attached.

1. Tap an arrow in the Move Hoop to Position area.
= The hoop moves until the needle is located at
the selected point of the embroidery design, as
long as the point is within the area to be
embroidered.
2. Check whether the position is correct.
3. If necessary, move the embroidery design
horizontally and vertically.

4. If necessary, check other positions.

Pinpoint Placement

Embroidery (O » Edit ## » Position » Pinpoint
Placement [x3,

With the Pinpoint Placement [, function, you can
position the embroidery design with the following
options:

m Grid

s Free Point %,

s Four Point{ !

TIP

Using the Laser function, you can position the point
precisely at the desired location on the fabric.

Positioning the Embroidery Design by 2 Grid
Points

With the Grid £$3 option, you can position embroidery
designs precisely on the fabric using 2 grid points.
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Prerequisite:

m  The desired position of the embroidery design is
marked on the fabric with two points and is clearly
visible.

= A hoop with the hooped project is attached.

1. Tap the Grid $3¢ icon.

2. To maintain the size of the embroidery design,
activate the Retain Size L& function.

3. Select any point on the grid as the rotation point.

4. Position the needle at the corresponding marking
on the fabric using the multifunction knobs and
confirm with the Pin > button. You can activate
the laser to assist with exact positioning of the
needle.

5. Select a second grid point. Position the needle at
the second marking on the fabric and confirm with
the Pin s button.

Positioning the Embroidery Design by means
of 2 Freely Positioned Points

With the Free Point %, option, you can position
embroidery designs precisely on the fabric using 2
freely positioned points.

Prerequisite:

m The desired position of the embroidery design is
marked on the fabric with two points and is clearly
visible.

= A hoop with the hooped project is attached.

1. Tap the Free Point %, icon.
2. To maintain the size of the embroidery design,
activate the Retain Size 57 function.

3. Select any point on the embroidery design as the
rotation point.

4. Position the needle at the corresponding marking
on the fabric using the multifunction knobs and
confirm with the Pin > button. You can activate
the laser to assist with exact positioning of the
needle.

5. Select the second point of the embroidery design.
Position the needle at the second marking on the
fabric and confirm with the Pin > button.

Positioning the Embroidery Design in a
Square

With the Four Point [ option, you can position the
embroidery design in a square using four points, e.g. in
a quilt block. The following options can be used to
place the design:

s Morph [ [ : The embroidery design is reshaped so

|
o

that it fits into the boundary.
m  Fit] [ : The embroidery design is inserted propor-
tionally and centered within the boundary.

Prerequisite:

m  The desired position of the embroidery design is
marked on the fabric with four points and is clearly
visible, or the hoop has been scanned and the
preview displays the fabric. [» see page 83]

m A hoop with the hooped project is attached.

1. Tap the Four Point | { icon.

= The design is placed inside a rectangular
bounding box.

2. Select one of the corner points and position the
needle over the corresponding marking on the
fabric with the multi-function knobs. You can
activate the laser to assist with exact positioning of
the needle.

3. Select all corner points one after the other and
position the needle.
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4. Select the Morph [ [ or Fit] ! option.
= The design is placed inside a bounding box.

5. To maintain the size of the embroidery design,
activate the Retain Size (& function.

6. If necessary, set a margin spacing from the grid.

Borders

Embroidery (O » Edit ## » Position » Endless
Embroidery ¥

With the Endless Embroidery ¥ function, you can
stitch combinations that are longer than the hoop.

TIP

m Using a larger hoop will require less re-hooping.

m To help keep the designs straight, draw guide
lines on the fabric and use the template for
clamping and re-hooping. Make sure that the
guide lines run parallel to the lines of the

template. You can also reposition the embroidery

design using the Pinpoint Placement [,
function.

Creating Borders

Prerequisite:

1.
2,

A hoop with the hooped project is attached.

Select an embroidery design.
Select the Endless Embroidery ¥ function.

= The embroidery design is multiplied to match
the hoop.

= Marker positions are inserted.

If necessary, insert additional marker positions. The
marker points are also embroidered and help to
align the project when rehooping.

If necessary, enter the number of repetitions of the
embroidery design.

If necessary, adjust the size of the embroidery
design so that it fits into the hoop.

If necessary, adjust the spacing between the
embroidery designs.

Confirm settings.

Endless Embroidery

Prerequisite:

1.

A hoop with the hooped project is attached.

With the Stitchout _§ function, open the
Stitchout Summary screen and confirm the
settings.

Use the Start/Stop oe button to start stitching
out.

Once the embroidery design has been fully stitched
out, remove the hoop and re-hoop the fabric so
that the stitched-out marker positions are located
in the upper embroidery area of the hoop.

Using the Pinpoint Placement [, » Free

Point %, function in the embroidery design,
connect at the stitched marker postions. [» see
page 86]

Continue stitchout.

Repeat these steps until the required length of the
trim has been achieved.
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12.4 Lettering

Lettering

Embroidery O » Lettering A

e s | i e e

£ 3 )
B | asc | 1on § noc J aoc f asc
Font

ABC

Name

Art Deco Block

Font

ABC

Name

Children's Slab

ABC

Chivalry

ABLG

Condensed Sans

ABC

Curved Block

ADB

Cyrillic Calligraphic

HABE

Artemis Script

ABC

Flare

ABC

Astra

IAB(E

Full Block Outline

ABC

Athletic Block

ABC

Full Block

asC

Atlantic Script

ABC

Happy Times

ABC

Basic Block

ABC

Micro Block

A

Blackletter English

ABC

Oriental Script

HABC

Park Avenue

ARC

Quilt Block

ABC
A BB Cyrillic Book
Chancery

ABC

ABC

Winding Times
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Creating Lettering

1 Justification 2 Font Selection 3 Keyboard 4 Text
Preview

You can design single-line or multi-line lettering.

1. Tap the Add Design -+ icon in the layer bar.

2. In the File Manager, tap the Lettering A tab and
select a font.

3. Type in the text using the on-screen keyboard. You
can adjust the font, orientation and line breaks to
suit your preferences when doing so.
= The changes are displayed in the preview.

4. Confirm the completed text.
Access special characters by long pessing on the

keyboard character, e.g. "E", "E" etc. when you press
the letter "E".

Editing Functions
Embroidery (O » Edit &/

o fz) B

Ir

th

You can edit lettering using special functions. These are
grouped together in the Lettering submenu.

Edit Text
Embroidery () » Edit &/ » Lettering » Edit Text T’
With the Edit Text T function, you can edit the

lettering. This enables you to correct text, insert line
breaks or modify the alignment.

TIP

You can also access this function by pressing and
holding an embroidery design.

Transform

Embroidery (O » Edit &/ » Lettering » Transform Agc
With the Transform #c function, you can reshape
single-line text as follows:

m  Horizontal 2&ec : Arrange text horizontally.

m  Vertical ¢ : Arrange text vertically.

m  Arch %5 : Reshape horizontal text into an arch.

Spacing
Embroidery (O » Edit #/ » Lettering » Spacing ¥4

With the Spacing ¥4 function, you can modify the
character spacing.

Line Spacing

Embroidery () » Edit // » Lettering » Line

Spacing I=

With the Line Spacing J=— function, you can modify
the spacing between lines for multi-line lettering.

Styling
Embroidery () » Edit &/ » Lettering » Styling 525

With the Styling 2°5 function, you can modify the

stitches in the lettering with the following settings:

m  Stitch Density: Modify the density of the lettering.

m  Pull Compensation: Compensate for the fabric
contracting when stitching.

m Satin Value: Transform satin stitches that are
longer than the set value into step stitches.

The lettering is recalculated and the changes are only
shown in the design preview when you confirm the
settings.
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12.5 Saving Embroidery Designs
Embroidery O » Save 1,

You can save modified embroidery designs in the
Personal Folder or on a USB stick.
1. Tap the Save {, icon.
2. Enter and confirm the embroidery design name.
3. Select a folder, create a new folder or select the
USB Stick fi icon in the toolbar and confirm.
= The embroidery design is saved in the Personal
Folder ¢ or on the USB stick fi .
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13.1 Stitchout Summary
Embroidery (O » Stitchout _§

Stitchout Summary

Hoop g Stitch Plate Presser Foot
0 2., m e it

B8 Quilt Settings “f Thread Away

In the Stitchout Summary screen, you can modify the
most common settings for optimal stitchout quality
before entering the Stitchout. Additional settings can
be modified in Embroidery Settings. [» see page 47]

Hoop
The Hoop () status shows the attached hoop.

Stitch Plate

The Stitch Plate setting shows the attached stitch
plate.

Presser Foot

The Presser Foot & setting shows the selected presser
foot. If you use a different presser foot, you can select
it from the list. The list contains all presser feet that are
suitable for embroidery.

Quilt Settings

With the Quilt Settings €% function, you can switch
on and off special quilt settings for thread cutting and
securing. The following options are available:

= On: Activate quilt settings.
= Quilt Securing Stitches.
= Thread Cut Disabled.
= Thread Away Disabled.

s Off: Adopt the thread cut settings from the
embroidery settings. [P see page 48]

Thread Away

With the Thread Away “§> function, you can set cut
threads to be pulled to the rear of the fabric for cleaner
embroidery on the top.

For embroidery designs with long stitches, it is recom-
mended to switch off the function because the presser
foot could get caught in the long stitches due to the

rapid movement of the embroidery arm. The same
applies to projects with appliqués, wash-out stabilizer
or other relief decorations, e.g. buttons.

The Thread Away < function should not be used if
the Thread Cutting -t function is switched off.

Color

With the Color Il" setting, you can define how thread
changes are handled during embroidery. The following
options are available:

s Multi Color: The embroidery design is stitched
with multiple colors as indicated in the saved
design.

After each color, the machine stops so that you can
change the threads.

m Single Color: The embroidery design is stitched
with the thread that is currently threaded, without
changing threads.

m  Reduce Thread Changes: The embroidery design
is regrouped so that the fewest possible thread
changes need to be made.

Use this function when sewing Customizable Quilt
Designs to avoid multiple starts and stops.

If this function is activated, the colors are also
regrouped in edit mode.

Basting

With the Basting ("} function, you can secure

materials in the hoop that cannot be hooped, e.qg., felt,

organza and silk. The basting can also be used to

prevent top stabilizers from moving or as a guide for

trimming after embroidery. The following functions are

available:

= None: No basting is stitched.

s Around Design: The machine sews a basted seam
around the embroidery design.
If you sew a basted seam around the embroidery
design, you can determine the distance between
the basted seam and the embroidery design. Use
the basted seam around the pattern if the
embroidery design is substantially smaller than the
hoop, or if you are only embroidering a small piece
of fabric.

s Around Hoop: The machine will sew a basted
seam along the inner edge of the hoop.
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Thread Cutting If this option is selected, you can define the length

With the Thread Cutting .;’ function, you can switch of the connecting stitch at which the thread is to

automatic cutting of the thread on and off. The be cut.

following options are available:

m  Off: The thread is not automatically cut. Fabric Thickness

= On Thread Change: The thread is automatically With the Fabric Thickness ©: function, you can set
cut on thread changes. the thickness of the fabric. The set value affects the

= On Jump Stitch: The thread is automatically cut embroidery speed. The higher the value, the slower the
when connecting stitches are made. machine embroiders so that the needle does not get

stuck in thicker fabrics.

13.2 Stitchout
Embroidery (O » Stitchout _§ » OK «/

Stitchout
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7 — N —ETT— R Summary 41207/71002 41 min 10 min g
1 Design Preview 2 Color Bar 3 Color Change 4 Embroidery Information 5 High Speed 6 Stitch 7 Summary
8 Edit 9 Current Color 10 View
The Stitchout screen appears when the embroidery Color Bar
design is ready for stitching out. You can start stitching The color bar shows the color layers in the order in
with the Start/Stop ce button. which they will be stitched out. The length of the
individual color sections corresponds to the count of
Design Preview stitches in that color — the more stitches, the longer the
The design preview shows the embroidery design as it section.
will be stitched out. When it is opened, the current You can scroll left and right in the color bar using the
color layer is adjusted in the preview. You can adjust two arrow keys, in order to display other colors in the
the preview with finger gestures or the view slider. embroidery design.

If you select a color, that color is displayed in the
Current Color bar and in the design preview. At the
same time, the hoop is moved to the starting position
for the selected color. The embroidery information is
also adjusted.
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Color Change
With the Color Change 222 function, you can define

how thread changes are handled during embroidery.
This setting overwrites the setting on the Stitchout
Summaryscreen. The following options are available:
= Multi Color 222 : The embroidery design is stitched
with multiple colors as indicated in the saved
design.
After each color, the machine stops so that you can
change the threads.

m Single Color 222 : The embroidery design is

stitched with the thread that is currently threaded,
without changing threads.

m  Reduce Thread Changes [3: : The embroidery
design is regrouped so that the fewest possible
color changes need to be made.

Use this function when sewing Customizable Quilt
Designs to avoid multiple starts and stops.

If this function is activated, the colors are also
regrouped in edit mode.

Embroidery Information

The following information about the embroidery
process is displayed in the Embroidery Information area:
m  Color: Sequence number of the current color.

m Stitch: Current stitch number/Total stitch number.
m Total Time: Estimated stitch time for the whole

design.

m  Color Time: Estimated stitch time for the current
color.

High Speed

Embroidery designs are stitched out at the optimum
speed for an even embroidery pattern. The optimum
embroidery speed depends on the hoop used. With the
High Speed -z function, you can increase the
embroidery speed up to the saved maximum speed.
Depending on the type of stitch, e.qg. triple stitch, the
function may result in an irregular stitch pattern.

This function is only available once you have started
stitching out using the Start/Stop ce button.

Stitch

With the Stitch ::- function, you can return to a
specific point in the embroidery after a thread break or
other interruption in the embroidery process in order to
continue stitching from that point. The machine
displays the needle position at the time the process was
canceled.

You can move stitch by stitch or use the lower multi-
function knob to move across larger sections of the
design. The laser makes it easier to recognize the
current stitch.

If you wish to return to a specific stitch, you can enter
the number of the stitch.

Summary

With the Summary Y— function, you can cancel
stitchout in order to modify the current embroidery
settings in the Stitchout Summary screen.

Edit
With the Edit €&— function, you can cancel stitchout in
order to edit the embroidery design.

Current Color

The color bar shows the current thread color with the
thread brand and number.

If the machine is sewing, the slider shows the current
needle position. If the machine is not sewing, you can
move the slider to move the needle to a desired
position.

View
With the View @ function, you can modify the size of
the embroidery design in the design preview.
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14.1 Software

Update Firmware

Settings 147 » Machine & » Update and Reset
» Update Firmware

You can use the Update Firmware function to install
the latest version of the firmware on your machine.
You can update the current firmware of the machine
and download detailed step-by-step instructions for the
update process at www.bernina.com/990-support.

Prerequisite:

m  The latest firmware data has been downloaded and
copied to the USB stick according to the update
instructions.

1. You can open the Update Firmware function in
the settings.

2. Update the firmware according to the instructions
on the screen.

Reset Settings

Settings tdt » Machine &F » Update and Reset
> Reset Settings

With the Reset Settings functions, you can reset the
sewing and embroidery settings or all settings to the
factory settings.

Task Maintenance Interval

Cleaning the Machine

Delete Data

Settings it » Machine &) » Update and Reset
» Delete Data

With the Delete Data function, you can delete all
personal data stored on the machine.

Save and Transfer Data

Settings 41 » Machine BF » Update and Reset
» Save and Transfer Data

With the Save and Transfer Data functions, you can
save your personal data, e.g. settings and your own
stitch and embroidery designs, to a USB stick and
transfer them back to the machine.

14.2 Machine

Maintenance Intervals

To ensure that your machine remains in proper working
order for many years to come, BERNINA recommends
regular maintenance and care of your machine.

The maintenance intervals depend largely on the
following factors:

m  Frequency of use of the machine

= Nature of the fabric used

m  Number of stitches

m  Nature of the thread used

BERNINA recommends maintaining the machine after
every 3 — 4 full bobbins have been used.

Measures

Regularly, depending on usage of » Wipe down the surface of the

the machine. machine and screen with a soft,
slightly damp microfiber cloth.
Checking the Machine Regularly, depending on usage of 1. Check the machine for external
the machine. damage.
2. In case of damage, contact your
BERNINA dealer.
Cleaning the Feed Dog and the Regularly, depending on usage of » Clean the feed dog. [P see
Stitch Plate the machine. page 99]
Cleaning the Hook Regularly, depending on usage of » Clean the hook. [P see
the machine. page 99]
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Task

Cleaning the Thread Catcher

Maintenance Interval

If the relevant message is displayed.
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Measures

» Clean the thread catcher. [» see
page 101]

Cleaning the Needle Threader and
Thread Clamp

Regularly, depending on usage of
the machine.

» Cleaning the needle threader
and thread clamp [P see
page 101]

Replacing the Needle

Regularly, depending on usage of
the machine.

» Replace the needle.

Updating Firmware

As soon as a new version is
available.

» Updating Firmware.

Lubricating the Hook

m Before using the machine for
the first time.

m After a longer downtime of the
machine.

m Before every new project.
Now and then during a project,
depending on the scope of the
project.

m  Regularly, depending on usage
of the machine.

m I the relevant message is
displayed.

m In case of unusual noises in the
bobbin area.

» Lubricate the hook. [P see
page 100]

Adjusting, cleaning and lubricating
machine components inside the
machine

With intensive use: annually
s With normal use: 2-yearly

m I the relevant message is
displayed.

Maintenance Information

Settings 47 » Machine &} » Maintenance

settings | Maching

Cleaning the Thread Catcher

Cloaning the Meedis Threadar and

Maintenance Thread Clamp

Lubricating the Machine

» Contact your BERNINA dealer.

Number of Stitches
The display Number of Stitches shows the number of

stitches that have been sewn with the machine.

Service Prediction / Service Interval

The display Service Prediction / Service Interval
shows how much of the maintenance interval has
elapsed. If the maintenance forecast reaches 100 %, a
corresponding message is displayed when the machine
is started and the machine must be serviced.

Lubrication Prediction / Lubrication Interval

The display Lubrication Prediction / Lubrication
Interval shows how much of the lubrication interval
has elapsed. If the maintenance forecast reaches
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100 %, a corresponding message is displayed when the
machine is started and the machine must be lubricated.
[» see page 100]

Number of Thread Cuts / Next Cleaning

The display Number of Thread Cuts / Next Cleaning
shows the number of thread cuts the machine has
made.

Cleaning the Screen

1. Lock screen and sewing functions.

2. Wipe down the screen with a soft, slightly damp
microfiber cloth.

Cleaning the Feed Dog

Thread residue accumulates under the stitch plate over
time. Remove the thread residue on a regular basis.

1. Raise the needle and presser foot.
2. Lower feed dog.

/\ CAUTION

Electronically Driven Components

Risk of injury near the needle and the hook.

» Switch off the machine and disconnect it from the
power supply.

3. Remove the needle and presser foot.
4. Remove the stitch plate.

NOTICE

Dust and thread remnants inside the machine
Damage to mechanical and electronic components.
» Use a brush or a soft cloth.

» Do not use compressed air spray.

5. Clean the feed dog with the brush.

Cleaning the Hook

/\ CAUTION

Electronically Driven Components

Risk of injury near the needle and the hook.

» Switch off the machine and disconnect it from the
power supply.

1. Open the bobbin cover.
2. Remove the bobbin case.
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3. Push the release lever to the left.

4. Fold down the fastening bracket with the black
hook race cover.

5. Remove the hook.

NOTICE

Dust and thread remnants inside the machine
Damage to mechanical and electronic components.
» Use a brush or a soft cloth.

» Do not use compressed air spray.

6. Clean the hook race area with a brush and a soft
cloth. Never use any sharp instruments.

7. Hold the hook at the pin in the center with two
fingers.

8. Guide the hook with the lower edge diagonally
from the top to the bottom behind the bobbin
cover.

9. Position the hook with the two lugs on the hook
driver meeting the corresponding openings in the
hook. The gray marking on the hook driver must be
visible in the hole of the hook.

10. Insert the hook.
= The shuttle is magnetic and therefore pulled

into the correct position.

11. Close the bobbin cover and the fastening bracket
until the release bracket engages.

12. Turn the handwheel to check.
= The hook will rotate.
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13. Insert a bobbin case and close the bobbin cover. 7. Add a drop of BERNINA sewing machine oil to the
bottom of the hook race.

Lubricating the Hook

Lubricating the hook keeps the machine running
smoothly and quietly.

/\ CAUTION

Electronically Driven Components

Risk of injury near the needle and the hook.

» Switch off the machine and disconnect it from the
power supply.

8. Add one drop of BERNINA sewing machine oil into

1. Open the bobbin cover. each of the two oil depots so the felt is damp.
2. Remove the bobbin case. Make sure that the surface of the hook sleeve
3. Push the release lever to the left. remains free of oil.

ST

A_ t
4. Fold down the bobbin case holder with the black 9. "_'Old the hook at the pin in the center with two
bobbin cover. fingers.

5. Remove the hook.

e

10. Guide the hook with the lower edge diagonally
from the top to the bottom behind the bobbin
cover.

11. Position the hook with the two lugs on the hook
driver meeting the corresponding openings in the
hook. The gray marking on the hook driver must be
visible in the hole of the hook.

12. Insert the hook.

= The shuttle is magnetic and therefore pulled
into the correct position.

6. Clean the hook race area with a brush and a soft
cloth. Never use any sharp instruments.
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13. Close the bobbin cover and the fastening bracket
until the release bracket engages.

14. Turn the handwheel to check.
= The hook will rotate.
15. Insert a bobbin case and close the bobbin cover.

16. To absorb excess oil, sew or embroider on a test
fabric.

Cleaning the Thread Catcher

Settings it » Machine & » Maintenance
» Cleaning the Thread Catcher

Thread remnants accumulate in the thread catcher over
time. Clean the thread catcher when the corresponding
message is displayed.

1. You can open the Cleaning the Thread Catcher
function in the settings.

2. Clean the thread catcher according to the
instructions on the screen.

Cleaning the Needle Threader and Thread
Clamp

Settings 4 » Machine & » Maintenance
» Cleaning the Needle Threader and Thread Clamp

Lint can accumulate on the needle threader and
prevent proper performance. It is recommended to
clean the threader head regularly.

1. You can open the Cleaning the Needle Threader
and Thread Clamp function in the settings.

2. Clean the thread catcher and the thread clamp
according to the instructions on the screen.

Changing the Battery

1. Switch off the machine and disconnect it from the
power supply.

2. Remove all threads and thread stand.
3. Carefully set down the machine on its back.
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4. Open the battery compartment cover on the
bottom of the machine.

s,

5. Remove the battery and dispose of it properly.
L~ J

o

/A WARNING

Danger of chemical burns if the lithium button cell

battery is swallowed

Swallowing the lithium button cell battery may result in

severe internal chemical burns.

» Make sure that the battery does not fall into the
hands of children and is not swallowed.

» If you suspect that the battery has been swallowed
or has otherwise entered the body, contact a
doctor immediately.

6. Insert a new type CR2032 battery. When doing so,
make sure that the positive pole is facing outward.

7. Close the battery compartment cover.
Set up the machine.

o

Export the Log File

Settings it » Machine &8 » Maintenance » Export
the Log File

Log files help service personnel to find errors in the
firmware. If you are requested to do so by BERNINA
Service, you can export a log file.

1. Insert the USB stick into the machine.

2. Confirm saving the log file and wait until the
export is complete.

3. Close the window.



Maintenance

15 Troubleshooting

102

The Automatic Needle Threader does not thread the needle

The needle selected in the needle selection cannot be » Single needle: Select the needle in the needle
automatically threaded, e.g. twin needle. selection to match the attached needle. [» see
page 32]
» Double and triple needles: Thread the needle by
hand.
Automatic threading is not possible with the selected » Attach the appropriate presser foot and select it in
presser foot. the presser foot selection. [} see page 40]
The automatic needle threader is dirty. » Clean the needle threader. [» see page 101]
The threader mechanism is not in the correct position. Check the position of the threader mechanism.
If the needle threader is at the front, turn the
needle threader slightly to the left until it is perpen-
dicular to the machine head. If necessary, confirm
the error message. Rethread the needle.
Stitch regulation does not react correctly
Dust or thread residue in front of the BISR sensor. Switch off the stitch regulation.
Open the bobbin cover.
Clean the sensor at the bobbin cover and the area
under the stitch plate with a brush and soft cloth.
BSR not detected
BSR cable not inserted correctly. » Insert the BSR connector properly and ensure it is
clicked into place.
The screen does not respond
.The screen is locked. » Unlock the screen. [» see page 22]
Screen is defective or not connected correctly. » Contact your BERNINA dealer.
Wrong touchscreen pen. » Use other touchscreen pen or finger.
Error during Firmware Update
USB stick is not recognised. » Use a BERNINA USB stick.
The update process is blocked and the animation on » Remove the USB stick.
the screen is inactive. » Switch the machine off.
» Switch the machine on.
» Follow the instruction on the screen.
» Contact your BERNINA dealer.
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Error during Firmware Update

Firmware update files are not found. >

Skipped Stitches

103

Unpack the compressed ZIP file according to the
update instructions.

Store data for the firmware update directly on the
data medium and not in a folder on the USB stick.

Incorrect needle. » Use the needle system 130/705H.

Needle blunt or bent. » Replace the needle.

Poor quality needle. » Use a new BERNINA quality needle.

The needle is incorrectly inserted. » Insert the needle with the flat side to the back as
far up as it will go into the needle holder and
tighten the screw.

Incorrect needle point. » Match the needle point to the texture of the
material.

Incorrect needle/thread combination. » Use a needle with a suitable needle size. [» see

Speed too low

Room temperature is too warm or too cold. >

page 30]

Place the machine in a warm room one hour before
use.

Reduced maximum speed.

Camera image is blurred or contains dirt particles

Camera lens dirty. >

The Laser Dot is not visible or is at the wrong position

The laser is concealed or deflected by the presser foot

>
or the needle. >
>
>

The Light of the button “Start-/Stop” doesn't light up

Light is defective. >

Move the speed control to the right.

Modify the maximum sewing speed in the Settings.
[» see page 45]

Modify the maximum embroidery speed in the
Settings. [P see page 47]

Have the lens cleaned by a BERNINA dealer.

Raise the needle.

Fit another presser foot.

Lower the presser foot before starting sewing.
Contact your BERNINA dealer.

Contact your BERNINA dealer.
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The Machine doesn't start
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The machine is not connected to the power supply. » Insert the mains plug into the socket and into the
machine.
» Check the socket for power.
Room temperature is too warm or too cold. » Place the machine in a warm room one hour before
use.
» Connect the machine and switch it on.
The machine is damaged. » Contact your BERNINA dealer.
Needle Breaks
The needle is incorrectly inserted. » Insert the needle with the flat side to the back as
far up as it will go into the needle holder and
tighten the screw.
Fabric was pulled. » Feed the fabric evenly.
Thick fabric has been pushed. » Use a suitable presser foot for thick fabric,
e.g. Jeans Foot #8.
» Use the height compensation tool when sewing
over a thick seam.
Knotted thread. » Use quality thread.

Sewing Light and/or the Light on the Free Arm do not light up

Sewing light and/or light on the free arm not switched ~ »  Switch on the sewing light and the light on the free

on. arm in the Settings. [» see page 44]

Sewing light and/or free arm light defective. » Contact your BERNINA dealer.

Faulty Stitching

Thread remnants between the thread tension discs. » Fold a piece of thin material and slide the folded
edge (not the raw edges) between the thread
tension discs.

Incorrectly threaded. » Rethread the upper and lower thread.

Thread remnants below the bobbin case spring.

Remove the bobbin case.
Remove the thread remnants under the spring.
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Upper thread is not threaded

The needle is incorrectly inserted.

105

Insert the needle with the flat side to the back as
far up as it will go into the needle holder and
tighten the screw.

Threader head is defective.

Upper Thread Breaks

Incorrect needle/thread combination.

Contact your BERNINA dealer.

Match the needle with the thread size.

Upper thread is too tight.

Reduce the upper thread tension.

Incorrectly threaded.

Rethread the upper thread.

Poor quality thread.

Use quality thread.

The stitch plate or the hook tip is damaged.

Contact your BERNINA dealer to have the damages
repaired.

Replace the stitch plate.

The thread is caught in the area of the thread take-up
lever.

Upper Thread Indicator fails to respond

The upper thread indicator is not switched on.

Slide the cover at the front of the sewing machine
head to the left and remove the cover.

Remove the thread remnants.

Guide the 4 knobs of the cover into the recesses
provided and push the cover to the right until it
clicks into place.

Switch on the upper thread indicator in the
Settings. [P see page 43]

The upper thread indicator is defective.

Upper Thread Indicator reacts too frequently

Upper thread not threaded correctly.

Contact your BERNINA dealer.

Thread the upper thread correctly. [» see page 34]

Upper thread tension too low.

Adjust the upper thread tension. [» see page 50]

The upper thread indicator is defective.

Contact your BERNINA dealer.

Buttonholes are repeatedly not sewn properly

The Buttonhole Foot with Slide #3A is not calibrated
with the machine.

Calibrate Buttonhole Foot with Slide #3A. [P see
page 46]

Lens on the presser foot is dirty.

Clean the lens with a soft, slightly damp cloth.
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Stitch width not adjustable

The selected needle and stitch plate cannot be used in
combination.

106

Replace the needle. [P see page 32]
Replace the stitch plate. [» see page 29]

The presser foot selection prevents the adjustment of
the stitch width.

Attach and select a suitable presser foot. [P see
page 40]

Stitch Plate not detected

Stitch Plate without sensor.

Attach Stitch Plate with sensor.

Disturbance due to magnetic field.

Remove magnetic accessories in the area of the
stitch plate.

Sensor on the stitch plate defective.

Time does not remain set

Battery is empty.

Contact your BERNINA dealer.

Change battery. [P see page 101]

Battery protection film has not been removed.

Uneven Stitch Formation

Upper thread too tight or too loose.

Removing the Protective Film on the Battery. [P see
page 25]

Adjust the upper thread tension. [» see page 50]
Check the thread feed from the thread spool.

Needle blunt or bent.

Replace the needle, make sure that a new BERNINA
quality needle is used. [P see page 32]

Poor quality needle.

Use a new BERNINA quality needle.

Poor quality thread.

Use quality thread.

Incorrect needle/thread combination.

Match the needle with the thread size.

Incorrectly threaded.

Rethread the upper thread. [P see page 34]
Rehtread the bobbin thread. [» see page 38]

Fabric was pulled.

Feed the fabric evenly.

Incorrect bobbin case is used.

Use supplied bobbin case.

Lower thread too tight or too loose.

Contact your BERNINA dealer.
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Lower Thread Breaks

The bobbin case is damaged.
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Replace the bobbin case.

The stitch hole in the stitch plate is damaged.

Contact your BERNINA dealer to have the damages
repaired.

Replace the stitch plate. [» see page 29]

Needle blunt or bent.

Bobbin Thread Indicator doesn't react

The bobbin door cover is opened.

Replace the needle. [P see page 32]

Close the bobbin cover.

The bobbin thread indicator is not switched on.

Switch on the bobbin thread indicator in the
Settings. [P see page 43]

The bobbin thread indicator is defective.

USB stick is not detected

USB stick is incompatible.

Contact your BERNINA dealer.

Use a BERNINA USB stick or compatible USB stick.

USB stick not with correct file system.

Use a USB stick with the FAT32 file system.
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16 Storage and Disposal

16.1 Storing the Machine

BERNINA recommends that you store the machine in its
original packaging. If the machine is stored in a cold
room, place the machine in a warm room for one hour
before use.

1. Switch off the machine and disconnect it from the
power supply.

2. Clean the machine.

Don't store the machine outdoors.

4. Protect the machine against climatic influences.

w

16.2 Dispose of the Machine

1. Delete personal data on the machine. [» see
page 97]

2. Sort components by material and dispose of in
accordance with local laws and regulations.

108
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Term Value Unit
Maximum Speed 1200 Stitches per Minute
Needle System 130/705
Measurements without the Spool Pin (W x H x D) 675 x 420 x 245 mm

(26.6 x 16.5 x 9.7) (in)
Measurements incl. Embroidery Module without 1175 x 420 x 635 mm
Spool Pin (W x H x D) (46.3 x 16.5 x 25.0) (in)
Weight of the Machine 19.2 kg
(42.3) (Ib)
Weight of the Embroidery Module 6.7 kg
14.8 (Ib)
Energy Consumption 160 W
Input Voltage 100 - 240 Y
50/60 Hz
WiFi Frequency Band 2.4 GHz
WiFi Protocol 802.11 b/g/n
Power Output (802.11 b) 17.5 dBm
Power Output (802.11 g) 14.0 dBm
Power Output (802.11 n) 12.5 dBm
Laser Class » LASER
(according to IEC 60825-1:2014) o 1

Protection Class (Electrical Engineering) Il
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18.1 Practical Stitches

15 16 17 18 19 20 21 24 25 26 27 29
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18.2 Decorative Stitches
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iy 2R P % BB R ¥ O
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Nature Sideways Motion
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5
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747
765

Heirloom

L g 2 g 3
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903 904 905 906 907 908 909 910 911 912 913 914
918 919 920

917
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w B R
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Heirloom Sideways Motion
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952 954 955 957 958 959 961 962 963 964 965
Children Sideways Motion
1001 1002 1003 1005 1006 1008 1009 1010 1011 1012 1014
1015 1016 1017 1019 1020 1022 1023 1024 1025 1026 1028

* P E D

&

Special
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:
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Filigree Sideways Motion
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1215 1216 1217 1220 1221 1223 1224 1225 1226 1227

8 2

A

Tapering
1401 1402 1403 1405 1406 1408 1409 1410 1411 1412 1414
1415 1416 1417 1418 1419 1420 1423 1424 1425 1427 1428 1430

P

:
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1431 1437 1438 1440 1446 1447 1448 1449 1450 1454 1455 1459 1460 1461
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Geometric Sideways Motion
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Constellations
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19 Embroidery Designs

embroidery designs is included with your
machine.

After registering your machine, the included
embroidery designs are available as downloads in an
editable format at the BERNINA Customer Portal.

If you see one of the following pictograms below a
number of the embroidery design, you can find
additional information at
https://Awww.bernina.com/specialeffects.

119

Fringe m Projects in the
Embroidery Hoop
D Appliqué Puffy Fonts
CutWork Quilting
PaintWork Trapunto

CrystalWork

& Freestanding PunchWork
Lace
Basic Cutwork B Couching 19.1 Inspirations

You can find the detailed embroidery instructions at
bernina.com/990-designs.

Quilt
& Q101

1. [l 1sacord 40 0020

[ Qo3

1. [ 1sacord 40 0020

&) Q105

1. ] 1sacord 40 0020

Q102

1. [l isacord 40 0020

Q104

1. [ 1sacord 40 0020

Q106

1. [ 1sacord 40 0020


https://www.bernina.com/specialeffects
https://www.bernina.com/990-designs
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[E) Q107

1. [l 1sacord 40

& Q109

1. [} 1sacord 40

E) Qi

1. |} 1sacord 40

B Q113

1. [ 1sacord 40

E) Q115

1. |} 1sacord 40

0020

0020

0020

0020

0020

cef B Bl B RN

Q108

1. [l Isacord 40

E Q110

1. [ 1sacord 40

E Q112

1. [ 1sacord 40

E Q14

1. [ 1sacord 40

Q116

1. [ 1sacord 40

0020

0020

0020

0020

0020

120
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E) Q117

1. [l 1sacord 40 0020

[E Q119

1. [ 1sacord 40 0020

&) Q121

1. ] 1sacord 40 0020

[E Q123

1. [ 1sacord 40 0020

&) Q125

1. ] 1sacord 40 0020

SslElE] £

[ Q18

1. [l isacord 40 0020

Q120

1. [ 1sacord 40 0020

Q122

1. 1sacord 40 0020

E Q124

1. 1sacord 40 0020

Q126

1. [ 1sacord 40 0020

=/ K&

121
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E) Q127

1. [l 1sacord 40 0020

[E Q129

1. [ 1sacord 40 0020

&) Q131

1. ] 1sacord 40 0020

[E Q133

1. [ 1sacord 40 0020

&) Q135

1. ] 1sacord 40 0020

27
NN

9/ Mg 5 S

Q128

1. [l isacord 40 0020

Q130

1. [ 1sacord 40 0020

Q132

1. 1sacord 40 0020

[E Q134

1. 1sacord 40 0020

Q136

1. [ 1sacord 40 0020

122
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E Q137

1. [l 1sacord 40 0020

Petal SM

1. Isacord 40 3210
2.8 Applique 1
3. [l Applique 2
4.l Applique 3
5.l Isacord 40 3210

Circle SM

1.l 1sacord 40 3210
2.8 Applique 1
3. ] Applique 2
4. Applique 3
5.l Isacord 40 3210

Half Circle

1. Isacord 40 3210
2.8 Applique 1
3. ] Applique 2
4.l Applique 3
5.l Isacord 40 3210

CutWork Petal SM

1. [l 1sacord 40 3210
2. Cut 0001
3. ] Cut 0003
4.l Cut 0004

7

s

7

5

165 x 165 mm
6.5 x 6.5 inch

H 2.877

[

165 x 165 mm
6.5 x 6.5 inch

u 2.271

@

165 x 318 mm
6.5 x 12.5 inch

H 5.970

N

153 x 153 mm
6 x 6 inch

B 1930

Petal LG

1. [l Isacord 40 3210
2.8 Applique 1
3. [l Applique 2
4. | Applique 3
5.8 Isacord 40 3210

Circle LG

1. 1sacord 40 3210
2.8 Applique 1
3.l Applique 2
4.l Applique 3
5.8 Isacord 40 3210

Four Circles

1. 1sacord 40 3210
2.8 Applique 1
3. [l Applique 2
4. | Applique 3
5.l Applique 2
6.l Applique 3
7.1 Applique 2
8.l Applique 3
9. [l Applique 2
10. [l Applique 3

CutWork Petal LG

1. 1sacord 40 3210
2. Cut 0001
3.l cut 0003
4. cut 0004

CutWork Circle LG 3

1. [l Isacord 40 3210
2. Cut 0001
3.8 cut 0002
4.l Cut 0003
5. cut 0004

123

305 x 305 mm
z 12 x 12 inch n 51058
:!. ...... -
1
\I\‘\. .I.\\".
.\\ I.'.
.\-. .Il.
|
—
305 x 305 mm
il 12 x 12 inch -~ JERER
305 x 305 mm
<z 12 x 12 inch n Clotss

11. [ 1sacord 40 3210

()
O

280 x 280 mm
11 x 11 inch - JEEEY
280 x 280 mm
11 x 11 inch - JEREE
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124

CutWork Circle 152 x 152 mm H s CutWork Half gy 149 x 302 mm u 607
SM 6 x 6 inch ' Circle 5.9 x 11.9 inch ’
1.l 1sacord 40 3210 1. 1sacord 40 3210
2. Cut 0001 ’ 2. Cut 0001
3.1 | Cut 0002 3.1 | Cut 0002
4.l cut 0003 4.l cut 0003
5. cut 0004 5. cut 0004
Dress
185 x 176 mm 118 x 101 mm
L3 p101 B oo B 20050 L3 p102 il 47 x4inch B 70
1. lIsacord 40 0672 1 Isacord 40 0672
2. lsacord 40 0672 2 Isacord 40 0672
3. Isacord 40 0672 3. Isacord 40 0672
4. lsacord 40 0101 4 Isacord 40 0101
73 x 77 mm 55 x 48 mm
ﬂ D103 < 2.9 x 3 inch H AL m D104 <z 2.1 x1.9inch u &R
1. lIsacord 40 0672 1 Isacord 40 0672
2. Isacord 40 0672 2. lsacord 40 0672
3., Isacord 40 0672 3. Isacord 40 0672
4.  Isacord 40 0101 4 Isacord 40 0101
54 x 42 mm 117 x 123 mm
L3 Dp105 il 2.1x1.7inch B s L3 D106 il 4.6 4.38inch B oo
1. lIsacord 40 0672 1 Isacord 40 0672
2. Isacord 40 0672 2 Isacord 40 0672
3. Isacord 40 0672 : 3. Isacord 40 0672
4. lIsacord 40 0101 - 4. lsacord 40 0101
151 x 129 mm 149 x 149 mm
L3 p107 il 59 x5.1inch B o LJp1o8 il 5.9 x5.9inch -~ JRERES

Isacord 40
Isacord 40
Isacord 40
Isacord 40

AN =

0672
0672
0672
0101

1 Isacord 40 0672
2. lsacord 40 0672
3. Isacord 40 0672
4 Isacord 40 0101
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L4 D109

Isacord 40 0672
Isacord 40 0672
Isacord 40 0672
Isacord 40 0101

MW =

C3p111

Isacord 40 0672
Isacord 40 0672
Isacord 40 0672
Isacord 40 0101

AW =

L4 D113

Isacord 40 0672
Isacord 40 0672
Isacord 40 0672
Isacord 40 0101

MW =

L4 D115

1. Applique 1
2. [l Applique 3
3. Isacord 40 0672
4. lsacord 40 0101
5.l Isacord 40 2900
6. Isacord 40 0101

L4 D117

1. Applique 1
2. [l Applique 3
3., Isacord 40 6031
Isacord 40 0630
Isacord 40 0672
Isacord 40 0101

S

110 x 117 mm

z 4.3 x 4.6 inch

120 x 118 mm

< 4.7 x 4.7 inch

168 x 137 mm

< 6.6 x 5.4 inch

115 x 70 mm

< 4.5 x 2.8 inch

72 x 115 mm

< 2.8 x 4.5 inch

H 5557 ﬂ D110

1 Isacord 40 0672
2. lIsacord 40 0672
3. Isacord 40 0672
4 Isacord 40 0101

H 6.664 ﬂ D112

1 Isacord 40 0672
2 Isacord 40 0672
3. Isacord 40 0672
4 Isacord 40 0101

B oo m D114

1.l 1sacord 40 1720
2.l isacord 40 1720
3. lIsacord 40 0672
4. lsacord 40 0101

H 5.784 ﬂ D116

1. Applique 1
2.l Applique 3
3. Isacord 40 0672
4. Isacord 40 0101

H 4221 D118

1.l 1sacord 40 6043

7

2

s

2

s

207 x 200 mm
8.1x7.9inch

100 x 80 mm
3.9x3.2iinch

187 x 178 mm
7.4 x 7 inch

119 x 139 mm
4.7 x 5.5 inch

70 x 139 mm
2.8 x 5.5 inch

125

n 29.950

u 5.531

n 15.018

u 22320

H 2782
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D119

1. [l 1sacord 40 6043

D121

1.0 lsacord 40 0442
2. 1sacord 40 0345

D123

1.0 Isacord 40 5912
2.l sacord 40 5722
3. [l Isacord 40 5633

D125

1.8 Isacord 40 5912
2. 1sacord 40 5633

7

7

7

59 x 129 mm
2.3 x5.1inch

104 x 79 mm
4.1 x 3.1 inch

65 x 126 mm
2.6 x 5inch

104 x 109 mm
4.1 x4.3 inch

H 2.348

H 3416

D120

1. [l Isacord 40 6043

D122

1. lIsacord 40 0352
2. Isacord 40 6133

D124

1. 1sacord 40 5912
2. Isacord 40 5633

D126

1. 1sacord 40 5912
2. 1sacord 40 5633

126

64 x 147 mm
2.5 x 5.8 inch u 2746
105 x 107 mm

2 [P R -- X2

74 x 110 mm

<z 2.9x4.4inch n 2210
71 x 62 mm

il 28 x2.4inch - JREYE
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D127 g i, @ ens  Dis - [l - R
1. lIsacord 40 3962 1. [l Isacord 40 0132
2. 'sacord 40 3644 2.l 'sacord 40 5233
3. ] Isacord 40 0134 3.l lsacord 40 5233
4.l 1sacord 40 5233 4. Isacord 40 0170
5.l lsacord 40 5233 5.0 lIsacord 40 0170
6.l 1sacord 40 3644 6./ |lsacord 40 0170
7. [ sacord 40 3644 7.[ ] Isacord 40 0170
8. [ lsacord 40 3644 8.l lsacord 40 3644
9.l lsacord 40 3644 9.l lsacord 40 3644
10. [ 1sacord 40 0504  11. [ Isacord 40 0504  12.[8Isacord 40 0504  10. [ 1sacord 40 3644 11| 1sacord 40 3644 12 [ 1sacord 40 0134
13. [ Isacord 40 0504  14. [l 1sacord 40 3713 15. [ 1sacord 40 3713 13.[J1sacord 40 0134 14. [ isacord 40 0134 15 [ Isacord 40 0134
16. [l 1sacord 40 3713 17.[ll1sacord 40 3713  18.[Misacord 40 2711 16. [l 1sacord 40 2900 17.[l1sacord 40 2900 18. [l Isacord 40 2900
19. [l lsacord 40 2711 20. | Isacord 40 2711 21. [ 1sacord 40 2711 19. [ isacord 40 2900 20.[M Isacord 40 5934 21.[W Isacord 40 5934
22. [ 1sacord 40 5934  23.[M1sacord 40 5934 24| 1sacord 40 2711
25. [l 1sacord 40 2711 26. [ 1sacord 40 2711 27. [ 1sacord 40 2711
28. [l 1sacord 40 1720 29. [ 1sacord 40 1720 30. [l 1sacord 40 1720
31. [l Isacord 40 1720
Organizer
0101 - Jyersu - EL 0102 - [P - L

1.l 1sacord 40 3631 1.l 1sacord 40 3631

v
]

5050502050

Gk

B 20700

-

HOLVBOR

150 x 147 mm
5.9 x 5.8 inch

0103 2

1. [l 1sacord 40 3631

Chair

300 x 370 mm
11.8 x 14.6 inch

H 72.017

c101 2

1. lIsacord 40 0015
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19.2 Quilting

32196-01

1. [ 1sacord 40 0020

32196-03

1. [l 1sacord 40 0020

32196-05

1. [ 1sacord 40 0020

32196-07

1. ] 'sacord 40 0020

32196-09

1. [ 1sacord 40 0020

16188

% R d k¢

32196-02

1. 1sacord 40 0020

32196-04

1. [l isacord 40 0020

32196-06

1. [ 1sacord 40 0020

32196-08

1. [ 1sacord 40 0020

32196-10

1. [ 1sacord 40 0020
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32196-11

1. [l 1sacord 40 0020

32196-13

1. [ 1sacord 40 0020

32196-15

1. ] 1sacord 40 0020

32196-17

1. [ 1sacord 40 0020

32196-19

1. ] 1sacord 40 0020

Akl

32196-12

1. [l isacord 40 0020

32196-14

1. [ 1sacord 40 0020

32196-16

1. 1sacord 40 0020

32196-18

1. 1sacord 40 0020

32196-19-1

1. [ 1sacord 40 0020

D |a ok €
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32196-20

1. [l 1sacord 40 0020

32196-22

1. [ 1sacord 40 0020

32196-24

1. ] 1sacord 40 0020

32196-26

1. [ 1sacord 40 0020

32196-28

1. ] 1sacord 40 0020

LR 9P 5

32196-21

1. [l isacord 40 0020

32196-23

1. [ 1sacord 40 0020

32196-25

1. 1sacord 40 0020

32196-27

1. 1sacord 40 0020

32196-29

1. [ 1sacord 40 0020

Q
&
<)
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32196-30

1. [l 1sacord 40 0020

Basics_05s

1. [ 1sacord 40 0020

Basics_02

1. ] 1sacord 40 0020

Basics_04

1. [ 1sacord 40 0020

Basics_05

1. ] 1sacord 40 0020

|
i
i
b

Basics_02s

1. [l isacord 40 0020

Basics_01

1. [ 1sacord 40 0020

Basics_03

1. 1sacord 40 0020

Basics_04_corner

1. 1sacord 40 0020

12416-15q

1. [ 1sacord 40 0020

i
i
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12416-36q

1. [l 1sacord 40 0020

12591-14_1

1. [ 1sacord 40 0020

12607-28q

1. ] 1sacord 40 0020

12756-01q

1. [ 1sacord 40 0020

12756-03q

1. ] 1sacord 40 0020

= L e B 12

12416-38q

1. [l isacord 40 0020

12591-14 2

1. [ 1sacord 40 0020

12607-33q

1. 1sacord 40 0020

12756-02q

1. 1sacord 40 0020

12756-11q

1. [ 1sacord 40 0020
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12756-18q

1. [l 1sacord 40 0020

12756-22q

1. [ 1sacord 40 0020

80185-03q

1. ] 1sacord 40 0020

12380-04q

1. [ 1sacord 40 0020

12380-09q

1. ] 1sacord 40 0020

!

%
o
o3
&

12756-19q

1. [l isacord 40 0020

80185-01q

1. [ 1sacord 40 0020

80185-07q

1. 1sacord 40 0020

12380-08q

1. 1sacord 40 0020

BD285q

1. [ 1sacord 40 0020

T
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BD288q

1. [l 1sacord 40 0020

BD292q

1. [ 1sacord 40 0020

BD308q

1. ] 1sacord 40 0020

Quilt project_2

1. [ 1sacord 40 0020
BD412
1. ] 1sacord 40 0020

BD289q

1. [l isacord 40 0020

BD299q

1. [ 1sacord 40 0020

Quilt project_1

1. 1sacord 40 0020

BD394

1. 1sacord 40 0020

BD413

1. [ 1sacord 40 0020

ST
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BD513

1. [l 1sacord 40

BD553

1. [} 1sacord 40

BD567

1. |} 1sacord 40

BD665

1. [ 1sacord 40

BD801

1. |} 1sacord 40

0020

0020

0020

0020

0020

N/

BD514

1. [l Isacord 40

BD554

1. [ 1sacord 40

BD659

1. [ 1sacord 40

BD800

1. [ 1sacord 40

BD804

1. [ 1sacord 40

0020

0020

0020

0020

0020

135
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BD837 HE959

1.l sacord 40 0020 K( 1.l 1sacord 40 0020

Panto_Candle Villette
1. [ 1sacord 40 0020 1. [ 1sacord 40 0020
Villette2

1. ] 1sacord 40 0020

Amandy Murphy

80202-01 80202-02
1. [} 1sacord 40 0020 1. 1sacord 40 0020
80202-03 80202-04

1. [l 1sacord 40 0020 J 1. [l isacord 40 0020

o
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80202-05

1. [l 1sacord 40 0020

80202-06

1. [ 1sacord 40 0020

80257-02

1. ] 1sacord 40 0020

80257-04

1. [ 1sacord 40 0020

80257-05s

1. ] 1sacord 40 0020

P
.
2

80202-05s

1. [l isacord 40 0020

80257-01

1. [ 1sacord 40 0020

80257-03

1. 1sacord 40 0020

80257-05

1. 1sacord 40 0020

80257-06

1. [ 1sacord 40 0020

LT

/

137
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80258-02 80258-03

1. [l 1sacord 40 0020 1. [l isacord 40 0020

80258-04 80258-05

1. [ 1sacord 40 0020 1. [ 1sacord 40 0020

80258-06

1. ] 1sacord 40 0020

80259-01

1. 1sacord 40 0020

80259-02

1. [ 1sacord 40 0020

80259-03

1. 1sacord 40 0020

80259-04

1. ] 1sacord 40 0020

80259-05

1. [ 1sacord 40 0020

1 o Pl L B
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80259-06

1. [l 1sacord 40 0020

80260-03

1. [ 1sacord 40 0020

80210-07s

1. ] 1sacord 40 0020

80210-05

1. [ 1sacord 40 0020

80210-08

1. ] 1sacord 40 0020

80260-02

1. [l isacord 40 0020

80260-06

1. [ 1sacord 40 0020

80210-03

1. 1sacord 40 0020

80210-06

1. 1sacord 40 0020

80210-09

1. [ 1sacord 40 0020

Al RdL
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80210-01

1. [l 1sacord 40 0020

80210-07

1. [ 1sacord 40 0020

LoopedFlowers_
Panto2
1. [} 1sacord 40 0020

PebblesShells_
Border
1. [} 1sacord 40 0020

PebblesShells_
Panto
1. ] 1sacord 40 0020

AN EIE

80210-04

1. [l isacord 40 0020

- LoopedFlowers_
= Border1
1. [l isacord 40 0020

PebblesShell_
Square
1. [ 1sacord 40 0020

PebblesShells_
Corner
1. 1sacord 40 0020

PebblesShells_
Segment
1. [ 1sacord 40 0020

140
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. PebblesShells_
Segment1
1. ] 1sacord 40 0020

@ SwirlsPaisley_
Border
1. [l 1sacord 40 0020

SwirlsPaisley_
Panto
1. [l 1sacord 40 0020

. SwirlsPaisley_
Segment1
1. [} 1sacord 40 0020

@ SwirlsPaisley_
Square2
1. [ 1sacord 40 0020

B B e K

. PebblesShells_

Triangle
1. [ 1sacord 40 0020

SwirlsPaisley_
Corner
1. [l isacord 40 0020

@ SwirlsPaisley_
Segment
1. [l isacord 40 0020

@ SwirlsPaisley_
Square1
1. [ 1sacord 40 0020

VinesBerries_
Block
1. 1sacord 40 0020

141
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VinesBerries_
Border
1. ] 1sacord 40 0020

VinesBerries_
Corner
1. [l 1sacord 40 0020

@ VinesBerries_
triangle
1. [l 1sacord 40 0020

. VinesBerries_
Border2
1. [ 1sacord 40 0020

VinesBerries_
Panto
1. [l isacord 40 0020

VinesBerries_
(|

Wreath
1. [l isacord 40 0020

142

Template

QsS101

1. ] 1sacord 40 0020

QS103

1. [l 1sacord 40 0020

QS102

1. [ 1sacord 40 0020

QS104

1. [l isacord 40 0020
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QS105

1. [l 1sacord 40 0020

QS107

1. [ 1sacord 40 0020

Qs109

1. ] 1sacord 40 0020

Qs111

1. [ 1sacord 40 0020

Qs113

1. ] 1sacord 40 0020

W [ N\ [@

QS106

1. [l Isacord 40

QS108

1. [ 1sacord 40

Qs110

1. [ 1sacord 40

QS112

1. [ 1sacord 40

0020

0020

0020

0020

143
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19.3 Accents

12436-29 ul

100 x 37 mm
3.9x 1.4 inch

H 2.464

1.1 Yllvariations 8016
2.l YUl variations 8015
3., Yenmet 7030

124 x 124 mm

12445-11 2 4.9 x 4.9 inch

H 11.385

1. lsacord 40 2520
2. Isacord 40 2550
3. [l sacord 40 2504
4. lsacord 40 2520
5. [l sacord 40 2715

44 x 34 mm

12508-12 il 1.8 1.3inch

H 1.789

1.8 1sacord 40 4752
2. lsacord 40 0352
3. Isacord 40 5552

46 x 58 mm

12508-30 < 1.8 x 2.3 inch

H 1.662

1.0 Isacord 40 0124
2. lIsacord 40 0352
3. 1sacord 40 6133

12440-19

1.l 1sacord 40 1543
2.l 1sacord 40 1521
3. [0 Isacord 40 2761
4.[l sacord 40 1543

12445-13

1. lsacord 40 2520
2. lIsacord 40 2550
3. [l 1sacord 40 2504
4.  lsacord 40 2520
5. [l 1sacord 40 2715

12508-21

1. 1sacord 40 6133
2. Isacord 40 4752
3./ Isacord 40 5552

£d 12523-04

1. lIsacord 40 0310
2. Isacord 40 0310
3. [ Isacord 40 1701
4. 1sacord 40 1701
5. lsacord 40 0311
6. Isacord 40 1102
7.l 'sacord 40 2508
8. [l Isacord 40 1701
9. Isacord 40 2530
10.  Isacord 40 0101
13. [l 1sacord 40 4174

172 x 50 mm
6.8 x 2 inch

7

u 3.005

11.

127 x 120 mm
5x 4.7 inch

2

n 16.595

46 x 60 mm

il 1.8x2.4inch B 26
110 x 139 mm

l 4.3 x 5.5 inch n 13.768

Isacord 40 0310

12. [l Isacord 40 1701
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L4 12523-05
1.1 Isacord 40 0151
2.| Isacord 40 0151
3.1 Isacord 40 0151
4.] | lsacord 40 4111
5.l lsacord 40 2504
6.l 1sacord 40 4174
7. Isacord 40 0101
8. Isacord 40 4073
12523-16
1. [l Isacord 40 1701
2.1 Isacord 40 1102
3. Isacord 40 0101
4.] |lsacord 40 3652
5. lsacord 40 3040
6., | lsacord 40 2530
7.8 Isacord 40 1701
8.1 Isacord 40 5822
9.1 Isacord 40 4111
10. [l 1sacord 40 4103
13. [l 1sacord 40 1301
16. [l 1sacord 40 4410
19. [l Isacord 40 1344
22.| |lsacord 40 2530
25. [ 1sacord 40 1902
12633-09
1. Isacord 40 0015
12879-07L
1.1 Isacord 40 5740
2.0 Isacord 40 5440
3. Isacord 40 5210

30 x 75 mm
1.2 x 3 inch

7

173 x 172 mm
6.8 x 6.8 inch

B

11. [l 1sacord 40 2905 12. [ Isacord 40 1902
14.  Isacord 40 0311 15. lIsacord 40 1102
17. [ 1sacord 40 5633 18.[ll Isacord 40 5944
20. Isacord 40 0101 21.[Jll lsacord 40 4103
23.[ 1sacord 40 1102 24. [l Isacord 40 5633
26. [l 1sacord 40 2905

- ISPV - BB

155 x 151 mm
6.1 x 5.9 inch

7

145

(2 12523-06 - ISP - A

1. lIsacord 40 0015

2. lIsacord 40 0015

3.1 |lsacord 40 0151

4. lsacord 40 0311

5.0 Isacord 40 3652

6. 1sacord 40 1701

7. | lsacord 40 5822

8. lIsacord 40 3040

9.l Isacord 40 4103

10.[7] Isacord 40 2530  11.] |Isacord 40 2640 12.[M Isacord 40 5633

13. [l lsacord 40 2504  14. [ 1sacord 40 1902  15. [l Isacord 40 1301

16. [l lsacord 40 4174 17. [ 1sacord 40 4410 18. [ Isacord 40 5944

19. lsacord 40 0101 20.[Isacord 40 4073 21.[JIsacord 40 1902

22. [0 1sacord 40 4111 23. [l 1sacord 40 5944  24. [ 1sacord 40 2905
12620-14 2 [V - [REXCE

1. lIsacord 40 2520

12773-32 s gf‘s);sss.sn;rr:‘ch B s
1.l 'sacord 40 4174
2. lsacord 40 0015
3. lsacord 40 0600
4.l 1sacord 40 1725
5. [ 1sacord 40 0020
12919-02 - [P -- L
1. lsacord 40 2560
2.l isacord 40 2732
3. lsacord 40 1220
4. lIsacord 40 0934
5.l Isacord 40 1055
6. lsacord 40 3962
7., lIsacord 40 3820
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21021-10

1. [l 1sacord 40 1252
2.l Isacord 40 1161
3.l Isacord 40 1565

51204-15

1. 1sacord 40 5510
2. lsacord 40 0703
3.l 1sacord 40 3713
4. |lsacord 40 1102
5.l Isacord 40 3210
6. ] 1sacord 40 1805
7.l sacord 40 2723

51278-01

1. lIsacord 40 1260
2. [ Isacord 40 0731

51278-10

1. Isacord 40 0731
2. lIsacord 40 1260

82001-08

1.l 1sacord 40 1252
2.l lsacord 40 0933
3.l Isacord 40 1252

117 x 148 mm
4.6 x 5.8 inch

Bl 14460

28 x 172 mm
i 1.1x6.8inch B 5o

116 x 147 mm

< 4.6 x 5.8 inch

89 x 228 mm

< 3.5 x 9 inch

76 x 78 mm

< 3 x3.1inch

21021-14

1. [l Isacord 40 1252
2.8 Isacord 40 1161
3.l Isacord 40 1565

51204-22

1.l 1sacord 40 2723

51278-09

1. lIsacord 40 1260
2.[W Isacord 40 0731

82001-04

1.l 1sacord 40 0933
2.l 1sacord 40 1252

82001-12

1.l 1sacord 40 0933
2.l isacord 40 1252

146

122 x 122 mm
4.8 x 4.8 inch

23 x 27 mm

7 PSRN -- I
110 x 128 mm

s 4.3 x 5 inch n 7.310

97 x 103 mm
il 338 x4.1inch B oo

60 x 95 mm
8 24x38inch B s
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52 x 60 mm 242 x 242 mm
82001-20 i 2 24inch H 3.448 82001-40 il o o5 inch u 22.712

1. [l 1sacord 40 0933 1. [l Isacord 40 1252

186 x 249 mm 138 x 145 mm
82005-15 il 73 x9.38inch - JEEELE 82005-22 il 5.4x5.7inch B 2

1. 1sacord 40 1032
2. lIsacord 40 0870

1. Isacord 40 1032
2. lIsacord 40 0870
3. lsacord 40 0851
4. [ 1sacord 40 1346
5.l lsacord 40 1346
6. [l lsacord 40 1346
7.  lsacord 40 2650
8. Isacord 40 0851
9. 1sacord 40 1753
10. lIsacord 40 0870 11.| Isacord 40 0851 12.[JIsacord 40 1346

54 x 54 mm 108 x 46 mm
82015-23 il 2.1x2.1inch B 2000 Bd361 il 42 x1.8inch - JRREY

1. [ Isacord 40 0504
2., lIsacord 40 2152
3.l Isacord 40 2920
4. [l 1sacord 40 3815
5. lsacord 40 5610
6. Isacord 40 1010

1.1 Isacord 40 2152
2.0 1sacord 40 0874
3. Isacord 40 0532
4.] | lsacord 40 0453

e

125 x 123 mm 114 x 99 mm
Fs327_48 2 [ B o5 Pk10005-01 B o oemm B c66

1. 1sacord 40 3810
2. Isacord 40 3920
3. Isacord 40 5115
4. [l 1sacord 40 5510
5. lsacord 40 0713
6. Isacord 40 1200
7. lsacord 40 2520
8.l lsacord 40 2723

1. Isacord 40 0862

Pk10005-02 2 1028;(39;m$ H 3.561 51220-01 2 1(:(26’:?;(:'"‘ u 24353

1. [l isacord 40 0020
2. Isacord 40 0630
3.l lsacord 40 1332
4. Isacord 40 0660
5.l Isacord 40 2521
6.l lsacord 40 2333
7. lIsacord 40 1362
8.l Isacord 40 1334
9. sacord 40 0020

1.1 Isacord 40 1200
2. lIsacord 40 0713
3. [l Isacord 40 5510
4. 1sacord 40 3920
5.l lsacord 40 2723
6.l Isacord 40 1906
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51222-15 - I -- JEE

1. [l 1sacord 40

3. Isacord 40

2., Yenmet 7012 fﬁ
N

4.1 x 3.9 inch
0721

1260

108 x 75 mm
51232-14 il 43 x3inch - JREEES
1. lsacord 40 5230
2. lsacord 40 2520
3. lsacord 40 0608
4. Isacord 40 1114
5. [l Isacord 40 1900
6. 1sacord 40 0020
7. lsacord 40 0010
174 x 174 mm
51251-15l il 6.5x6.9inch B oe
1.1 Isacord 40 4620
2.l sacord 40 2508
3. lsacord 40 0506
4. Isacord 40 6011
N
N \ N
110 x 106 mm
51283-071 il 23x42inch B 2
1. [ 1sacord 40 0020
126 x 211 mm
82026-11 < 4.9 x 8.3 inch H 10.279
1. Isacord 40 1161
2.l lsacord 40 5743

3. | 1sacord 40
4.l 1sacord 40

5.0 Yenmet 7012

0020 %
0721 '

51222-16

1. lIsacord 40
2. 1sacord 40

1260
0721

3.1 Yenmet 7012

51232-15

1.0 lIsacord 40
2. lIsacord 40
3. [l Isacord 40
4. lIsacord 40
5.1 lIsacord 40
6. sacord 40

5230
0010
1900
0608
1114
0020

51283-01|

1. [ 1sacord 40

0020

51283-08l|

1. [ 1sacord 40

0020

82026-13

1. 1sacord 40
2.l 1sacord 40
3.1 Isacord 40
4. | 1sacord 40
5. 1sacord 40
6.l Isacord 40
7. 1sacord 40

1161
5743
5822
0020
3762
3953
3732

8.1 Yenmet 7012

9. Isacord 40

0721

10..  Yenmet 7012

148
s g.zz);ssz.zn;:ch B s
s 2?5);1;;‘ inch |
3 B
l
r ;.28);1;2 mm B zs04
. iﬁ’;zﬁg mm B 5o
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132 x 138 mm 96 x 108 mm
82026-16 z 5.2 x 5.4 inch H 17748 82026-31 z 3.8x4.2inch n Sz
1. [l Isacord 40 0721 1. [ Isacord 40 0721
2., Yenmet 7012 2.|  Yenmet 7012
3. [l Isacord 40 1161
4.l 1sacord 40 5743
5. Isacord 40 3762
6.l 1sacord 40 3953
7. [ sacord 40 3732
8., Yenmet 7012
9. Isacord 40 0660
10.  Isacord40 1060 11.[  Yenmet 7012 12.  Isacord 40 1761
13.1 Yenmet 7012 14.[ l1sacord 40 5822 15[ Isacord 40 0020
78 x 78 mm 76 x 156 mm
82026-32 < RN -- RS Nb830_48 il 36.1inch -~ JEREE
1. Isacord 40 0721 1., lsacord 40 9925
2.1 Yenmet 7012 2.l Isacord 40 9975
3.l lsacord 40 9924
4.l 1sacord 40 9973
5.8 Isacord 40 1972
124 x 142 mm
Nb840_48 B oxscinn B 1159
1.1 Isacord 40 9925 i
2.l Isacord 40 9971 4
3. Isacord 40 9937
4.l 1sacord 40 9973
5.l Isacord 40 9924
6.l Isacord 40 1972
19.4 Borders
31 x 152 mm 75 x 75 mm
12398-13 il 12 x6inch - JREEE 12398-14 il 29x29inch - JREEE
1.1 Isacord 40 5822 1.0 Isacord 40 5822
2. |lsacord 40 2153 2.. |lsacord 40 2153
3. Isacord 40 2155 3. lIsacord 40 2155
32 x 152 mm 76 x 76 mm
12398-20 il 136 inch -~ R 12398-21 il 33inch - JEERE
1. lIsacord 40 6051 & 1. lsacord 40 6051
2. lIsacord 40 5610 .,-" 2. lIsacord 40 5610
3. Isacord 40 4250 i 3. Isacord 40 4250
4. lsacord 40 4430 4. lsacord 40 4430
5. lsacord 40 6051 5. lsacord 40 5610
6. lIsacord 40 5610 6. Isacord 40 6051
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12398-24

1. [l Isacord 40 4220
2.l Isacord 40 0722

12428-32

1. Isacord 40 0015

12445-18

1. Isacord 40 1010

12508-26

1. lIsacord 40 0352
2. 1sacord 40 6133
3.1 Isacord 40 4752
4.1 |lsacord 40 5552

12576-10

1.l 1sacord 40 3444
2.l lsacord 40 1332
3. [ Isacord 40 2022

7

7

PN TN Tt

7

s

30 x 152 mm
1.2 x 6 inch

115 x 18 mm
4.5 x 0.7 inch

108 x 16 mm
4.2 x 0.6 inch

44 x 152 mm
1.7 x 6 inch

70 x 200 mm
2.8x7.9inch

B s2s

H 2192

H 2.680

H 8.761

H 10.961

12418-25

1.1 |lsacord 40 6141
2., lIsacord 40 5822
3. lIsacord 40 2250

12428-33

1. Isacord 40 0015

12445-20

1. 1sacord 40 1010

12508-27

1. lIsacord 40 0352
2. 1sacord 40 6133
3.1 Isacord 40 4752
4.1 | lsacord 40 5552

51208-15

1. [ 1sacord 40 0020

150

25 x 141 mm
1x5.5inch n 20
39 x 39 mm

7 [P -- ISR

33 x 33 mm
<z 1.3x 1.3 inch n 1.234
i 1 '.}
=
% .
e 4=
Elleesee,,
Sl &
b of 5
’ -—-----'1 .“_l %
78 x 77 mm
s 3.1 x 3 inch u aE0
Ape
N
W) W
48 x 170 mm
A o7 B 2614
‘/”:



1.
2.
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Fb038

Isacord 40
Isacord 40

0352
1532

3.l Isacord 40 1730

Hg792_48

1.l 1sacord 40 1900

2.

Isacord 40

4113

3. [l 1sacord 40 1355

1.
2.
3.
.l 1sacord 40

4

1.
2.

3.
4.
5

12426-18

Isacord 40
[l 1sacord 40
Isacord 40

51214-1

[l 1sacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40

0520
1730
0800
3920

51

6043
3030
0442
3630
3650

82008-45

Isacord 40

0453

107 x 22 mm
4.2 x 0.9 inch

21 x 153 mm
0.8 x 6 inch

i
Py
TP

%)
S

N
c?)

e’

D

7

178 x 27 mm
7 x1.1inch

s

2 82 x 260 mm

3.2x10.2 inch

116 x 115 mm
4.6 x 4.5 inch

s

B s« Fs114_48
1.0 lIsacord 40 6011
2. Isacord 40 6133
3., Isacord 40 2550
4. Isacord 40 2520
B 200 Nz819
1.0 Isacord 40 5220
B 102 12426-19
1. 1sacord 40 3920
2. Isacord 40 0800
3.l sacord 40 1730
4. Isacord 40 0520
- JEEZN 82008-44
1.1 | Isacord 40 0453
B 50 82028-32
1.l 1sacord 40 1521
2.l Isacord 40 1725
3., Isacord 40 1352

151

24 x 103 mm
z 1x4.1inch n 3.963

woneelng

AP

71 x 45 mm
il 235 1.8inch - JEEZE

62 x 82 mm
<z 2.4 x3.2inch n 23

35x 171 mm
il 1.4 x6.7inch -~ JERES

30 x 178 mm
<z 1.2x 7 inch H 51820
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152

89 x 89 mm 33 x 169 mm
82028-33 <z 3.5x3.5inch H S Cm575—48 z 1.3 x 6.6 inch n 7514
1.. Isacord 40 1521 1. lIsacord 40 5230 M
2.l Isacord 40 1725 2. Isacord 40 5933 ¥,

3.1 Isacord 40 1352

Cm576_48

1. Isacord 40 5633
2.l 1sacord 40 5643
3. Isacord 40 5610
4.l 1sacord 40 6133
5. Isacord 40 5934
6.[  Isacord 40 5531

3. Isacord 40 5610
4. [ Isacord 40 4152
5.0 Isacord 40 4610

89 x 68 mm

il 35527inch H 7.924 Pk10019-05 gy 71x50 mm

2.8 x 2inch

1.0 Isacord 40 0832
2.| lsacord 40 2530
3. [l 1sacord 40 2508
4. [l 1sacord 40 1730
5.0 Isacord 40 0904
6. Isacord 40 5740

36 x 190 mm
Pk10019-06 2 [ B 12430
1. Isacord 40 0670 R
=
2. lsacord 40 5740 *f
3.l Isacord 40 1730 .
4.  Isacord 40 0670 . w
5.0 lsacord 40 2530 3
6. Isacord 40 0832 B
7.l Isacord 40 2508 a
8. ] lsacord 40 0134 q
9.l Isacord 40 0904
19.5 Frames
122 x 122 mm 124 x 124 mm
12508-24 il 4.8x438inch B ss0 12719-53 il 4.9x4.9inch B s

1. lIsacord 40 0352
2.l Isacord 40 6133
3.l Isacord 40 4752
4. 1sacord 40 5552

12931-01

1. Isacord 40 0721
2. 1sacord 40 0731
3. Isacord 40 0660
4. 1sacord 40 0721
5.0 lsacord 40 0741
6. Isacord 40 0660
7. Yenmet 7011

=N
{ ;
s’

Bl 14443

150 x 150 mm
<z 5.9 x 5.9 inch H Z2E

121 x 122
51208-08 @l 48458 inch

1., lsacord 40 0131
2. [l 1sacord 40 5743
3.l lsacord 40 5643
4. ] 1sacord 40 0020
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153

124 x 135 mm 182 x 126 mm
51285-08 4.9 x 5.3 inch H 1eL5i= Ckos3 7.2 x4.9 inch n 12572
1. [l 1sacord 40 0152 1.1 lsacord 40 2166
2. lIsacord 40 2650
3.l Isacord 40 2721
4. ] 1sacord 40 0020
5. Isacord 40 0020
183 x 117 mm 139 x 162 mm
Ck993 -~ RPN -- IRERZE 82020-54 2 It -- RN
1. lsacord 40 0015 > = ‘.' f 1.. Isacord 40 0345
2.[ Isacord 40 0811 B$ il h - 2. lIsacord 40 0761
3.l 1sacord 40 1904 ' 3. 1sacord 40 0622
4. 1sacord 40 0108 l *x 4. Isacord 40 0542
5.l 1sacord 40 3711 - 4 5.1 Isacord 40 0442
2 4 ¢ 6. Isacord 40 0622
v p— v 7.[0 Isacord 40 0542
2 W 4 % 8. lsacord 40 0221 " ua
203 x 197 mm 305 x 299 mm
82022-17 Ml 5 7.8inch B e 12795-05 - Iyt - - [
1.l 1sacord 40 0674 1.0 Isacord 40 2830 M\
2.l 1sacord 40 2810 o TN
3.l Isacord 40 2504 )
4.[ Isacord 40 0811 .
5.0 lIsacord 40 1141
Qs_.:- / |
R\ ¥
237 x 305 mm
51227-04 il 93 x12inch B sss
1. Isacord 40 4610 RN
2. lsacord 40 0702 F ol \Q
3.0 Isacord 40 1840 ‘_€ D
4.  Isacord 40 1860 = ;-'
5.l lsacord 40 4174 WY )
6. Isacord 40 0010 Q . é&’
7. [l Isacord 40 1521 \*\ -
8.| lsacord 40 1352 N —f’
9. Isacord 40 0713
19.6 Lace
. 110 x 92 mm . 147 x 123 mm
12474-01 - IPESr A -- IRIAIE 12474-19 Bl e iome B 25009

1. lsacord 40
2.1 lIsacord 40
3.1 Isacord 40
4. [ 1sacord 40
5.1 Isacord 40

6. [l 1sacord 40

2051
2051
2051
2241
0131
0112

1.0 Isacord 40
2.|  lsacord 40
3.l Isacord 40
4.l 1sacord 40
5.l Isacord 40
6.1 Isacord 40

5822
5531
5633
5633
5633
0771
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12609-03

Isacord 40 0015
Isacord 40 0015
Isacord 40 0015
Isacord 40 0015
Isacord 40 0015
Isacord 40 2250
Yenmet 7008

N o v kA wWwN =

12635-03

1.0 |lsacord 40 0131
2.l 1sacord 40 0132
3. 1sacord 40 0112

12746-11

1. Isacord 40 2762
2. Isacord 40 0761
3. [l Isacord 40 2764
4.1 Isacord 40 2153

12771-01

Isacord 40 0870
Isacord 40 0870
Isacord 40 0870
Isacord 40 0101

AW =

12779-02

1.l 1sacord 40 1874

7

s

7

s

222 x 76 mm
8.7 x 3inch

38 x 165 mm
1.5 x 6.5 inch

110 x 110 mm
4.3 x 4.3 inch

135x 211 mm
5.3 x 8.3 inch

87 x 210 mm
3.4x 8.3 inch

B 3350

H 16.833

H 21.560

H 44.572

H 63.342

12609-04

Isacord 40 0015
Isacord 40 0015
Isacord 40 0015
Isacord 40 0015
Isacord 40 2250
Isacord 40 0015
Yenmet 7008

N ou A~ WwN =

12742-01

1.l 1sacord 40 1911

12758-03

1. lIsacord 40 0015

12779-01

1. 1sacord 40 1874

12779-05

1.l 1sacord 40 1874

154

84 x 85 mm
i 33x33inch B sose
C_."_\
137 x 133 mm
il 5.4x5.2inch B ses

50 x 173 mm

<z 2 x 6.8 inch n 21.912
106 x 210 mm

il 22x83inch B 77504
76 x 75 mm

il 352.9inch B ces
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12788-01

Isacord 40 4071
Isacord 40 4071
Isacord 40 4071
Isacord 40 0010

AW =

12896-05

1. Isacord 40 0781

82018-08

1. lIsacord 40 0010

82018-14

Isacord 40 0010
Isacord 40 2153
Isacord 40 2241
Isacord 40 1172
Isacord 40 0010

vA W=

82018-30

1.0 Isacord 40 1161

141 x 218 mm
5.6 x 8.6 inch B 677
116 x 117 mm

il 4.6 x 4.6 inch B s

129 x 64 mm
5.1 x 2.5 inch

s

u 16.909

88 x 139 mm
il 3555 inch B 26422

o 9

jl‘lt 2

76 x 68 mm

< 3x2.7inch

N
\

(= ~—
l._'\'ﬁ/ ‘\\

12889-09

1 Isacord 40 0017
2. | lIsacord 40 3652
3. Isacord 40 2650
4 Isacord 40 3030

82014-34

1.1 |lsacord 40 0131

82018-13

1. lIsacord 40 0010

82018-18

1. lIsacord 40 1172

0c07107

1. lIsacord 40 0670

133 x 224 mm
5.3 x 8.8 inch

45 x 76 mm

s 1.8 x 3iinch

177 x 223 mm

<z 7 x 8.8 inch

89 x 125 mm

s 3.5x4.9inch

121 x 172 mm

<z 4.8 x 6.8 inch

155

n 51.499

n 71.896

u 20.053

H 50.579
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. 130 x 130 mm . 196 x 394 mm
12667-08 B e B a7 12794-02-06 7 [ - [REEPES

1.1 Isacord 40 0504 1. Isacord 40 0015

2.l sacord 40 2115

19.7 Mini

27 x 31 24 x 31
12491-23 2 [N - REE 12819-01 2 [N B

1.l 1sacord 40 3815 1., lsacord 40 0934
2. lsacord 40 3962 2. Isacord 40 6133
3. [l Isacord 40 3902 3.1 |lsacord 40 6141
4. ] 1sacord 40 0020 4. lIsacord 40 5650
5.l 1sacord 40 5944

e

12819-02 Bx3omm B s 12819-03 7 [ -~ REIE

1. [l Isacord 40 5944
2., lIsacord 40 6141
3. Isacord 40 5933
" 4.[ |lsacord 40 5531
5. Isacord 40 1010
6. Isacord 40 0015

1. Isacord 40 4071
2. lIsacord 40 0015
3. Isacord 40 0800
4. ] 1sacord 40 0020

12819-04 0xymm Y 1% 12819-05 - [P - [IREY

’ 1. lIsacord 40 3650

2.. lsacord 40 3910
3. [l 1sacord 40 3902
12819-06 2 [ B 12819-07 z

1. [ 1sacord 40 0020
2.1 Isacord 40 2530
3. Isacord 40 0800

4.1 |lsacord 40 0131 4.1 |lsacord 40 2530

1. lsacord 40 0970 1. lsacord 40 0310
2.| |lsacord 40 0771 2. Isacord 40 1725
3. [l Isacord 40 0945 3.1 |lsacord 40 2530
4.l 1sacord 40 1725 4.l 1sacord 40 2702
5. lIsacord 40 0015
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12819-08
1. [l 1sacord 40 0132
2.| Isacord 40 2530
12819-11
1.1 Isacord 40 0771
2. 1sacord 40 1725
3. lIsacord 40 0800
4. lsacord 40 0015
5.0 Isacord 40 0131
6 Isacord 40 6141
12819-13
1. Isacord 40 5664
2.l Isacord 40 5933
3.1 Isacord 40 3730
4.l 1sacord 40 4032
12819-17
1. Isacord 40 3830
2., lsacord 40 3730
3.| Isacord 40 5531
12819-20
1. Isacord 40 4032
2. lIsacord 40 3650
3.l Isacord 40 5101
4. lsacord 40 0970
5.0 Isacord 40 2530
6. Isacord 40 0800

33 x 34 mm
1.3 x 1.3 inch

7

- JEEE

34 x 32 mm

< 1.3 x 1.2 inch

H 1355

34 x 35 mm

< 1.3 x 1.4 inch H 1A
32 x 34 mm

il 13 1.4inch -- R
31 x 34 mm

< [Pey i -- RREE

12819-10
1.1 |lsacord 40 2530
2.l isacord 40 1725
3. 'sacord 40 0020
4.l Isacord 40 1010
5.0 | Isacord 40 5531
6. Isacord 40 3045
12819-12
1.1 |Isacord 40 6141
2.. |lsacord 40 5531
3.[l 1sacord 40 5944
4.1 |lsacord 40 0131
12819-14
1. lIsacord 40 0015
2. lIsacord 40 2530
3.1 Isacord 40 6141
4. ] 1sacord 40 0020
12819-18
1.0 lIsacord 40 0822
2. Isacord 40 1010
3. [l 1sacord 40 0020
12822-06
1.l 1sacord 40 5510
2. lIsacord 40 5822
3.l Isacord 40 3901
4. lsacord 40 2152
5. Isacord 40 0904
6. Isacord 40 2171
7. isacord 40 4114

157

z 3.23);3:4n;rr:lch -
- [Ty - L
2 [PV -- B
- IR S -- RIZE
l 3?;316.4.1;:1[1 B roe
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12822-07

1. [l Isacord 40 3901
2.1 Isacord 40 5822
3.l Isacord 40 4114
4. Isacord 40 0015

12822-12

1.1 Isacord 40 2152
2. 1sacord 40 3901
3.] Isacord 40 3730
4.l 1sacord 40 1725
5. lsacord 40 2155
6.[  Isacord 40 5531

12822-14

1.0 | lsacord 40 5531
2.l 1sacord 40 3211
3.1 Isacord 40 2640
4.  Isacord 40 2171

12822-18

1. Isacord 40 3901
2. [ Isacord 40 3251
3.1 Isacord 40 5531
4. [l lsacord 40 4114
5.0 lsacord 40 2640
6.[ Isacord 40 3150
7.1 Isacord 40 6141
8 Isacord 40 0015

12903-07

1.1 Isacord 40 4740
2. 1sacord 40 5115
3.1 Isacord 40 3150

32 x 38 mm

z 1.3 x 1.5 inch

28 x 30 mm

< 1.1 x 1.2 inch

24 x 28 mm

< 0.9 x 1.1 inch

80 x 84 mm

< 3.2x3.3inch

21 x45 mm

il 0.8 x1.8inch

12822-10

1., lIsacord 40 3150
2.8 Isacord 40 3251
3.1 Isacord 40 5531

12822-13

1. lIsacord 40 2155
2., | lsacord 40 2152
3. 1sacord 40 3901
4. lIsacord 40 0015
5.l Isacord 40 6043

12822-15

1. [l Isacord 40 6043
2.| lIsacord 40 2152
3.l Isacord 40 1725
4. lsacord 40 0015
5.l Isacord 40 3901
6. Isacord 40 2640

12836-35

1.l 1sacord 40 1900
2.l 'sacord 40 2011
3. Isacord 40 5833
4. lsacord 40 0010

21017-15

1., lIsacord 40 0453
2. lIsacord 40 0442
3. Isacord 40 0345
4. lIsacord 40 0702
5.0 lsacord 40 1102
6. lIsacord 40 0640

7

2

2

7

2

22 x 48 mm
0.9 x 1.9 inch

28 x 28 mm
1.1 x 1.1inch

158

B s

u 909

76 x 78 mm
3 x3.1inch

45 x 46 mm
1.8 x 1.8 inch

30 x 36 mm
1.2 x 1.4 inch

B
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30 x 29 mm 24 x 42 mm
51215-18 <z 1.2 x 1.1 inch H = 51253-07 Z 0.9 x 1.7 inch n 1.008
1. lsacord 40 6011 1. lsacord 40 0506
2.l 'sacord 40 1904 g 2. lsacord 40 2160
3. [l Isacord 40 5912 : 3.1 |lsacord 40 2530
4.l 1sacord 40 5633 - .E@, 4. Isacord 40 2520
Py Iy « 1 E14
@h‘&h
26 x 41 mm 34 x33 mm
51253-08 il 1x1.6inch B o 51253-13 - [N - R
1., lsacord 40 0741 by 1.  lsacord 40 0670
2. lsacord 40 0506 AR 2. lsacord 40 0506

3. Isacord 40 0520 . 3. Isacord 40 1030
: 4.l sacord 40 4174
5. lsacord 40 2520

26x24 20x 27
51253-20 4 09 inch - JEIE 80081-18 7 [FPOURUN -- [EE2

1. lIsacord 40 0506 ~ 1. lsacord 40 2520

2. Isacord 40 1030 2.l isacord 40 2521 W

3.1 Isacord 40 0741

V5

L

107 x 23 mm . 32 x 24 mm
80081-19 il 42 x0.9inch -~ JREEE Cj325 il 1.2x0.9inch - JRIELE
1. [l Isacord 40 2521 1. lsacord 40 3761
2. lIsacord 40 0250
3.0 Isacord 40 2153
. 24 x 33 mm . 20 x 23 mm
Cj587 @ 0.9 13 inch B oo Cj850 il 0.8 x0.9inch B o
1. Isacord 40 2171 1., lsacord 40 3640

2.0 Isacord 40 1840
3. lIsacord 40 5610

2. lIsacord 40 1755
3.| | Isacord 40 3331

. 23 x 22 mm . 25 x 19 mm
Cj862 < ST -- R Cjs64 il 1038 inch B e
1. lsacord 40 0630 ) 1. 1sacord 40 2764
2. Isacord 40 0221 ‘ tj‘l 2., lIsacord 40 0811
3.1 Isacord 40 1352 .f..--"-" \ : 3. Isacord 40 0713
\ tary 4.[7 Isacord 40 1430
g = l...._._..i
-
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160

- 19 x 22 mm . 25 x 25 mm
C]866 z 0.7 x 0.9 inch H EEo C1868 z 1x 1inch n ol
1. [l Isacord 40 2764 1. lIsacord 40 3761
2. lIsacord 40 0630 2., lIsacord 40 3331
3. Isacord 40 4071 3. Isacord 40 0713
4.l 1sacord 40 2920
. 32 x 24 mm 34 x 31 mm
Cj870 il 12 x1inch B o Nv104 7 [N -- REE
1. lIsacord 40 6051 1.l 1sacord 40 3600
2. lsacord 40 0811 (-""{? . 2. lsacord 40 0015
- et
3. lsacord 40 3650 oy ;—-F - 3.l 1sacord 40 1902
4.[ lsacord 40 3951 TERRA
5 3 e, Y
“*:1.1 s
18 x 21 mm 15 x 15 mm
0c86069 B o osinen B 44 0c86074 A oosinen B 3
1. lIsacord 40 3962 1. lIsacord 40 2155
2.[lIsacord 40 3641 2. Isacord 40 2764
\
55 x 34 mm
12507-32 < 2.2 x 1.3 inch H 3.989
1. lIsacord 40 0015
19.8 Flowers
127 x 133 mm 80 x 205 mm
Hb101 il 552 inch - JREEEE 12379-33 il 31x8.1inch B ooo

1. [l 1sacord 40 5722
2.l 1sacord 40 5643
3. Isacord 40 2560
4. 1sacord 40 2532
5. Isacord 40 1921
6. lIsacord 40 0640

1. lIsacord 40 2170
2. 1sacord 40 2761
3. lsacord 40 0311
4.l 1sacord 40 0931
5.0 lIsacord 40 6141
6. Isacord 40 0453
7.1l 1sacord 40 5944
8. Isacord 40 2051
9. Isacord 40 2764
10. lsacord 40 0015

11. [ Isacord 40 0853
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96 x 156 mm 104 x 160 mm
12379-49 B i iinn B 14900 12417-08 - ISR - [REFPY

1. lsacord 40 3350
2.l Isacord 40 3130
3. lIsacord 40 2650
4.l 1sacord 40 2920
5.l Isacord 40 2900
6.l Isacord 40 2510
7.l 1sacord 40 2832
8. Isacord 40 1362
9. Isacord 40 0453
10. [l Isacord 40 5944

1.0 lIsacord 40 0442 i =
2.l 1sacord 40 0721 '
3. Isacord 40 0532
4.l Isacord 40 0345
5.l 1sacord 40 1521
6. Isacord 40 0811
7. 1sacord 40 1010
8. Isacord 40 1311

113 x 136 mm 32 x40 mm
12417-10 e 45 x5.4inch - JEXES 12422-31 8 13x1.6inch -~ JREES

1.0 Isacord 40 0811
2.l Isacord 40 0721
3. [l Isacord 40 1032
4. 1sacord 40 0345

1.0 Isacord 40 1114
2./ Isacord 40 1311
3., Isacord 40 0811

82 x 125 mm 134 x 132 mm
12713-01 e 3 4.9inch -~ JRERER 12713-03 i 53 x5.2inch B i

1., lsacord 40 5450
2.[ Isacord 40 2530
3.l 1sacord 40 4174
4.l 1sacord 40 4174
5./ Isacord 40 2530
6.l Isacord 40 2320

1.0 Isacord 40 5832
2. Isacord 40 5450
3. [l 1sacord 40 5722
4.l 1sacord 40 1321
5. 1sacord 40 1911
6.l lsacord 40 4174
7.1 Isacord 40 2530
8.l 1sacord 40 2320
9.l Isacord 40 1730
10. [l lsacord 40 1911 11, Isacord 40 0800 12. [ Isacord 40 1321
13.  lsacord 40 0015 14.[J lsacord 40 4174

46 x 86 mm 117 x 155 mm
12773-40 e 18 x3.4inch B son0 12914-01 i 46 x6.1inch - [REEEE

1. lIsacord 40 2155
2. lIsacord 40 5830
3. sacord 40 0020

1.l 1sacord 40 2600
2.8 Isacord 40 2241
3. [l lsacord 40 2944
4.l 1sacord 40 1342
5. 1sacord 40 5643
6. Isacord 40 5912
7. Isacord 40 0465

112 x 154 mm 113 x 153 mm
12914-02 8 4.4 x6.1inch B s 12914-03 i 4.4 x6inch -~ JRERER

1.l 1sacord 40 5643
2.l sacord 40 5722
3.1 Isacord 40 5912
4.l 1sacord 40 0465

1.l 1sacord 40 5643
2.l 'sacord 40 5722
3. 1sacord 40 5912
4.l Isacord 40 0853
5.l Isacord 40 0465
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12914-06

1. [l 1sacord 40 5722
2.1 Isacord 40 5912
3. [l Isacord 40 0465

12914-08

1. Isacord 40 5912
2.l 1sacord 40 5643
3.l 1sacord 40 5722
4.l 1sacord 40 0465

12931-05

1. lsacord 40 0660
2. [ Isacord 40 0731
3. Isacord 40 0660
4. 1sacord 40 0721
5.0 lsacord 40 0741
6.l Isacord 40 0721
7. Yenmet 7011

32040-08

1.l 1sacord 40 1900
2. lIsacord 40 0800
3.l Isacord 40 4114
4. Isacord 40 0800
5.l lsacord 40 5643
6.l Isacord 40 0132
7.0 Isacord 40 2220
8. lIsacord 40 0800
9.l Isacord 40 4114
10. [l Isacord 40 1900

51202-11

1. Isacord 40 5770
2.| Isacord 40 5822
3. Isacord 40 1911
4. 1sacord 40 1921
5.0 Isacord 40 1430
Isacord 40 1532
Isacord 40 1362
Isacord 40 2153

9.1 Isacord 40 2152
10.  Isacord 40 2155
13. [ Isacord 40 0622

© N o

110 x 151 mm

z 4.3 x5.9 inch

\ Petrosalinum-Aplaceas

106 x 159 mm

< 4.2 x 6.3 inch

81 x 128 mm

<z 3.2x5.1inch

126 x 133 mm

< 4.9 x 5.2 inch

11. ] Isacord 40 5643

64 x 75 mm

z 2.5 x 3 inch

11.  lIsacord 40 2171 12. Isacord 40 0010

B 533

H 16.390

B 72

12914-07

1. [l Isacord 40 5643
2. Isacord 40 0853
3. Isacord 40 5912
4. [l 1sacord 40 0465

12931-04

1. lsacord 40 0660
2.[W Isacord 40 0731
3. lIsacord 40 0660
4.l 1sacord 40 0721
5.0 lIsacord 40 0741
6. Isacord 40 0721
7. Yenmet 7011

32040-02

1. lIsacord 40 6031
2.l isacord 40 5643
3. lIsacord 40 4240
4. lIsacord 40 0702
5. 1sacord 40 3210
6. [l 1sacord 40 1902
7.l 'sacord 40 1543

32040-09

1. lIsacord 40 0800
2.[¥ Isacord 40 5912
3. [l 1sacord 40 5643
4. lIsacord 40 0800
5.0 lsacord 40 2220
6.l lsacord 40 4114
7.1l 1sacord 40 1900

51202-12

1., lsacord 40 5770
2., lIsacord 40 5822
3.l lsacord 40 1911
4. Isacord 40 2155
5.0 lsacord 40 2152
6. lIsacord 40 2171
7.0 lIsacord 40 2153
8. Isacord 40 1921
9. Isacord 40 0010
10. [ Isacord 40 0622

162

122 x 153 mm
4.8 x 6 inch

B s

L1

ROSB mary

‘R Sabvia:Larmiacoss

89 x 176 mm
M 35x6.9inch B 02

128 x 114 mm

<z 5.1 x 4.5 inch

n 16.844

119 x 173 mm
il 4.7 x6.38inch -~ [REEEE
-!.';,r.
83 x 46 mm
s 3.3 x 1.8 inch n 5.388




1
1

—
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51202-1

1. [} 1sacord 40
2. |l sacord 40
3.l Isacord 40
4.l 1sacord 40
5./ Isacord 40
6. [ Isacord 40
7.} 1sacord 40
8. [ Isacord 40

3

5833
6043
5933
5643
2153
1921
1911
0622

51227-08

1. lsacord 40
2. lIsacord 40
3. [l Isacord 40
4. [l 1sacord 40
5. lIsacord 40
6. [l 1sacord 40
7.0 lIsacord 40
8.  Isacord 40
9. |l 1sacord 40
0. |l 1sacord 40
3. Isacord 40

82006-1

1. lsacord 40
2. [ Isacord 40
3. [l Isacord 40
4.l 1sacord 40
5. [l Isacord 40

Fp785

1.1 Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40

© L XNV A WN

4430
0010
4610
4515
0702
1521
1840
1860
4174
1704
1755

7

0660
0832
1526
4421
4174

3150
5822
0232
5770
1755
2152
2363
3650
0640
0131

7

88 x 77 mm
3.5x 3 inch

Bl 0693

124 x 136 mm
4.9 x 5.4 inch

B 26077

1.l 1sacord 40 1521 12.
14. [l 1sacord 40 4174

7

7

35 x 37 mm
1.4 x 1.4 inch

99 x 104 mm
3.9x4.1inch

Isacord 40 0010

51203-

13

1.0 Isacord 40 5832
2.l 'sacord 40 5643
3. [l Isacord 40 0945
4. lsacord 40 2220
5. lIsacord 40 0310
6.l lsacord 40 4116
7. lsacord 40 2155

8.l Isacord 40 2920
9. Isacord 40 0010
51227-10
1. [l lsacord 40 4515
2. Isacord 40 0702
3.8 Isacord 40 4610
4. Isacord 40 0010
5.0 lIsacord 40 1840
6. Isacord 40 1860
7.1 1sacord 40 4531
8.l lsacord 40 4515
9.l Isacord 40 1521
10.| Isacord 40 1840
13.] Isacord 40 1840
Cm416_48
1. Isacord 40 0504
2. Isacord 40 0904
3./ Isacord 40 1311
4. lsacord 40 2155
5.0 lsacord 40 5822
6.1 Isacord 40 5833
7. lsacord 40 2655
8. lIsacord 40 3045
9. Isacord 40 3130
Fq561_48
1.1 | Isacord 40 0552
2. lIsacord 40 6051
3. Isacord 40 5833
4. 1sacord 40 5934
5.0 lsacord 40 5822
6.0 Isacord 40 5833
7. lsacord 40 5650
8.| |lsacord 40 3652
9.| |lIsacord 40 3641
10. [l 1sacord 40 3620
13. [ sacord 40 2123

163

117 x 125 mm

z 4.6 x 4.9 inch u 19.514
90 x 136 mm

z 3.5x5.4inch n 2009

11. [l lsacord 40 4174

12.  Isacord 40 0010

76 x 70 mm
M 3238inch - JEREH
."',_,:
185 x 243 mm
M 7.3 x9.6inch - JRERZE

11.  lsacord 40 0970
14. [l sacord 40 1913

12. [l 1sacord 40 1805
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Fq986_48
1. Isacord 40 5650
2.8 Isacord 40 5833
3. Isacord 40 0352
4. 1sacord 40 5934
5. [l Isacord 40 0465
6./ Isacord 40 5822
7. Isacord 40 0015
8. Isacord 40 0781
9.1 Isacord 40 0170

10.1 | Isacord 40 0731

Na882
1. lIsacord 40 0352
2.1 Isacord 40 0453
3. Isacord 40 0532
4. lsacord 40 1060
5.0 lsacord 40 1430
6. Isacord 40 1532
7. Isacord 40 3650
8.1 Isacord 40 3641
9.l Isacord 40 3762

10.  Isacord 40 2655

13.  lsacord 40 0520

16.  lsacord 40 2250

51322-01
1.l 1sacord 40 5542
2. 1sacord 40 5730
3.1 Isacord 40 5833
4.l 1sacord 40 5743
5.l Isacord 40 2506
6.l Isacord 40 2521
7. 1sacord 40 2320
8. Isacord 40 2520
9. Isacord 40 2170
51322-03
1. [l 1sacord 40 6043
2. Isacord 40 5833
3.l Isacord 40 5933
4. 1sacord 40 0853
5.0 Isacord 40 1061
6. Isacord 40 0310
7. lIsacord 40 6051
8. Isacord 40 0250
9. Isacord 40 0311
10..  Isacord 40 0811

139 x 145 mm
<z 5.5 x 5.7 inch H ZHELE

1. lsacord 40 0640 12.[MIsacord 40 6133

Fs316_48

1.l Isacord 40 3853

- I -- L 0c86020
1. lIsacord 40 5610
2.8 Isacord 40 0504
3.l Isacord 40 0922
4.0 Isacord 40 1840
5. lsacord 40 2363
6. Isacord 40 0520
7 Isacord 40 1123
11. [l 1sacord 40 2764 12.  Isacord 40 3040
14.  lsacord 40 0811 15. Isacord 40 0506
17.0 Isacord 40 2153 18.  lIsacord 40 1840
- [Rysrrha - LX) 5132202
= 1.0 |lsacord 40 5531
2. lIsacord 40 6141
3.[ Isacord 40 5633
4. [l 1sacord 40 5643
5. Isacord 40 2920
6. Isacord 40 3130
7.1l 1sacord 40 2702
8.l lsacord 40 2953
9.1 Isacord 40 6141
B 2 7omn B 10100 51322-04
& 1. Isacord 40 5833
b 2. lIsacord 40 5832
‘ 3. Isacord 40 5933
\ 4. [l 1sacord 40 5643
5. lsacord 40 0670
6. Isacord 40 4071
7.0 lsacord 40 0176
8.[ Isacord 40 0622
9. Isacord 40 0704
11. [l Isacord 40 0824 10. [ Isacord 40 0824

7

s

2

124 x 167 mm

4.9 x 6.6 inch

164

B oss

65 x 82 mm
2.6 x 3.2 inch

H 2.462

80 x 201 mm
3.1 x7.9inch

97 x 203 mm
3.8 x 8 inch

\

B s

B 20256
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51322-05

1., Isacord 40
2. lIsacord 40
3. [l Isacord 40
4.l 1sacord 40
5. lIsacord 40
6. Isacord 40
7.l 1sacord 40
8.  Isacord 40

5531
0250
5633
5643
0532
5832
5633
0670

51322-07

1. Isacord 40
2.l 1sacord 40
3. Isacord 40
4. 1sacord 40
5.} Isacord 40
6. [l 1sacord 40
7., lsacord 40
8. [l Isacord 40

5833
5743
5832
3363
3810
3622
3730
0622

51322-09

1.l 1sacord 40
2. Isacord 40
3. [l 1sacord 40
4. 1sacord 40
5. [l Isacord 40
6. [l 1sacord 40
7. lsacord 40
8. [l 1sacord 40
9.  Isacord 40

51322-1

1., Isacord 40
2.l 1sacord 40
3. Isacord 40
4. 1sacord 40
5. [l Isacord 40
6. Isacord 40
7. lsacord 40

5542
5832
5743
5643
2510
2723
2520
2506
2650

1

5822
6043
5933
1335
1521
1532
1060

123 x 176 mm
asneomen I 22119 51322-06

1.1 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4. |l 1sacord 40
5. Isacord 40
6. Isacord 40
7. Isacord 40
8.l sacord 40
9.] | lIsacord 40
10.  Isacord 40
13. [l Isacord 40

5833
5743
5542
5944
5933
5832
1921
2011
2152
2170
1543

95 x 202 mm
il 37x7.9inch -~ JREREE 51322-08

1.l 1sacord 40
2.l Isacord 40
3.] | Isacord 40
4. 1sacord 40
5.l 1sacord 40
6.l Isacord 40
7. lsacord 40
8. Isacord 40
9.l Isacord 40

5542
5743
5822
1911
1725
1521
1532
0731
2336

- ISP -- X 51322-10

1.l 1sacord 40
2., Isacord 40
3. [l Isacord 40
4.l 1sacord 40
5.1 lsacord 40
6.l Isacord 40
7. lsacord 40
8.l Isacord 40
9.| |lIsacord 40
10.  lsacord 40

5542
5822
5643
5743
6141
1334
1220
1321
1030
0630

98 x 202 mm
il 39 x7.9inch H 27.263 51322-12

1.1 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4.1 | Isacord 40
5. [l 1sacord 40
6.l sacord 40
7.8 Isacord 40

5833
5633
5944
5531
1911
2113
1725

1.

7

Isacord 40 0010

7

2

2

88 x 202 mm
3.5x 8 inch

104 x 177 mm
4.1 x 7 inch

68 x 203 mm
2.7 x 8 inch

101 x 184 mm
4 x 7.2 inch

165

Bl 2383

12. [ Isacord 40 0853

B 20646

B =5

B =6
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166

82022-13 1296):(71 i7n9clr:1m H 22543 82033-07 s 12;:5132;::‘ n Girler
1. lIsacord 40 1140 1.l Isacord 40 5500 =N
2. lIsacord 40 0781 2. Isacord 40 2532 -
3. lsacord40 1172 3. lsacord 40 5230
4.l 1sacord 40 5643 4. Isacord 40 2532
5. lsacord 40 5610 5.l 1sacord 40 2510
6. Isacord 40 5650 6.l 1sacord 40 5613
7.0 Isacord 40 5832 7.8 Isacord 40 2532
8. |lsacord 40 5531 o= 8. Isacord 40 5500
9. [l Isacord 40 6043 9. Isacord 40 0704
10. [l 1sacord 40 1154 11. [ Isacord 40 5730 12.] Isacord 40 5740 10. [ 1sacord 40 2810  11. [l lsacord 40 2510 12. lsacord 40 0704
13. [l 1sacord 40 0722 14. [ 1sacord 40 1375 15. [ Isacord 40 5643
16. [l Isacord 40 5633  17.  Isacord 40 2155 18.[W Isacord 40 2241
19.1 | Isacord 40 5912
19.9 Stylized Flowers
12579-02 asxasmen [ 257 12579-05 - IS - IEC

1. lsacord 40 0015
2. 'sacord 40 0020

1. [l 1sacord 40 0020
2. lIsacord 40 0015
3. sacord 40 0020

73 x 101 mm

2.9 x 4inch 12579-08

12579-06 2

1. lsacord 40 0015 W 1. 1sacord 40 0020
2. sacord 40 0020 2. lsacord 40 0015

g

142 x 144 mm

5.6 x 5.6 inch 12627-05

12579-10

B 27

1. Isacord 40 0015 . 1.
2. sacord 40 0020

Isacord 40 5230

70 x 95 mm

[P ORTN -- AT
93 x 100 mm

z 3.7 x3.9inch n 8.679
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12627-22

1. Isacord 40 2320

12633-13

1. Isacord 40 0015

12633-16

1. lIsacord 40 0015

12802-04l

1. [ 1sacord 40 0020

12802-07s

1. ] 1sacord 40 0020

2 67 x 173 mm u 9172

2.6 x 6.8 inch 12633-03

1. lIsacord 40 0015

gy 76 x 124 mm H 8728 12633-14

3x4.9inch

@ 1. lIsacord 40 0015

86 x 138 mm
3.4 x5.4inch H 10.182

;E 1. 1sacord 40 0020
‘E ‘

A2 203 x 278 mm H 16.322

l 12802-02I

8 x 10.9 inch 12802-06s

1. 1sacord 40 0020

2 107 x 178 mm H 13.642

4.2 x 7 inch 12812-01L

1. [ 1sacord 40 0020

167

99 x 117 mm
s 3.9 x 4.6 inch n 11.235
82 x 119 mm
 [REOWERN -- R
%

203 x 260 mm
5 x10.2 inch n 15.158

127 x 128 mm
s 5x5.1inch u 17.403

197 x 222 mm
s 7.7 x 8.7 inch H 31.258
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12812-02L

1. [l 1sacord 40 0020

12812-08M

1. [ 1sacord 40 0020

12852-07

1. lIsacord 40 0010

12854-01

1. Isacord 40 0015

12861-09L

Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
.| Isacord 40
.l 1sacord 40

No v e wN =

0640
1030
2640
1840
0506
1102
2721

197 x 176 mm
7.8 x 6.9 inch

u 29.132

146 x 199 mm
Ml 57 x7.8inch B e

122 x 126 mm

< 4.8 x 4.9 inch H 10EE
208 x 280 mm

il 52 x11inch B e

178 x 253 mm
< 7 x 10 inch H =21637

12812-03L

1. [l isacord 40 0020

12852-01

1. lIsacord 40 0010

12852-15

1. lIsacord 40 0010

12854-02

1. lIsacord 40 0015

12919-04

1. 1sacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40

o v A W N

5210
5220
3820
1362
1220
0934

168

197 x 205 mm
7.8 x 8.1inch

B s

193 x 150 mm

Bl oo B 17004
86 x 108 mm

<z 3.4x4.3inch n 6.566

137 x 298 mm
2 ISt -- AT

82 x 154 mm
<z 3.2 x6.1inch H 6068
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21017-1

1. lIsacord 40
2.| Isacord 40
3.1 Isacord 40
4.l 1sacord 40
5. [l Isacord 40
6.  Isacord 40

51208-1

1.1 Isacord 40
2.| Isacord 40
3.l Isacord 40
4.l 1sacord 40
5. [ Isacord 40

3

0702
0453
0442
0345
1301
0640

3

0131
0131
5210
5100
0020

51259-07

1.l 1sacord 40
2.1 Isacord 40

82004-3

1.l 1sacord 40

3743
1600

9

5722

82010-02

1.l Isacord 40
2. lsacord 40
3. lsacord 40
4. 1sacord 40
5. lIsacord 40
6. [l 1sacord 40
7. lsacord 40
8. [l Isacord 40
9. [l Isacord 40

0721
0352
0672
4620
0352
0152
0672
0152
4620

- [P -- R 21017-16
1 Isacord 40 0453
2.| lsacord 40 0442
3. Isacord 40 0702
4.1 |lsacord 40 1102
5.l 1sacord 40 1301
6. Isacord 40 0345
7.  lIsacord 40 0761
8. Isacord 40 0640
- JFEOPrrNA - IR 51208-14
1.1 |lsacord 40 0131
2.l 'sacord 40 1800
3. [ sacord 40 2123
4. ] 1sacord 40 0020
- [Pty uA -- IREEY 82004-14
1. lIsacord 40 0352
2.l isacord 40 5510
3. Isacord 40 0506
4. Isacord 40 0015
5. lsacord 40 1220
6.0 Isacord 40 4111
7. lIsacord 40 0352
8. Isacord 40 5050
9. lsacord 40 4240
10. [ Isacord 40 4111
13. [l Isacord 40 1900
16.  lsacord 40 1220
A oo K7 82004-44

122 x 176 mm
i 438 x6.9inch B 256

1.l 1sacord 40 5722

82010-03

1.l 1sacord 40
2.
3. Isacord 40
4
5. [ 1sacord 40
6.
7.8 Isacord 40
8.

Isacord 40

Isacord 40

Isacord 40

Isacord 40

0721
0672
4620
0352
0152
0672
0152
0352

7

2

s

128 x 117 mm
5x 4.6 inch

119 x 172 mm
4.7 x 6.8 inch

169

135 x 135 mm
5.3 x 5.3 inch

11. [l 1sacord 40 1730 12.
Isacord 40 0506  15.

14.

2

s

62 x 69 mm
2.4 x 2.7 inch

119 x 138 mm
4.7 x 5.4 inch

u 19.103

Isacord 40 0352
Isacord 40 0015

u 2122

u 17.842
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82010-12

1.l Isacord 40 0721
2. Isacord 40 0672
3. [l Isacord 40 4620
4. lsacord 40 0352
5. lsacord 40 0672
6.l Isacord 40 0152

82010-28

1. Isacord 40 0721
2. lsacord 40 0672
3.l Isacord 40 4620
4.  lsacord 40 0352
5. Isacord 40 0152
6. Isacord 40 0672

82010-36

1.l Isacord 40 0152
2.l Isacord 40 0721

Bd681_48

1. lsacord 40 0124
2.0 Isacord 40 1352
3.[1 Isacord 40 3652
4. lsacord 40 3040

Fq505_48

1. Isacord 40 9405
2.l Isacord 40 9916
3. [l Isacord 40 9302
4.l 1sacord 40 9805
5. [l YLl variations 8019
6. Isacord 40 9405
7.0 Yllvariations 8020
8. [l Isacord 40 9605
9.l YU variations 8009
10.  Yllvariations 8021

118 x 120 mm
4.7 x 4.7 inch

B 177

124 x 124 mm
il 4.9 x 4.9 inch B 2

80 x 112 mm

< 3.1x4.4inch H 8.223
119 x 111 mm

il 4.7 x4.4inch - JERIE

105 x 100 mm

< 4.1 x 3.9 inch

82010-19

1. lsacord 40 0672
2.l Isacord 40 0721
3. Isacord 40 0352
4. [l Isacord 40 4620
5.8 Isacord 40 0152

82010-34

1. 1sacord 40 0152
2.8 Isacord 40 4620

82035-01

1. [l isacord 40 2832

Bd691_48

1. lsacord 40 0124
2. lIsacord 40 1352
3.1 Isacord 40 3652

Fq506_48

1. 1sacord 40 9405
2., Yl variations 8020
3. [l Isacord 40 9805
4. Yllvariations 8006
5. [ YLl variations 8008
6./ YLl variations 8020

7

2

2

s

108 x 109 mm
4.3 x 4.3 inch

148 x 73 mm
5.8 x2.9inch

145 x 176 mm
5.7 x 6.9 inch

112 x 315 mm
4.4 x 12.4 inch

154 x 87 mm
6.1 x 3.4 inch

170

u 9.941

u 21.540

u 11.224
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95 x 174 mm
Fs332_48 il 335x6.3inch

H 12.081

1.l 1sacord 40 1725

121x 122
12812-06s Ml 42x48inch

H 14.413

1.l sacord 40 0020

140 x 212 mm

Pk50017-01 < 5.5 x 8.4 inch

H 25.629

1.l 1sacord 40 5326
2.l lsacord 40 5513
3.1 Isacord 40 5450
4.l 1sacord 40 2721
5. Isacord 40 2152
6.l 1sacord 40 1310
7.l Isacord 40 3210
8. Isacord 40 5912
9. Isacord 40 0600

10. [l 1sacord 40 1800  11. [l Isacord 40 3510
13.  lsacord 40 0015 14. Isacord 40 0015

119 x 132
51220-09 M 47x52inch

H 31.868

1. lsacord 40 0630
2. [l sacord 40 2521
3. Isacord 40 4152
4.l 1sacord 40 1332
5. [l 1sacord 40 0020

142 x 142 mm

Pk50012-02 i 56 x5.6inch

H 12.960

1. lsacord 40 5830
2. M Isacord 40 2810
3. [l sacord 40 2300
4.l 1sacord 40 5100
5.l Isacord 40 2732
6. Isacord 40 1030
7.  lsacord 40 2650
8. Isacord 40 4111

12. [l Isacord 40 3713

171

69 x 136 mm

Fs337_48 il 27 x 5.4 inch

n 7.998

1.l 1sacord 40 1730

197 x 268 mm

12812-08lI Ml 7.7 x 10.6 inch

u 31.963

1.l 1sacord 40 0020

139 x 208 mm

Pk50017-02 8 55x82inch

1.l 1sacord 40 5326
2.l isacord 40 5513
3., Isacord 40 5450
4. [ Isacord 40 5912
5. 1sacord 40 3541
6. [l 1sacord 40 2508
7.l 'sacord 40 2721
8.l Isacord 40 3210
9.l sacord 40 3510
10. [l lsacord 40 3713 11.
13. [ lsacord 40 1800 14

Isacord 40 0600 12 [l Isacord 40 1310
Isacord 40 0015 15. Isacord 40 0015

u 21.180

124 x 171 mm

51221-04 il 19x6.7inch
1.l 1sacord 40 5100
2.l Isacord 40 4010
3.l Isacord 40 4643
4.l Isacord 40 5210

78 x 205 mm
Pk50012-04 2 [ B o420
1. Isacord 40 5830 -_A(D g
2. Isacord 40 2810 AN

3. 1sacord 40 2732
4.l 1sacord 40 2300
5.l 1sacord 40 5100
6., | Isacord 40 1030
7.  lsacord 40 2650
8.1 |lsacord 40 4111
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19.10 Animals
12375-04 2 RSO - JEREL 12375-09 B] 158x217mm P g 055

1.0 Isacord 40 0811
2. sacord 40 0020
3.l Isacord 40 3630
4.l 1sacord 40 5722

12418-03

1. lIsacord 40 0870
2.l sacord 40 1055
3.1l Isacord 40 1123
4. Isacord 40 0842
5.l lsacord 40 1154
6.l Isacord 40 0853
7.l sacord 40 0945
8.l lsacord 40 4174
9. Isacord 40 0101
10. [ Isacord 40 6141

12454-14

1. Isacord 40 3810
2. Yenmet 7037

3. Isacord 40 3732
4. ] 1sacord 40 0020
5. lsacord 40 0015
6.l Isacord 40 3810

12576-04

1. 1sacord 40 2022
2.l lsacord 40 3444
3.l Isacord 40 1322

12672-01

1. lsacord 40 0015
2.l Isacord 40 2600
3. lsacord 40 2655
4.  lsacord 40 2250
5. [l lsacord 40 2510
6. ] lsacord 40 2702

11.

80 x 101 mm
3.2x4inch

Isacord 40 5822

7

64 x 31 mm
2.5x 1.2 inch

176 x 127 mm
6.9 x 5 inch

H 13.696

7

138 x 137 mm
5.4 x 5.4 inch

1. Isacord 40 3251
2. Isacord 40 2532
3.l Isacord 40 1906
4.l 1sacord 40 5722
5.0 Isacord 40 3630
6. Isacord 40 0811
7. Isacord 40 1304
8. Isacord 40 0105
9. sacord 40 0020

12441-37

1.l 1sacord 40 1900

12550-06

Isacord 40 0352
Isacord 40 5230
Isacord 40 1061
.| Isacord 40 1220
.l Isacord 40 1565

oA wN

L4 12662-08

1.l 1sacord 40 1032
2. Isacord 40 1032
3.l Isacord 40 1032
4.l 1sacord 40 1010
5. lsacord 40 0015
6. Isacord 40 5822
7. Isacord 40 4220
8.l Isacord 40 4531
9.[l Isacord 40 1055
10. [l 1sacord 40 0576

12712-03

1. lIsacord 40 1362
2., lIsacord 40 1220
3.l Isacord 40 1301
4.l 1sacord 40 1301
5.l 1sacord 40 4174

116 x 103 mm
il 4.6 x4inch B 2

113 x 141 mm

Ml 45 x5.6inch - JEREE
105 x 109 mm

i 4.1x43inch B 2o

126 x 188 mm
il 5 7.4inch B 20065
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12878-01

1. [l 1sacord 40
Isacord 40
Isacord 40
Isacord 40
Isacord 40

vk woN

3852
1362
1030
4250
4430

12745-01

1.l 1sacord 40
2.l 1sacord 40
3. [l 1sacord 40
4. 1sacord 40
5. Isacord 40
6. [l 1sacord 40
7.l 1sacord 40
8. | 1sacord 40
9.l sacord 40
10. [l Isacord 40

1912
1725
1904
2115
0853
0945
4174
0020
1310
0904

12760-03

1. [l 1sacord 40

0020

12791-01s

1.l 1sacord 40
2. lIsacord 40
3. Isacord 40
4. lsacord 40
5. [l Isacord 40
6. [l Isacord 40
7.l 1sacord 40
8. [l 1sacord 40
9. Isacord 40
10. [l 1sacord 40

4174
0310
3910
2363
5515
0904
1940
2504
2520
4116

12824-011

1.l 1sacord 40
2.l sacord 40
3. lsacord 40
4. [l 1sacord 40

0922
1134
172
0945

7

141 x 112 mm
5.6 x 4.4 inch

B s

109 x 122 mm
4.3 x 4.8 inch

11.  lsacord 40 0010

7

7

s

106 x 169 mm
4.2 x 6.7 inch

H 15.872

B 2297

126 x 150 mm
5x 5.9 inch

B 20066

195 x 198 mm
7.7 x 7.8 inch

12729-02

1. [ Isacord 40
2. lIsacord 40
3. [l Isacord 40

1010
0124
0132

12760-01

1. [ 1sacord 40

0020

12791-01L

1. [l 1sacord 40
2. lsacord 40
3.. Isacord 40
4. lsacord 40
5. [l 1sacord 40
6. Isacord 40
7.1l 1sacord 40
8.l sacord 40
9.  lIsacord 40
10. [l Isacord 40

4174
0310
3910
2363
5515
0904
1940
2504
2520
4116

12791-04L

1.l 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4.l 1sacord 40
5. lsacord 40
6. [l 1sacord 40

4174
4174
1900
4174
0310
4174

12824-03M

1.l 1sacord 40
2.l Isacord 40
3. lIsacord 40
4.l 1sacord 40

1134
0922
1172
0945

173

137 x 214 mm
z 5.4 x 8.4 inch n 18 238

128 x 179 mm
s 5.1 x 7 inch u ECRU

203 x 241 mm
s 8 x 9.5 inch n 34.026

203 x 207 mm
8 x 8.1inch

7

144 x 150 mm
i 57 x5.9inch - [RRELY
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12824-05s

1. [l Isacord 40 0945
2.l lsacord 40 1134
3. Isacord 40 1172
4.l 1sacord 40 0922

51202-02

1. lIsacord 40 0010
2. 1sacord 40 2762
3. Isacord 40 0182
4. 1sacord 40 2776
5.0 lsacord 40 2152
6. 1sacord 40 0020
7. Isacord 40 0310
8. Isacord 40 1755
9./ Isacord 40 5770
10..  lsacord 40 5822
13.  lIsacord 40 1430
16.] Isacord 40 2153
19. lsacord 40 2171

51202-07

1.1 Isacord 40 2152
2.1 Isacord 40 2153
3. [l Isacord 40 6043
4. 1sacord 40 5933
5.l lsacord 40 5643
6. ] 1sacord 40 5555
7. Isacord 40 0010
8. Isacord 40 0182
9.l Isacord 40 2762
10. [l 1sacord 40 2776
13. [ Isacord 40 1921
16..  Isacord 40 2152
19. [ Isacord 40 0622

51208-04

1.0 Isacord 40 1220
2.l Isacord 40 1321
3. sacord 40 0020

115 x 117 mm
4.5 x 4.6 inch

7

Bl 12463

114 x 145 mm

< 4.5 x 5.7 inch

o 9
|

.§ Jr; Ii{
\

N

e

o

11. [ Isacord 40 1911
14.  lsacord 40 1532 15.
17.] |lsacord 40 2152 18.
20.  Isacord 40 0010

120 x 153 mm

< 4.7 x 6 inch

“-":r:( f
'

12. [ Isacord 40 1921

Isacord 40 1362
Isacord 40 2155

H 27,553

11.  lsacord 40 0310 12.
14. [ 1sacord 40 1911 15.
17. [ Isacord 40 1921 18.
20.. Isacord 40 5770 21.

113 x 172 mm

< 4.5 x 6.8 inch

Isacord 40 2152
Isacord 40 1755
Isacord 40 0310
Isacord 40 5822

H 22.742

12910-03

1. [ Isacord 40 0853
2. lsacord 40 0870
3.| Isacord 40 0832
4. Isacord 40 1755
5. 1sacord 40 2211
6. | Isacord 40 2153
7.l 'sacord 40 1565

51202-04

Isacord 40 2155
Isacord 40 2152
Isacord 40 2171
Isacord 40 1755
. Isacord 40 0010
[l sacord 40 2776

oA W

51202-08

1.0 | Isacord 40 2152
2. Isacord 40 1921

51208-11

1.l 1sacord 40 1800
2.l 'sacord 40 2011
3. 'sacord 40 0020
4.1 |lsacord 40 0131

2

7

s

142 x 118 mm
5.6 x 4.6 inch

174

o REESE

83 x 152 mm
3.3 x 6 inch
Va . 'd
w
4
75 x 165 mm
2.9 x 6.5 inch
=
— —
-
—
L
{__.J T e
i, B = W

120 x 159 mm
4.7 x 6.3 inch

u 11.330

=
5]
oo

u 21.602
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106 x 178 mm 134 x 76 mm
51212-05 B e B 28067 51212-15 i Zixremm B 12900

1.1 Isacord 40 1114
2.| Isacord 40 1030
3. Isacord 40 0761
4. | lsacord 40 0442
5. Isacord 40 6133
6. ] lsacord 40 2504
7. Isacord 40 4220 7.1l 1sacord 40 2504
8. lsacord 40 5866 8.l Isacord 40 1252
9. 1sacord 40 0020 ' 9. sacord 40 0020
10.  lIsacord 40 0015 11.[lisacord 40 1030 12. [l Isacord 40 1321 10.  Isacord 40 1140

1. lsacord 40 1140
2.l Isacord 40 0945
3. | Isacord 40 0442
4. lsacord 40 1351
5. Isacord 40 4220
6.l Isacord 40 1321

89 x 140 mm 82 x 177 mm
51274-04 8 35x55inch - JEEREY 51274-05 8 32 x7inch B 25000

Isacord 40 2170
Isacord 40 1860
Isacord 40 2051
4. lsacord 40 0761
5.7 Isacord 40 1123
6.l Isacord 40 0853
7. [l lsacord 40 1134 7. lsacord 40 2051
8. [l Isacord 40 0945 ; 8.l lsacord 40 1543
9. Isacord 40 0010 9.l sacord 40 4174
10. [l 1sacord 40 5542 11. [ 1sacord 40 0020 12. [ 1sacord 40 1375  10. [ 1sacord 40 0020 11. [ Isacord 40 0853 12. [ Isacord 40 0945
13.1 Isacord 40 2051 14.[HIsacord 40 1123 15 [lisacord 40 4174  13.[lIsacord 40 4174 14. lIsacord 40 0010

16. | 1sacord 40 0020 17. [l Isacord 40 0108 18.  Isacord 40 0010

1 Isacord 40 2170
2. lIsacord 40 1860
3., Isacord 40 2051
4. lsacord 40 0010
5. lsacord 40 0761
6. Isacord 40 1123

woN =

170 x 117 mm 82 x 165 mm
51278-06 il 6.7 x 4.6 inch -~ JREREEE 51278-08 il 32 x6.5inch - JEREE

1. lsacord 40 1260
2. W Isacord 40 0731

1.8 Isacord 40 0731
2. lIsacord 40 1260

146 x 130 mm 72 x 49 mm
51289-03 @ 5.7 x5.1inch B e 80020-26 il 235 1.9inch B 7oos

1.1 Isacord 40 4740
2. lIsacord 40 0010
3.l Isacord 40 4410
4. [l Isacord 40 4610
5. [l 1sacord 40 4643
6.l Isacord 40 4410
7. Isacord 40 4610
8.1 Isacord 40 4740
9.l Isacord 40 5643
10. [l 1sacord 40 5510  11.  Isacord 40 0010 12. [ Isacord 40 0622

1.0 Isacord 40 6141
2. lIsacord 40 5822
3.[l Isacord 40 0453
4. lsacord 40 0270
5.0 Isacord 40 5833
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80126-02

1. Isacord 40 1755
2. lIsacord 40 0670
3.1 Isacord 40 0771
4. 1sacord 40 0853
5. Isacord 40 0862
6.1l 1sacord 40 0132
7.8 Isacord 40 5912
8. Isacord 40 0015
9. sacord 40 0020
10.| | Isacord 40 2152

82010-15

1.l Isacord 40 0721
2. [l Isacord 40 4620
3. Isacord 40 0352
4. lsacord 40 0672
5.8 1sacord 40 0152

Cm621_48

Isacord 40 0015
Isacord 40 2250
Isacord 40 3971
Isacord 40 0552
5.0 Isacord 40 0131
6. Isacord 40 0108
7.l 1sacord 40 0138
8.l Isacord 40 6133
9. Isacord 40 0352
10. ] 1sacord 40 0020
13. Isacord 40 5740

AW =

Fq518_48

1. Yllvariations 8006
2.l Isacord 40 9916
3. [l Isacord 40 9605
4. YU variations 8008
5. [l YL variations 8014
6. [l YU variations 8009
7.1 Isacord 40 9914

7

s

7

11.  lsacord 40 0015

75 x 144 mm
2.9 x 5.7 inch

Bl 25466

123 x 124 mm
4.9 x 4.9 inch

H 11.769

111 x 166 mm
4.4 x 6.6 inch

B 19.050

Fooa
M
7=y

W<

12. [ Isacord 40 5730

14. [ 1sacord 40 3953

s

90 x 114 mm
3.5x4.5inch

H 4.269

80126-09

1. lIsacord 40 0101
2., | Isacord 40 0105
3.l lsacord 40 3265
4.l 1sacord 40 0112
5.l Isacord 40 4174
6. Isacord 40 6011
7. lIsacord 40 1755
8. sacord 40 0020
9.  Isacord 40 3971
10.  Isacord 40 0101

Cm421_48

Isacord 40 2155
Isacord 40 0015
Isacord 40 2155
Isacord 40 3045
.| Isacord 40 2640
[ Isacord 40 3130
Isacord 40 2520

N o s W =

Fm987

1. YU variations 8010
2. lsacord 40 3040
3. Isacord 40 0504

Fq520_48

1. YU variations 8010
2./ Yllvariations 8004
3. Yllvariations 8023
4.l 1sacord 40 9805
5. Isacord 40 9405
6.  Yllvariations 8023
7. Yllvariations 8006
8.l YU variations 8019
9.0 lsacord 40 9912
10. [l 1sacord 40 9918
13.[M Isacord 40 9916

16. ] YU variations 8009 17.

19. [ Isacord 40 9916

25. [l 1sacord 40 9605
28. [l YU variations 8014

YLl variations 8020 12.
14. [l 1sacord 40 9605
Isacord 40 9914
20. [l 1sacord 40 9302
22 [ YU variations 801923. [ Isacord 40 9405  24.
26. ] YU variations 8009 27.

176

92 x 115 mm

B oasinn B 225%
54 x 71 mm

2 IEVWPPS i - - JEME
88 x 77 mm

s 3.5 x 3 inch u 3.297

257 x 212 mm

<z 10.1 x 8.4 inch

H 15.274

15. [ YLI variations 8008
18. [} Isacord 40 9405
21. [ 1sacord 40 9805

YLl variations 8006

YLI variations 8020
YLl variations 8021



Appendix

19 Embroidery Designs

Wo379
1. Isacord 40 3951
2.l sacord 40 5643
3. [l Isacord 40 5912
4. lsacord 40 0520
5. [l 1sacord 40 5866
6.l Isacord 40 5500
7.l Isacord 40 5422
8.  Isacord 40 0640
9. lIsacord 40 0310
10.  Isacord 40 0800
13.  lIsacord 40 0015
16. ] Isacord 40 2224
Wp380_48
1. [ 1sacord 40 0020
Wp389_48
1.0 lsacord 40 5822
2. lsacord 40 0651
3. Isacord 40 0015
4. lsacord 40 0842
5. Isacord 40 1755
6. Isacord 40 0853
7. 1sacord 40 1055
8.l 1sacord 40 1233
9. |lsacord 40 1123
10. [l Isacord 40 0945
13.1 Isacord 40 1430
16.. Isacord 40 3971
19. [ Isacord 40 0108
22. [l Isacord 40 0020
51268-05
1. lsacord 40 2170
2. lsacord 40 2171
3. Isacord 40 0015
4.  lsacord 40 1755
5. Isacord 40 2051
6.l Isacord 40 1543
7. lsacord 40 6051
8. Isacord 40 5833
9. [l Isacord 40 0465
10.. Isacord 40 2550
13. [l Isacord 40 2222
16. [ Isacord 40 1010
19. [l Isacord 40 0853

72 x 94 mm
2.8 x 3.7 inch

7

Bl 1439

11. [ 1sacord 40 0853 12. [l Isacord 40 4101
14. lsacord 40 0520 15.| Isacord 40 1430
17. ] sacord 40 3522
80 x 116 mm
il 324.56inch - JEEEE
154 x 327 mm
- R - - EEED

11.[ l1sacord 40 0150 12. [l Isacord 40 0111
14. | 1sacord 40 0020  15.[ ] Isacord 40 0131
17. [ 1sacord 40 2674  18. [l Isacord 40 0111
20. [l 1sacord 40 0132 21. [l Isacord 40 4174
23, lsacord 40 0015 24.[H Isacord 40 5833

- I - I

11. [l Isacord 40
14, lIsacord 40
17. [l Isacord 40
20. [l 1sacord 40

2532
1060
0931
4174

12.  lsacord 40
15.  lsacord 40

2170
1760

Wp358_48

1. [l isacord 40 1375

Wp383_48

1. lIsacord 40 0352
2. 1sacord 40 5833
3. Isacord 40 0015
4.l 1sacord 40 1874
5.0 lsacord 40 0150
6.l lsacord 40 4174
7. 'sacord 40 0020
8. lIsacord 40 0015
9.l lsacord 40 4174

51255-03

1. lIsacord 40 0660
2. lIsacord 40 0506
3.l 1sacord 40 4174
4. Isacord 40 0660

18.
21.

Isacord 40 0015
Yenmet 7011

7

2

2

52 x 91 mm
2.1 x 3.6 inch

71 x 82 mm
2.8 x 3.2 inch

80 x 75 mm
3.2x2.9inch

177
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19.11 Children

140 x 122 mm 81 x 100 mm
12435-22 il 554.38inch B e 12440-01 M 32 x3.9inch B s

Isacord 40 1755
Isacord 40 2250
Yenmet 7028
4. lsacord 40 2640
5.1 Yenmet 7023
6.l lsacord 40 2912
7.0 Yenmet 7025
8.l lsacord 40 4174
9. Yenmet 7028

1.l 1sacord 40 1543
2.8 Isacord 40 2761
3.l sacord 40 1876
4. [l 1sacord 40 1521

woN =

50 x 109 mm 173 x 26 mm
12440-05 i 2 43inch B oo 12440-07 il 6.8 x1inch B 5o

1.l 1sacord 40 1543
2.l Isacord 40 1521
3. Isacord 40 0870
4. Isacord 40 2761
5.l lsacord 40 1876

1. Isacord 40 2761
2.l Isacord 40 1521
3.] |lsacord 40 0546

4 o
4.l 1sacord 40 1543 ”!'W *‘F‘M '\I!.
5. Isacord 40 6133 ' : ' :

97 x 149 mm 119 x 172 mm
12440-08 il 338 x5.9inch u 13511 12440-09 il 47 x6.8inch n U{tE

1.1 |lsacord 40 0546
2.8 Isacord 40 2761
3.l Isacord 40 1521
4. [l 1sacord 40 1543
5.l 1sacord 40 1876
6. 1sacord 40 6133

1. [ Isacord 40 2761
2.l Isacord 40 1521
3.l Isacord 40 1543
4.[  Isacord 40 0546
5.8 Isacord 40 6133
6.l 1sacord 40 1876

3 12590-04 g o Bues  iessor - A - R
1.1 Isacord 40 5740 1. lIsacord 40 0015
2.| Isacord 40 5740 2. lIsacord 40 0015
3. | Isacord 40 5740 3. lIsacord 40 0015
4. | lsacord 40 5740 4. lIsacord 40 0015
5.0 Isacord 40 5740 5. lsacord 40 0015
6./ Isacord 40 5740 6. Isacord 40 1140
7. lsacord 40 5740 7.1 'sacord 40 4174
8. | Isacord 40 5740 8. | Isacord 40 2152

©

Isacord 40 5740 9. Isacord 40 5115

10.  Isacord 40 0015 11.JJisacord 40 0020 12. Isacord 40 4230  10.[Jisacord 40 5513 11.] |lsacord 40 2051 12.[MIsacord 40 1010
13. [l lsacord 40 4116 14. [l Isacord 40 5510  15. [ Isacord 40 0132

16. [l 1sacord 40 0112 17. [ lsacord 40 0132 18.  Isacord 40 0015



1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

1.
2.
3.
4.
5.

W=

4.
5.
6.
7.
8.
9.
10.
13.
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51201-01

[ Isacord 40
[ 1sacord 40
¥ 1sacord 40
Isacord 40
Isacord 40
Il 'sacord 40
[l 'sacord 40
Isacord 40
Isacord 40
[l 1sacord 40

3150
3810
4752
2152
2650
0020
2954
0015
2152
3150

51201-08

Isacord 40
Isacord 40
Isacord 40
[ 1sacord 40
Isacord 40
Isacord 40
Isacord 40
Il 'sacord 40
Isacord 40
Isacord 40

3045
1060
2650
2241
2152
2530
0131
0020
0145
0142

51201-13

M 1sacord 40
¥ 1sacord 40
[l 'sacord 40

Isacord 40
Il 'sacord 40

4332
4752
2954
0015
0020

51203-04

Isacord 40
Isacord 40
Isacord 40
Isacord 40
B 1sacord 40
M 1sacord 40
[l 'sacord 40
B 'sacord 40
Isacord 40
[ 1sacord 40
Isacord 40

0010
0310
2155
2220
4116
2920
4174
5643
0520
5832
2155

7 AR -- IEEID 51201-02

1. 1sacord 40
2. lsacord 40
3. Isacord 40
4. | 1sacord 40
5. Isacord 40
6. Isacord 40
7. lsacord 40
8. Isacord 40
9. Isacord 40
10. [l Isacord 40

4752
0015
3810
0020
0015
4752
2650
3641
3830
2711

120 x 145 mm
il 47 x57inch B 228 51201-11

1. 1sacord 40
2. Isacord 40
3.1 | Isacord 40
4. lsacord 40
5. [ 1sacord 40
6. sacord 40
7.8 Isacord 40
8. lIsacord 40
9. lIsacord 40

11. ] 1sacord 40 0020

2920
4752
2152
1060
0020
2954
2920
2650
0015

78 x 127 mm
il 3.1 x5inch -~ JRREEE 51201-14

1. lIsacord 40
2. Isacord 40
3.1 | Isacord 40
4. 1sacord 40
5. lsacord 40
6. sacord 40

1060
2920
2152
2241
0015
0020

119 x 120 mm
8 47 x4.7inch H 22.989 51203-06

1. lsacord 40
2. lIsacord 40
3. lIsacord 40
4. |l 1sacord 40
5.1 Isacord 40
6.l sacord 40
7.8 Isacord 40
8.  Isacord 40
9. lIsacord 40
11.] 1sacord 40 2220 12.[M1sacord 40 2920  10.[ Isacord 40
14.  lIsacord 40 0010

0310
2155
0010
5643
5832
4116
2920
2155
0310
2152

1.

1.

7

Isacord 40 2152

s

179

111 x 107 mm
4.4 x 4.2 inch n 12.343

‘ =@
‘.\.’5

MAKE® y /7

120 x 114 mm
47 x 4.5 inch H 20.909

67 x 101 mm

8l 26 x4inch B oo
120 x 140 mm

i 4.7 x5.5 inch ﬂ 17.006

N A

12. [l sacord 40 4174

Isacord 40 0010
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L4 51211-04

1.l 1sacord 40
2. |l 1sacord 40
3. [l 1sacord 40
4.l 1sacord 40
5. [l Isacord 40
6.l 1sacord 40
7.l 1sacord 40
8. [l 1sacord 40
9. |l sacord 40
10. [l 1sacord 40
13.1 Isacord 40
16. lIsacord 40
19.]1 | Isacord 40
22.  lsacord 40

L4 512111

1. 1sacord 40
2. [l 1sacord 40
3. ] 1sacord 40
4. 1sacord 40
5. [ Isacord 40
6. [ 1sacord 40
7. [ 1sacord 40
8. [l 1sacord 40
9. |l sacord 40
10.[ | Isacord 40
13. [l 1sacord 40
16.  Isacord 40
19.1 | Isacord 40
22. [ 1sacord 40
25.] Isacord 40
28.  Isacord 40
31.] Isacord 40

0138
0138
0138
0138
0138
0138
0138
0138
0138
4174
0700
0184
6141
1760

5

2123
2123
2123
2123
2123
2123
2123
2123
2123
5832
4174
1760
5833
3732
5832
0184
0874

51237-06

1.l 1sacord 40
2.8 1sacord 40
3.1 Isacord 40
4. 1sacord 40
5. [l Isacord 40
6. [l 1sacord 40
7.l 1sacord 40

1703
1010
1030
4620
0945
1565
0576

51240-28

1.l 1sacord 40
2., Isacord 40
3. lsacord 40
4. Isacord 40
5. Isacord 40
6. Isacord 40
7., | lsacord 40
8. [l 1sacord 40
9. [l 1sacord 40
10. [l 1sacord 40
13. | sacord 40

1332
0811
3963
3910
3810
0010
0131
1913
1521
2123
0020

106 x 172 mm
4.2 x 6.8 inch

7

11. [ 1sacord 40 0020  12. [l Isacord 40
14. [l 1sacord 40 1904  15. [l Isacord 40
17.[ lisacord 40 1141 18. [} Isacord 40
20. [ 1sacord 40 5833  21. [ Isacord 40
23.[ Isacord 40 0874

3 e B

B 53

1972
2123
1252
5944

240

1. lsacord 40 0352 12. [ 1sacord 40 4074
14. [l 1sacord 40 0020  15.[ Isacord 40 0700
17. [l 1sacord 40 3815 18.[1] Isacord 40 6141
20. [l 1sacord 40 4122 21.  Isacord 40 0015
23. [l 1sacord 40 4101 24. [ 1sacord 40 1904
26. Isacord 40 0640 27.[J1sacord 40 2115
29. [l Isacord 40 5944  30.  lsacord 40 1760
32.| |lsacord 40 0142

- JE SR - ECE

s ;Gxx5.113?n::1m B cos

11. [l 1sacord 40

1322

12. [l 1sacord 40

0020

L4 51211-14
1., lsacord 40 1141
2. | lsacord 40 1141
3. Isacord 40 1141
4. Isacord 40 1141
5.0 lIsacord 40 1141
6. | Isacord 40 1141
7. | lsacord 40 1141
8. Isacord 40 1141
9. Isacord 40 1141
10. [l sacord 40 2123
13. [l 1sacord 40 3732
16. [ Isacord 40 0020
19. [l Isacord 40 0722
22.| Isacord 40 0874
25.] Isacord 40 5832
045121116
1. 1sacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020
4. lsacord 40 0015
5.1l Isacord 40 2123
51240-27
1. lsacord 40 0630
2. lsacord 40 0630
3. lIsacord 40 0630
4.l 1sacord 40 1332
5.0 lsacord 40 0811
6.l lsacord 40 1322
7.l 1sacord 40 0020
51240-31
1. lsacord 40 0010
2. lIsacord 40 0010
3. lIsacord 40 0010
4. lIsacord 40 0811
5. [l Isacord 40 0020

82 x 169 mm
3.2x 6.7 inch

7

180

B 20

11. [ Isacord 40 3810  12.[1 Isacord 40 3630
14. [l 1sacord 40 4074 15. [l Isacord 40 1972
17.. lsacord 40 0184 18.[J]1sacord 40 2123
20. [ 'sacord 40 0020 21.  Isacord 40 1760
23.  Isacord40 0015 24. lIsacord 40 0232
111 x 144 mm
7 [V -- JEEEY
87 x 80 mm
- [EPOUNE -- JEEC

87 x 83 mm
3.4 x3.3inch

s

J

u 3327
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76 x 142 mm 89 x 83 mm
51240-32 <z 3 x 5.6 inch H B 51240-35 z 3.5x 3.3 inch u 262
1. lIsacord 40 0010 1.. Isacord 40 0020 F=
2. lsacord 40 0811

3.1 Isacord 40 5450
4. [ Isacord 40 4752
5.8 1sacord 40 1725
6. Isacord 40 0010
7.l sacord 40 3743
8.l Isacord 40 1725
9. sacord 40 0020
10. [ 1sacord 40 0020

3.1 Isacord 40 3641
4. Isacord 40 3963
5.l 1sacord 40 3743
6. [l 1sacord 40 0020

2. Isacord 40 3641 ‘fq"‘ﬂr‘fx' : Gt

92 x 141 mm 99 x 144 mm
51240-36 8 36 x55inch - JIEED 51267-07 i 30x5.7inch - JREEES

1.1 Isacord 40 3641 1. lIsacord 40 4250

e o 87 o
2. Isacord 40 3963 2.8 Isacord 40 4610 o "%‘;’
3.l Isacord 40 3743 3. lsacord 40 1060 ./flé;f‘,/ )
4. [l 1sacord 40 0020 4.[ Isacord 40 1030 ' “"
5. [l 1sacord 40 0020 5.l Isacord 40 1310 "3\{

6. lsacord 40 2155 vy
7. Isacord 40 1753
8.l lsacord 40 4133

. 108 x 51 mm . 92 x 99 mm
Cj500 @ 42 x2inch H el Cj959 i 36x3.9inch n et/

Isacord 40 0015
Isacord 40 1860
Isacord 40 0182
. Isacord 40 0651
5. Isacord 40 0853
6. ] 1sacord 40 1366
7. [l 1sacord 40 4174 7. Isacord 40 1600
8. Isacord 40 1060 8. Isacord 40 0310
9. Isacord 40 0640 9. Isacord 40 2560
10. [l Isacord 40 1346 10. [ Isacord 40 2241 11.  lIsacord 40 0015 12.[Jl lsacord 40 3815
13.  lsacord 40 5650 14. Isacord 40 5610

Isacord 40 4230
Isacord 40 3840
Isacord 40 3650
Isacord 40 1430
Isacord 40 0520
.. Isacord 40 1351

Awon o=
GRS

. 98 x 90 mm 90 x 99 mm
Cj965 i 30x36inch - JEERES Ck174 i 353.9inch -~ JEEEES

1. lsacord 40 0015
2.l sacord 40 3815
3. lsacord 40 4230
4. Isacord 40 5650
5. Isacord 40 5115
6. Isacord 40 5220
7. lsacord 40 0704 7. Isacord 40 3762
8. Isacord 40 1430 8. Isacord 40 4230
9.l Isacord 40 5210 9.l lsacord 40 4452
10.| Isacord 40 3045 11. lsacord 40 0630 12.[Jl Isacord 40 1301

13. [ Isacord 40 2830

1.0 Isacord 40 2051
2. lsacord 40 0630
3.[ Isacord 40 5833
4. [ Isacord 40 0622
5. Isacord 40 1010
6. Isacord 40 0250
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Ck254
1. [ Isacord 40 5833
2. lIsacord 40 0640
3.1 Isacord 40 3150
4. | lsacord 40 3241
5. Isacord 40 5770
6. Isacord 40 0520
7. lIsacord 40 4071
8. [l Isacord 40 2920
9.l Isacord 40 1730
10. [l 1sacord 40 0111
13. [l Isacord 40 4174
16. [l Isacord 40 5510
Ck518
1.l 1sacord 40 0132
2. lsacord 40 0310
3. Isacord 40 0015
4.l 1sacord 40 3901
5. ] Yenmet 7000
6. Isacord 40 4073
7. Isacord 40 0310
8. Yenmet 7013
9.l Isacord 40 1703
10. | 1sacord 40 0020
13.  lsacord 40 0310
Ck978
1. lIsacord 40 2560
2.0 Isacord 40 2220
3. Isacord 40 0015
4.  Isacord 40 4071
5. Isacord 40 3641
Cm200_48
1.0 Isacord 40 1840
2.0 Isacord 40 2220
3. Isacord 40 1351
4. | lsacord 40 1430
5. [l sacord 40 1730
6.l lsacord 40 4174
7.1 Isacord 40 0552
8. Isacord 40 0232
9.. Isacord 40 1840
10. [l Isacord 40 1730

1.
14.

1.l sacord 40 1902

11.

91 x 99 mm
3.6 x 3.9 inch

7

B 15220

Isacord 40 0670

Isacord 40 5531

12.
15.

76 x 67 mm
3 x2.6inch

7

Isacord 40 5650

Isacord 40

5610

H 14.433

12. [ sacord 40 3323

49 x 42 mm
1.9 x 1.7 inch

7

B 60

94 x 109 mm
3.7 x4.3 inch

7

Isacord 40 2171

12.

Isacord 40

2250

Ck255
1. Isacord 40 5833
2. lIsacord 40 5770
3. | Isacord 40 5740
4. [ Isacord 40 5833
5. lIsacord 40 1755
6. |lsacord 40 2530
7. lsacord 40 2155
8. lIsacord 40 0520
9. Isacord 40 2220
10.  Isacord 40 2171
13. [ Isacord 40 3151
16. [l Isacord 40 2920
Ck524
1. 1sacord 40 0108
2. lsacord 40 3910
3. |lsacord 40 0142
4. 1sacord 40 4174
5. lsacord 40 5610
6.l lsacord 40 1703
7.1 'sacord 40 1903
8.l lsacord 40 5944
Ck991
1. [l isacord 40 1904
2. lIsacord 40 0015
3. Isacord 40 4071
4. Isacord 40 0108
Cm222_48
1. lsacord 40 0101
2.| lsacord 40 0934
3. lIsacord 40 0015
4. ] 1sacord 40 0020
5. Isacord 40 0853
6.l Isacord 40 0945
7. lsacord 40 0870
8. lsacord 40 0672
9., Isacord 40 0811

7

92 x 99 mm
3.6 x 3.9 inch

11. [ Isacord 40 2761 12.

14.

Isacord 40 4071

2

76 x 72 mm
3x2.8inch

182

B 533

Isacord 40 3150

15. [l 1sacord 40 3710

u 11.188

7

2

65 x 86 mm
2.6 x 3.4 inch

N
"

41 x 61 mm
1.6 x 2.4 inch

B 2726

u 5.951
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183

Cm420_48 - A - R 12426-01 - AP - IO

1. lIsacord 40 0970 1. [l Isacord 40 1972
2. lsacord 40 0124 2. Isacord 40 0015
3. Isacord 40 0670 3.l Isacord 40 3901
4. Isacord 40 0015 4.l 1sacord 40 3920
5. lsacord 40 0970 5.l Isacord 40 2521
6.] |Isacord 40 6141 6. [l 1sacord 40 1904
7. lsacord 40 2155 7. Isacord 40 2910
8. Isacord 40 2171 Bl A@»-.:—'g’f 8. Isacord 40 0230
9. lsacord 40 2152 9. lsacord 40 0520
10.  lsacord 40 1172 11.[J]1sacord 40 0020 12. [ Isacord 40 0853 10.  lsacord 40 0506 11. lsacord 40 0800 12. [l lsacord 40 1730
13.[ | lsacord 40 5822 14.[]Isacord 40 5833 15. Isacord 40 0015
16.. Isacord 40 3045 17.[l Isacord 40 2764
19.12 Baby
2 12662-03 B s B sos (21266205 - IEFSrT -- IR
1.0 lsacord 40 1133 1. lsacord 40 0672
2.| |lsacord 40 1133 2. lIsacord 40 0672
3.0 Isacord 40 1133 3. lsacord 40 0672
4. lIsacord 40 0015 4. lsacord 40 6051
5.1 Isacord 40 3150 5.0 Isacord 40 2532
6. Isacord 40 4620 6., Isacord 40 0741
7. 1sacord 40 2764 7.1l 1sacord 40 0576
8.l Isacord 40 2600
9.l Isacord 40 1543
10. [l Isacord 40 1565
(2 12662-09 aaxsomn 1430 [(J12662-10 - A - Rt
1. Isacord 40 2532 1.l 1sacord 40 5722
2.l Isacord 40 2532 2.l 'sacord 40 5722
3.l Isacord 40 2532 3.l lsacord 40 5722
4. lIsacord 40 0015 4. lsacord 40 0015
5.1 lsacord 40 5531 5.1 Isacord 40 3030
6. lIsacord 40 0221 6. 1sacord 40 4421
7.l 1sacord 40 2510 7. lsacord 40 5050

8.l lsacord 40 5944

9. Isacord 40 5933

10. [l Isacord 40 2864
(2 12663-21 A e B (31266322 - AP -
1. lIsacord 40 1140 L _ 1. lIsacord 40 0781 iF
2. Isacord 40 1140 // 2. lIsacord 40 0781 .
3. lsacord 40 1140 '| 3. lsacord 40 0934 1| dE
4. lsacord 40 1140 { '\\-_-\ }-__.' ® 4.l 1sacord 40 1521 =
5.l 1sacord 40 3631 % - 5. lsacord 40 1140 T
6. lIsacord 40 1140 i 6. lsacord 40 0781 @ \'§
7. sacord 40 0020 - \ 7. 'sacord 40 0020 3

<



_
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51272:07 3 e Boso G - Ve - R

1.1 Isacord 40 2153 1. lIsacord 40 0015
2. lIsacord 40 4250 2., lIsacord 40 2152
3.1 Isacord 40 3750 3. Isacord 40 0640
4. Isacord 40 3971 4.1 |lsacord 40 0552
5. Isacord 40 0970 5. lsacord 40 0124
6. Isacord 40 0184 6. Isacord 40 0520
7. Isacord 40 1760 7. lIsacord 40 1220
8.l lsacord 40 4174 8. lIsacord 40 3962
9.1 Isacord 40 2153 9. Isacord 40 1362

10.  lsacord 40 0015 11. lsacord 40 0660 12.[MIsacord 40 0853

13.] Isacord 40 3910

Gj529 l ;6)()(2.793i:1cr||11 B o Gj530 l g.zz);ssz.zn;rr:lh -~ JRERES

1. lIsacord 40 0660 1. lIsacord 40 0870
2. Isacord 40 3840 2. lIsacord 40 2170
3. Isacord 40 2155 3. lIsacord 40 0015
4. Isacord 40 3840 4.1 |lsacord 40 3640
5. lsacord 40 3650 5.0 lsacord 40 3820
6. Isacord 40 0970 6., Isacord 40 1123
7. lsacord 40 0851 7. Isacord 40 1055
8.] Isacord 40 3910 : 8. Isacord 40 0270
9.l 1sacord 40 1055 9. Isacord 40 5912

10.  lsacord 40 2650 11.[Jlsacord 40 5513 12.  lsacord 40 2560

Cj84a3 l ;7xx2.678inmcrrr: -~ [REEY Ck225 s g?9§721.8n;rr:lch -~ [REREE
1. Isacord 40 0250 1. lIsacord 40 2363
2. lsacord 40 0221 2. lIsacord 40 0250
3. Isacord 40 2363 3. Isacord 40 0713
4. lsacord 40 2560 4. lIsacord 40 1060
5.  lsacord 40 4071 5. lsacord 40 1362
6.] Isacord 40 3640 6. Isacord 40 4071
7. lsacord 40 0221 7. lsacord 40 2655
8. Isacord 40 3040
9. Isacord 40 1755

10. Isacord40 0015 11. lIsacord 40 3650 12. Isacord 40 3840

Ck229 - [N -- ERR Ck532 - [N -- [RLRE:

Isacord 40 0015
Isacord 40 3650
Isacord 40 3840
Isacord 40 2655
Isacord 40 3040
Isacord 40 2363
Isacord 40 1755
Isacord 40 2153
Isacord 40 1060
Isacord 40 1362 11. Isacord 40 0250 12. Isacord 40 0713
Isacord 40 3045

1. lIsacord 40 3962

1

&_._\\é;{

w o v o NV WN =
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Ck533

1. lIsacord 40 2155

Ck747

1. lsacord 40
2. lIsacord 40
3. Isacord 40
4. 1sacord 40
5.1 Isacord 40
6. [l Isacord 40

5770
2155
0221
1161
0622
0853

Ck753

1.1 1sacord 40
2. lIsacord 40
3. Isacord 40
4. 1sacord 40
5. Isacord 40
6./ Isacord 40
7.1 lIsacord 40
8. [ Isacord 40
9./ Isacord 40

2761
0352
0221
3151
5740
3951
0811
1600
5531

Ck811

1.l 1sacord 40
2.. lIsacord 40
3.l Isacord 40
4.l 1sacord 40
5. lIsacord 40
6. [ Isacord 40
7.l sacord 40
8. Isacord 40
9. lIsacord 40
10.  lIsacord 40
13. [ Isacord 40

3743
3951
3853
3953
0851
1161
0945
1123
0761
0506
0131

93 x 98 mm
8 36x3.9inch B o

74 x 96 mm
il 29 x3.8inch B 7os

89 x 89 mm
i 35x35inch B s

73 x 94 mm
i 29x3.7inch B 250

11.  lsacord 40 0015

12. [l 1sacord 40 4174

Ck742
1. lIsacord 40
2. lsacord 40
3. Isacord 40

4. Isacord 40
5.1 Isacord 40

6. lIsacord 40
7. Isacord 40
8.  Isacord 40
9. Isacord 40
Ck748
1./ Isacord 40
2. lsacord 40
3. Isacord 40
4., lIsacord 40
5.0 lsacord 40
6., | lIsacord 40
7. lsacord 40
8.[ " Isacord 40
9. lIsacord 40

10.  lsacord 40

Ck797
1.1 Isacord 40
2. Isacord 40
3. lIsacord 40
4.l 1sacord 40
5. lsacord 40
6. Isacord 40
7. lIsacord 40

8.l Isacord 40
9. Isacord 40
10.  Isacord 40

Ck909
1 Isacord 40
2. lIsacord 40
3. lIsacord 40
4. lsacord 40
5.1 Isacord 40
6. Isacord 40
7.1 Isacord 40
8. Isacord 40

9.l Isacord 40
10.  lsacord 40
13.1  lsacord 40
16.]  lsacord 40

4430
4240
6011
3150
3151
2560
2764
0221
0811

5531
6011
5610
6011
0811
1430
0015
3652
5610
0221

1141
1123
0651
0853
0870
2250
2152
0945
2241
0015

3045
0015
0630
1532
1600
2363
2530
0532
1521
3650
2640
2152

185

88 x 89 mm
3.5x3.5inch

7

B s

89 x 96 mm

i 35x33inch

B sss

11. [ Isacord 40 0542

94 x 85 mm

<z 3.7 x3.4inch

H 20281

11. [l 1sacord 40 1911 12. [l Isacord 40 0111

80 x 92 mm
M 32x36inch B o

11.0 lIsacord 40 3641 12. lIsacord 40 2363
14. [l sacord 40 1521 15. [l Isacord 40 2810
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Cm021_48

1. Isacord 40 0640
2. lIsacord 40 1755
3.l Isacord 40 2920
4. Isacord 40 3040
5. Isacord 40 5730
6./ Isacord 40 1840
7.l Isacord 40 1730
8. Isacord 40 0630
9. Isacord 40 0232

Cm032_48

1. lsacord 40 0640
2.l Isacord 40 5730
3.l Isacord 40 2920
4. Isacord 40 1840
5.l lsacord 40 1730
6. Isacord 40 1352
7. lsacord 40 3040
8. [l Isacord 40 4220

12401-07

1. Isacord 40 5934
2. lsacord 40 0352
3. lsacord 40 4240
4. 1sacord 40 1342
5. Isacord 40 0731
6.l Isacord 40 0111

12903-12

1.. lsacord 40 4740
2.l Isacord 40 5115
3. Isacord 40 0660

12903-20

1., lsacord 40 4740
2. lIsacord 40 1860
3.l Isacord 40 5115

88 x 98 mm
3.5x 3.8 inch

7

96 x 81 mm

<z 3.8x3.2inch

97 x 110 mm

< 3.8 x4.3 inch

Cm028_48

1. lIsacord 40 0640
2. Isacord 40 5730
3. Isacord 40 4220
4.1 |lsacord 40 3820
5.8 Isacord 40 2920
6.l Isacord 40 1730
7. lIsacord 40 1840
8. Isacord 40 3040
9. Isacord 40 1755

10.|  Isacord 40 0934

Cm223_48

1. lIsacord 40 0713
2. lIsacord 40 6141
3.[ Isacord 40 5833
4. lsacord 40 0811
5. lsacord 40 0101
6. lsacord 40 0020

12432-20

1.l 1sacord 40 1902
2.| lsacord 40 0105
3.| Isacord 40 0131
4.l 1sacord 40 0132
5. 1sacord 40 4174
6.l lsacord 40 1902

32 x35mm
il 12 1.4inch B e

12903-13

Isacord 40 1860

2. lIsacord 40 0660
3., Isacord 40 1840
27 x 25 mm

G 1.1 1inch H 1.024 Cm164_48
ée,. 1., lsacord 40 3640
‘Eﬁ"\* - 2. Isacord 40 0704
.1“‘1 3. Isacord 40 3251
4.1 |lsacord 40 6141
5. lsacord 40 1755

6.

Isacord 40 0232

186
95 x 96 mm
z 3.7 x 3.8 inch n 9.639
50 x 28 mm
| e, B 2154

126 x 114 mm
s 5x 4.5 inch u 6.317

32 x 36 mm
il 13 1.4inch -~ JREE

89 x 97 mm
i 35x3.3inch -~ e
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19.13 Food and Drink
01261117 - Pt -- EE2 12611-29 - PR - REE
1.l 1sacord 40 1154 1. 1sacord 40 4220
2.l lsacord 40 1154 2.l isacord 40 1154
3. [l 1sacord 40 1154 3. [l 1sacord 40 1902
4.| lIsacord 40 5440
5. | Isacord 40 0151
6.l Isacord 40 0152
(2 1262918 - IR - L 12655-13 3 e B 0o
1. [l Isacord 40 4220 1. [l Isacord 40 1055
2.l Isacord 40 4220
3.l Isacord 40 4220
4. 1sacord 40 4220
5. Isacord 40 4220
6.l Isacord 40 4421
7. lsacord 40 0015
8. Isacord 40 4240
12773-04 - IRy -- A 12773-12 - RPN - B
1. Isacord 40 5500 1., lsacord 40 0842
2. lsacord 40 5830 2. lIsacord 40 3840
3.1 Isacord 40 2241 3. lsacord 40 5610
4. lsacord 40 2160 4. lsacord 40 0101
5. Isacord 40 0230 5.  lsacord 40 2155
6. Isacord 40 0520 6. sacord 40 0020
7.1 |lsacord 40 2830
8. Isacord 40 0015
9.l 1sacord 40 0020
12774-13 - ISR - JEE 12774-15 B (ororimen B 12440
1. [ 1sacord 40 0020 1.0 lIsacord 40 1133
2.l sacord 40 1134
3. Isacord 40 0101
4. lsacord 40 0270
5. lsacord 40 0250
6. Isacord 40 0145
7. lsacord 40 0015
8.[l Isacord 40 3953
12843.08 QA s 1288310 - AN - R
1. lsacord 40 0311 1. lsacord 40 0311
2. Isacord 40 0520 2. lIsacord 40 0310
3. Isacord 40 0310 3. lIsacord 40 0520
4. lsacord 40 0010 4. lIsacord 40 5740
5.l Isacord 40 5510 5. lIsacord 40 5610
6. Isacord 40 0520 6.l 1sacord 40 5510
7. lsacord 40 5610 7. lsacord 40 0010
8. | Isacord 40 5740 8. lIsacord 40 0310
9. lIsacord 40 0310
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L4 12932-07

1. [l Isacord 40 1010
2.l Isacord 40 1010
3. Isacord 40 0101
4. 1sacord 40 1921
5. Isacord 40 1921
6. Isacord 40 0101

51213-13

1., lsacord 40 0741
2. 1sacord 40 4620
3.l 1sacord 40 3645
4.0 1sacord 40 2241

Gj291

1.1 Isacord 40 0832
2.l sacord 40 0933
3.0 Isacord 40 2550
4. Isacord 40 5230

12462-28

1. lsacord 40 6031
2. 1sacord 40 5833

51255-04

1 Isacord 40 0702
2 Isacord 40 0800
3. Isacord 40 0506
4. Isacord 40 0605
5. Isacord 40 0520
6.l 1sacord 40 0020

127 x 178 mm
5x 7 inch H 13k

37 x 241 mm
il 1.5 9.5inch B 2o

B
T

14 x 32 mm
0.6 x 1.2 inch

o

s

H 1.571

64 x 76 mm
< 2.5 x 3 inch H 2402

108 x 172 mm

< 4.3 x 6.8 inch

H 17.184

51202-14

1. [ Isacord 40 0622
2., lIsacord 40 2153
3. lIsacord 40 0310
4. 1sacord 40 5555
5. 1sacord 40 5513
6.1l 1sacord 40 6043
7.0 lsacord 40 2153

51287-06

1. 1sacord 40 3644
2. Isacord 40 3910
3.l sacord 40 3114
4. [l 1sacord 40 2732
5. Isacord 40 0345
6. Isacord 40 0501

12462-01

1. lsacord 40 5050
2. Isacord 40 0310
3.l Isacord 40 1521
4. Isacord 40 5730
5. 1sacord 40 0111
6. Isacord 40 1430
7.8 Isacord 40 5833
8. lIsacord 40 0015

04 12776-01

1 Isacord 40 6051
2 Isacord 40 6051
3 Isacord 40 6051
4 Isacord 40 1430
5.0 lsacord 40 1430
6. Isacord 40 1430
7 Isacord 40 1430
8 Isacord 40 1430
9 Isacord 40 0851
0. Isacord 40 0670
3.l Isacord 40 1900

82022-09

Isacord 40 0870
Isacord 40 0761
Isacord 40 0934
4. Isacord 40 1172
5.8 Isacord 40 0853
6. [l 1sacord 40 1055
7.l 'sacord 40 1565
8. Isacord 40 0862
9. Isacord 40 0015
10.  Isacord 40 0781

w N =

188

g 5nm B
- il R
4515 B
«» :?::%:::* B

11. [ 1sacord 40 0020  12. [l Isacord 40 0941

107 x 132 mm

<z 4.2 x 5.2 inch

n 13.993
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N

Pk10009-04 - I - R Pk10009-09 sonsimn B 42

1. [l 1sacord 40 0020 1. [l isacord 40 0020

19.14 Hobbies

100 x 152 mm 92 x 142 mm
12378-16 il 3.9 x6inch B o 12449-08 i 36 x5.6inch - JERLE

1. lsacord 40 0861
2. 1sacord 40 1874
3.l Isacord 40 0941

1. lsacord 40 0640
2. lsacord 40 0842
3.l 1sacord 40 3901
4. [ 1sacord 40 1900
5. [l 1sacord 40 5400
6./ Isacord 40 0131
7. lsacord 40 3971
8. [l 1sacord 40 0020
9. lIsacord 40 3971
10. [ Isacord 40 0504  11.] |lsacord 40 3910 12. [ Isacord 40 1900
13.. lIsacord 40 2640

82 x 144 137 x 85
12449-09 il 32x 5.7 inch B sas ﬂ 12572-04 il 54 x34inch B 72

1. [l isacord 40 3323
2.l 'sacord 40 3323
3. lsacord 40 3323
4.1 |lsacord 40 0105
5.l 1sacord 40 1055
6. [l 1sacord 40 1055
7. lIsacord 40 0015
8.[l Isacord 40 1055

1. Isacord 40 6031
2. Isacord 40 5115
3. [l Isacord 40 0504
4. lsacord 40 1351
5. Isacord 40 1753
6.l Isacord 40 2920
7.0 Isacord 40 1220
8.1 Isacord 40 0131

9. lsacord 40 3971 9.] Isacord 40 1123
10. [l 1sacord 40 0020  11. M Isacord 40 0721
121 x 104 mm 90 x 90 mm
L3 12611-01 i 438 x4.1inch B s L3 12721-02 i 3535inch B s

Isacord 40 0151
Isacord 40 0151
Isacord 40 0151

1 1.0 Isacord 40 1220
2

3.

4.] lIsacord 40 0151

5

6.

2., lIsacord 40 1220
3. Isacord 40 2220
4.l 1sacord 40 1805
5. lsacord 40 5610
6. Isacord 40 0015
7.1 'sacord 40 4174
8., Isacord 40 1220
9. Isacord 40 4220

.| lsacord 40 0151
[l 'sacord 40 1902
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12774-02

Isacord 40 3963
Isacord 40 3650
Isacord 40 3951
. lsacord 40 0017
. 1sacord 40 3853

[ TR RN

12796-03L 2

1. [l 1sacord 40 1904

12796-04s r

1. 1sacord 40 1904

12796-07m 2

1.l 1sacord 40 1904

12800-05I 2

1. lIsacord 40 0015

52 x 144 mm
2.1x 5.7 inch

194 x 278 mm
7.6 x 10.9 inch

B 330

B s

127 x 162 mm
5 x 6.4 inch

B e

153 x 167 mm
6 x 6.6 inch

203 x 248 mm
8 x 9.8 inch

B 2019

H 20.441

12774-04

1. 1sacord 40 5115

12796-04L

1. [l lsacord 40 1904

12796-05s

1. 1sacord 40 1904

12800-01s

1. lIsacord 40 0015

12800-05S

1. lsacord 40 0015

190

60 x 136 mm

ul 2.4 x5.4inch

Bl 7sss

204 x 259 mm
i 5 10.2 inch u 18.337

127 x 178 mm
5 x 7 inch

B s

111 x 176 mm

il 4.4x6.9inch u 12.448
123 x 150 mm

s 4.8 x 5.9 inch H 11.476
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12919-01

1. [ 1sacord 40
2.| lIsacord 40
3. Isacord 40
4. lIsacord 40
5. [l Isacord 40
6. [l 1sacord 40

5210
0934
3962
2560
2732
1055

51217-05L

1. lIsacord 40
2.| lIsacord 40
3. Isacord 40
4.l 1sacord 40
5. [l Isacord 40
6. Isacord 40
7. lIsacord 40
8. | 1sacord 40

3040
0842
0660
0853
0138
3971
2250
0020

80154-08

1.l 1sacord 40
2. lsacord 40

1355
0101

82014-24

1.l 1sacord 40

Ck973

1. [ 1sacord 40
2.. Isacord 40
3. [l sacord 40
4. lIsacord 40
5.0 lIsacord 40
6. [l Isacord 40
7.} 1sacord 40
8. [l 1sacord 40
9. [l sacord 40
10.  lIsacord 40
13. [l 1sacord 40

1902

3920
1061
0945
0101
3971
1010
1335
4174
1332
0660
0132

11.

84 x 154 mm

7

3.3x6.1inch

159 x 210 mm
6.3 x 8.3 inch

s

89 x 67 mm

7

3.5x 2.6 inch

Bl 0580

196 x 108 mm

< 7.7 x4.3 inch

106 x 61 mm
4.2 x 2.4 inch

N

Isacord 40 0311

12.

H 23.165

B e

Isacord 40 0704

191

114 x 170 mm
51216-11 il 45 x6.7inch B o

1. lsacord 40 3971
2. lIsacord 40 5050
3. Isacord 40 1532
4. ] 1sacord 40 0020
5. lIsacord 40 2155
6.l Isacord 40 2300
7.8 1sacord 40 5115
8.l sacord 40 2711
9. Isacord 40 1753
10. [l lsacord 40 2300 11. Isacord 40 0015 12.] lIsacord 40 1840

69 x 70
80154-02 4l 25 27 inch B s

1. Isacord 40 0904
2.l isacord 40 1346

121x85
82014-20 2 [P Bl 7560

1.l 1sacord 40 4174

8201429 Rl - R

1.l 1sacord 40 1902

2. 'sacord 40 0020
Mmade to creale

127 x 46 mm
Sr639 s 5x 1.8 inch u 20.623

1. lsacord 40 3650
2. lIsacord 40 5650
3.l lsacord 40 5513
4. Isacord 40 0670
5.0 Isacord 40 3641
6.l lsacord 40 3444
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5x 5inch

3.3 x8.5inch

12370-01 2 127 x 126 mm H 6.263 12370-04 2 83 x216 mm n 3.407

1. [l Isacord 40 5613 1.ll1sacord 40 2101 .

HEEFRERS

12370-12 g Jcemm By 3427 12952-02 g] O xjezmm I 15034

1. Isacord 40 3210 1. lsacord 40 0861
2. lsacord 40 0520
3.0 lsacord 40 1061
4. Isacord 40 0643
5.0 lIsacord 40 2051
6./ Isacord 40 0453
7.8 Isacord 40 0776
8.| lIsacord 40 0142
9.1 Isacord 40 0643
10.  lsacord 40 1362 11.| llsacord 40 1430 12.[J Isacord 40 4074
13. [ 1sacord 40 0111 14. [ 1sacord 40 1322 15[ Isacord 40 0020
16.  lIsacord 40 0010 17. Isacord 40 0520

12952-12 - IR - R 51287-03 - YT - I

1.0 Isacord 40 0643 1.l 1sacord 40 1334
2. Isacord 40 0352 o 2. Isacord 40 1120
3. Isacord 40 2051 3. [l sacord 40 3644
4.[  Isacord 40 0832 4. Isacord 40 3910
5.  lsacord 40 0352
6.l lsacord 40 0454
7. lsacord 40 0520
8. [l Isacord 40 0465
9. 1sacord 40 0020
10.  lIsacord 40 0010

80154-05 g ooon, Ees 8039 Jridll PR

1. lIsacord 40 0015
2. [ sacord 40 1911

1.l 1sacord 40 1730
2.l 'sacord 40 1900
3.l sacord 40 4114
4. [l 1sacord 40 3906
5. Isacord 40 2532
6. Isacord 40 0704

104 x 44 mm 115 x 171 mm
Lt850 8 2.1 1.7inch B 50 Pk50011-02 i 4567 inch B e

1. [l 1sacord 40 4174 1.l isacord 40 2711
2. lsacord 40 0015 2.l 1sacord 40 3211
3. Isacord 40 0124 3.l lsacord 40 2723
4.]  lIsacord 40 3640 4.l 1sacord 40 3611
5. Isacord 40 5822 5.l 1sacord 40 3906
6. Isacord 40 6133 6. 1sacord 40 0152
7.l 1sacord 40 5411
8.  Isacord 40 4250
9.l Isacord 40 5555
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119 x 172 mm 45 x 164 mm
Pk50011-03 il 47 x638inch H ELER) Pk50026-02 il 1865 inch n 72
1. [l 1sacord 40 5513 1. Isacord 40 4250
2.1 Isacord 40 5832 2.l isacord 40 4410 \v/
3. Isacord 40 5650 3.l lsacord 40 3743 v
4.l 1sacord 40 3611 4. lsacord 40 0822
5. [l Isacord 40 3906 5. lIsacord 40 0010 1
6.l Isacord 40 2920
7.0 Isacord 40 2830 -] i
8. Isacord 40 3040 ~
9. [l Isacord 40 1913
10. [ 1sacord 40 1725 11. [l 1sacord 40 1521 12. [}l Isacord 40 1334
13. [l 1sacord 40 1332 14.  Isacord 40 1362 15.[Isacord 40 0131
19.15 Seasons
123 x 161 mm 64 x 60 mm
12384-03 2 [P - JEREE 12400-07 - RPN - IEGE
1.l 1sacord 40 0945 1. lsacord 40 0250
2.l Isacord 40 0454 2. lIsacord 40 0630 @ /
3. lsacord 40 0352 3. | Isacord 40 1102 % g
@ A&
4. [l Isacord 40 2764 4. lIsacord 40 0800 /_ \
5.8 Isacord 40 2600 \\_/' ' m..,, Sl
6. Isacord 40 2761
253 x 253 mm 190 x 219 mm
12765-07 8 10 x 10 inch B s1oc0 12861-02L i 75856 inch -~ JRXRER
1., Yenmet 7005 1. lIsacord 40 2640
2. lsacord 40 0017 2.l 'sacord 40 2721
3.l Isacord 40 3815
4. lsacord 40 3962
5.l Isacord 40 2721
127 x 178 mm 77 x 163 mm
12895-02L l 5x 7 inch H 7610 51212-14 s 3 x 6.4 inch u 21112
1. lsacord 40 0010 | 1. 1sacord 40 5866
2., lsacord 40 3730 2. Isacord 40 0853
3.] |Isacord 40 5440 3. 1sacord 40 6133
4. 1sacord 40 5210 4. [Wisacord 40 1114
5.0 Isacord 40 5740 5. lsacord 40 0781
6.l lsacord 40 4174 6.) |lsacord 40 0771
7.1 lsacord 40 1030
8.l 1sacord 40 6133
9.l Isacord 40 5866
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51248-14L

1. [l 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4.1 1sacord 40
5. [l Isacord 40
6. [l 1sacord 40

2715
3902
0922
3630
2723
3645

51270-04

1.1 Isacord 40
2. lIsacord 40
3. Isacord 40
4. lsacord 40
5. [ Isacord 40
6. [l 1sacord 40
7. lIsacord 40
8.  Isacord 40
9. |l 1sacord 40

4740
2155
5115
4740
0904
1730
0506
0520
0138

51304-09

1. [l 1sacord 40
2. Isacord 40
3. [l 1sacord 40
4.1 1sacord 40
5. Isacord 40
6. [l 1sacord 40
7.8 1sacord 40
8. Isacord 40
9. Isacord 40

1600
0232
1565
1133
0853
1543
1010
0713
0520

82031-24

1. lsacord 40
2. lsacord 40
3. [ Isacord 40
4.l 1sacord 40
5.1 Isacord 40
6. Isacord 40
7.l 1sacord 40
8. [l Isacord 40
9. Isacord 40

5050
0015
0622
1321
1114
2171
3444
1753
2171

7

7

7

7

150 x 268 mm
5.9 x 10.5 inch

B 5496

Ao

125 x 207 mm
4.9 x 8.1 inch

H 16.828

80 x 106 mm
3.1x4.2inch

Bl s

123 x 119 mm
4.8 x 4.7 inch

H 23676
o

0.4 51266-06

1.1 1sacord 40
2. Isacord 40
3. Isacord 40
4. lsacord 40

0622
0622
0622
0520

51304-03

1. lsacord 40
2. lsacord 40
3.1 Isacord 40
4.} 1sacord 40
5.7 Isacord 40
6.l Isacord 40
7. lsacord 40
8. lsacord 40
9.l Isacord 40
10. [l Isacord 40
13. [l Isacord 40

1060
0184
6071
0853
0453
0555
0672
1362
1032
1010
2333

51312-01

1. [l Isacord 40
2.1 1sacord 40
3. [l Isacord 40
4. I1sacord 40
5. [l 1sacord 40
6.l Isacord 40
7.1l 1sacord 40
8.[ Isacord 40
9. lIsacord 40
10.[ Isacord 40
13. [l Isacord 40
16.  Isacord 40

5743
5833
5944
9868
1055
0945
1252
1123
0781
5531
1725
1532

Cc82425

1.l 1sacord 40
2.l 1sacord 40
3. Isacord 40
4. [l 1sacord 40

1134
1346
5730
5722

7

2

70 x 166 mm
2.7 x 6.5 inch

125 x 150 mm
4.9 x 5.9 inch

194

B 503

u 22.668

11.  lsacord 40 0352 12.
14. [ Isacord 40 2241 15.

7

11. [l Isacord 40 0747
14. [l sacord 40 2011

2

160 x 178 mm
6.3 x 7 inch

41 x 51 mm
1.6 x 2 inch

Isacord 40 0520
Isacord 40 1755

B s2560

12. [l lsacord 40 1252
15. [ lsacord 40 2123

u 5.290
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97 x 122 mm 72 x 83 mm
Cm>547_48 - OV -- LR Fp232 - JEPPEClU -- e

Isacord 40 0182
Isacord 40 0015
Isacord 40 5531
Isacord 40 0142
5. Isacord 40 6031
6. Isacord 40 0108
7.l Isacord 40 5101
8., Isacord 40 6011
9. [l lsacord 40 4122
10. [l 1sacord 40 4103 11. [l 1sacord 40 0111 12.] Yenmet 7030
13. [l 1sacord 40 3902 14. [l Isacord 40 0020

1. lIsacord 40 0101
2. Yenmet 7029
3. Isacord 40 4071 Y

MW =

Hd300 < [PPSR - - [RERE He923 48 - [P - - IRLAE:
1. lsacord 40 0015 1. lsacord 40 0101
2.l Isacord 40 3901 2. lIsacord 40 3840
3. lsacord 40 0015 3.0 lsacord 40 3641
4. lsacord 40 3650 4. lsacord 40 5822
5.l Isacord 40 3901 5. Isacord 40 5933
6. Isacord 40 0250 6. lIsacord 40 0145
7.0 Isacord 40 2830
8. [l Isacord 40 3743
9. lsacord 40 0800
10. [l 1sacord 40 1902 11. [l Isacord 40 0853  12. [ Isacord 40 3600
13.] Isacord 40 1430 14. lIsacord 40 5531 15./ Isacord 40 0811
16. lIsacord 40 0660 17.[lsacord 40 4174 18.  Yenmet 7029
Nb768_48 - ISR - AL 12404-10 - NCIRARN - IR

1. Isacord 40 0651
2.8 Yenmet 7037

1. [l isacord 40 0132
2.l 'sacord 40 2521
3. lsacord 40 2520
4. lsacord 40 2550

36 x 37 mm 100 x 157 mm
12422-33 il 1.4 1.5inch - JRXZE 12569-02 Ml 39 x6.2inch - JEEREY

1. Isacord 40 0922
2.l 1sacord 40 1154
3.0 Isacord 40 0811

1. 1sacord 40 3544
2. lIsacord 40 0015
3. 1sacord 40 5115
4.l 1sacord 40 2912
5.0 Isacord 40 5912
6. Isacord 40 0721
7. lIsacord 40 0630
8. lIsacord 40 2550
9. [l 1sacord 40 3710

1290724 - IRV - JESCR  RELEEE - vl - R
1. Isacord 40 4752 1.0 Isacord 40 1114
2. lsacord 40 1755 2.0 1sacord 40 1114 O o
3. [l 1sacord 40 5743 3.0 Isacord 40 1114
4. Isacord 40 0870 4. I1sacord 40 1114 =
5. [l lsacord 40 5555 5. [ Isacord 40 1114 @»«J-ﬂf’/
6. [l 1sacord 40 0020 & - @
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51232-02 - I -- EOE 51260-01 - ISP -- JRPEEE

4.2 x 5.8 inch

1. lIsacord 40 0608 1. [l Isacord 40 5743
2. lsacord 40 5230 @&@ 2. lsacord 40 1260
3.l Isacord 40 1900 3. [l sacord 40 3644
4. lIsacord 40 0010 4. lsacord 40 0311
5. [l 1sacord 40 0020 5. Isacord 40 4332
6. lIsacord 40 5230 6.1l 1sacord 40 3644
7.l 1sacord 40 1900 7.l 'sacord 40 1346
8. 1sacord 40 0020

86 x 166 mm 86 x 103 mm
£3 51266-01 il 34x6.5inch B oo 51304-08 il 34x4inch -~ JREREE
1.1 Isacord 40 2530 1.0 Isacord 40 0651
2.. | lsacord 40 2530 2. Isacord 40 0842
3.1 |Isacord 40 2530 3. 1sacord 40 0853
4. lIsacord 40 2520 4. [l 1sacord 40 1725

5. lsacord 40 2160
6.l lsacord 40 4174
7. Isacord 40 0108

5.l 1sacord 40 1521

6. Isacord 40 1430

7. lsacord 40 1532

8.l Isacord 40 1332

9.8 1sacord 40 1010
10.| Isacord40 1030 11. lIsacord 40 0713 12. lIsacord 40 0520
13. lsacord 40 1351

77 x 100 mm 110 x 116 mm
51304-10 il 3,3.9inch u 11.158 Fs080_48 il 4.4 x4.6inch n 703

1. [l 1sacord 40 1521
2. lIsacord 40 0352
3. Isacord 40 0232
4. Isacord 40 0651
5.0 Isacord 40 1430
6.l Isacord 40 1032
7.8 Isacord 40 1010
8. Isacord 40 0713

1 YLl variations 8007
2., lIsacord 40 9925
3., Isacord 40 0811
4.1 | YLl variations 8012
5. 1sacord 40 9978
6., | Isacord 40 0934
7.8 Isacord 40 0853
8. Isacord 40 1430

9. lIsacord 40 0520 9.l Isacord 40 9924
10.[ ] Isacord 40 1061  11. || Isacord 40 1565 10. [ sacord 40 0721 11. [ lsacord 40 1543
70 x 98 mm 100 x 135 mm
0c86075 - ISR -- EALE 0c88402 - [P -- RCE
1. lsacord 40 0520 i Isacord 40 5822

1
2.| |lsacord 40 1123 2.
3. [l Isacord 40 0504 3.1 |lsacord 40 0151
4. [l Isacord 40 0922 i 4. lIsacord 40 5610
5. lsacord 40 3962 ’L"/} !\{12 5. lIsacord 40 0630
=

Isacord 40 0101

P
il
o

6.1 Isacord 40 2761 [~ re 6./ Isacord 40 1600
> QY
7. | lsacord 40 3641 7. Isacord 40 1010

=
8. Isacord 40 1840 "@% 8. Isacord 40 5833
9. [l Isacord 40 1921 9. Isacord 40 0853
10. [ 1sacord 40 1055
150 x 174 mm 131 x 235 mm
Pk10037-02 - ISR -- IRREY Pk10031-02 - [T -- O

1. Isacord 40 9302
2.l sacord 40 1332
3.l 1sacord 40 9978
4.l Isacord 40 4620

1.l 1sacord 40 6156
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19.16 Holidays

41x126
12408-07 @ 16x5inch

1. YU variations 8008
2. [ sacord 40 4122
3. YU variations 8015
4.l sacord 40 1730
5. Yenmet 7029

43 x 64
12421-35 2 |

1. Isacord 40 0015
2.| Isacord 40 0131
3. [l sacord 40 0020

124 x 137 mm

12428-20 il 4.9 x5.4inch

1. Isacord 40 0015

202 x 135
12655-15 ul 8 x 5)f3 indTm

1.l 1sacord 40 1543
2.l 1sacord 40 1055
3.l sacord 40 1115

126 x 147 mm
5x 5.8 inch

12739-01 ul

H 46.003

1. Isacord 40 0015

66 x 141 mm

12408-08 M 26 x5.6inch

1./ Yenmet 7030
2.l YU variations 8015
3.l Isacord 40 1730
4. [l 1sacord 40 5500
5.8 YU variations 8008
6.l lsacord 40 4122
7.  Yenmet 7028

101 x 128 mm
12428-01 7 - 5.1inch n 4.503
1. lIsacord 40 0015 &

‘
u 8.345

87 x 86
m 12629-15 4l 3.4 3.4 Inch

Isacord 40 1220 e
Isacord 40 1220
Isacord 40 1220
Isacord 40 1220
Isacord 40 1220
Isacord 40 1220

7. lIsacord 40 1220

8.l Isacord 40 2920

9. Isacord 40 4421
10. [ Isacord 40 4421
13.  lsacord 40 0015

o v A wWN =

11. [ lsacord 40 4421 12.  lsacord 40 4240

98 x 132 mm

12682-01 z 3.9x 5.2 inch

n 11.482

Isacord 40 0230
Isacord 40 1030
Isacord 40 1114
Isacord 40 2560
Isacord 40 5832
Isacord 40 4430
.| lsacord 40 2220
8.l Isacord 40 2510

N ou oA~ W =

9 12766-08 2 [Pt -- REREY
1 Isacord 40 0017
2 Isacord 40 0017
3. lIsacord 40 0017
4. lIsacord 40 0017
5. Yenmet 7005

6.l lsacord 40 1903
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12793-04

1. [l 1sacord 40
2.l sacord 40
3. | 1sacord 40
4. [l 1sacord 40

1902
2776
0020
5633

12793-14

1. [} 1sacord 40

0020

12836-17

1. lIsacord 40
2.0 Isacord 40
3. | 1sacord 40
4. [l 1sacord 40
5. [l Isacord 40
6. Isacord 40
7.1 Isacord 40
8. [l 1sacord 40

1761
2051
0020
1900
2011
0010
0142
2011

80037-01

1.l 1sacord 40

1906

80037-23

1.l 1sacord 40

@e @(m
6 ~—p—"2

1906

243 x 282 mm
9.6 x 11.1 inch

B s7.006

81 x 174 mm
il 3> 6.9inch B e

107 x 134 mm
z 4.2 x 5.3 inch H 17387

e

120 x 119 mm
il 47 x4.7inch B oo

161 x 77 mm
<z 6.4 x 3 inch H >.878

12793-10

1.l 1sacord 40
2. Isacord 40
3. Isacord 40
4.l 1sacord 40

3631
3652
3652
3743

12836-12

1. [ 1sacord 40
2. 1sacord 40
3. [l Isacord 40
4. 1sacord 40
5.0 Isacord 40
6.l sacord 40
7. 1sacord 40
8. Isacord 40
9.1 Isacord 40
10. [ Isacord 40
13. [l Isacord 40

1161
5833
5643
2011
2152
1900
5643
5833
0453
5832
2011

32015-01

1. [ Isacord 40
2.l 1sacord 40
3. Isacord 40

5730
5722
5730

{3 80037-09

1. 1sacord 40
2. [l 1sacord 40
3. 'sacord 40
4. 1sacord 40
5. [l Isacord 40
6. lsacord 40

2320
1906
0020
0020
2300
2550

Cm302_48

1.0 lIsacord 40
2. Isacord 40

3045
2640

198

226 x 294 mm
8.9x 11.6 inch

cith

Uity

Timeo

112 x 165 mm
Ml 4.4 x6.5inch -~ [REEY

7

B 290319

A

Isacord 40 0010 12. Isacord 40 3963

124 x 160 mm

i 4963 inch B 456
143 x 81 mm

M 56x3.2inch - JEE

180 x 59 mm
7.1x 2.3 inch

s

B 585

v o &
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Hg298_48

1. [l 1sacord 40

2101

51212-07

1. |} 1sacord 40
2.l Isacord 40
3.1 Isacord 40
4.1 1sacord 40
5. [l Isacord 40
6. Isacord 40

2504
4220
1030
1114
5866
0015

51238-04

1., Isacord 40
2.| Isacord 40
3. Isacord 40
4. [l 1sacord 40
5. lsacord 40
6.1 Isacord 40

5740
1030
0108
4174
0640
3030

Pk50032-01

1. 1sacord 40
2..  Isacord 40
3. ] 1sacord 40
4.l 1sacord 40
5. lIsacord 40
6. Isacord 40
7.l sacord 40
8. [l 1sacord 40
9. [l 1sacord 40
10. [l Isacord 40
13.  lsacord 40

1321
1030
2715
2721
0605
0220
2715
2721
5613
5500
0605

65 x 112 mm

z 2.6 x 4.4 inch H 1.878
98 x 99 mm

B o B 13660

36 x 43 mm
il 1.4x1.7inch Bl e

—.f_- 1 1

160 x 211 mm
Ml 6383 inch B 005

11. [l 1sacord 40 1321 12.[ Isacord 40 1030
Isacord 40 0220 15. Isacord 40 1260

12907-20

1.l 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4. Isacord 40
5. [l 1sacord 40
6.1 Isacord 40
7. lIsacord 40
8. Isacord 40
9.l Isacord 40
10. [l Isacord 40

1134
5555
5743
4752
4133
1600
1755
0800
1912
1134

51238-03

1.1 | Isacord 40
2. lsacord 40
3. [l Isacord 40
4., lsacord 40
5.1 Isacord 40

3030
0640
4174
5740
0108

0c00429

Isacord 40
Isacord 40
Isacord 40
Isacord 40

MW =

0520
0270
0640
0532

Pk50032-04

1.l 1sacord 40
2. Isacord 40
3. [l Isacord 40
4.1 Isacord 40
5. [l 1sacord 40
6. Isacord 40
7. lsacord 40
8. lIsacord 40
9.l Isacord 40
10. |l Isacord 40

4423
5115
2508
2530
5613
5500
0605
0220
2715
2721

96 x 146 mm

il 335.7inch

199

B 1907

27 x 51 mm

<z 1.1 x 2 inch

Wt
Yy,

190 x 323 mm

s 7.5 x 12.7 inch

153 x 246 mm

s 6 x 9.7 inch

Ill 1.560

B 5101

Ill 34.614

Isacord 40 1260
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19.17 Celebrations

62 x 64 36 x 49
12436-23 il 55 x25 inch B 550 12478-01 2| e B s

1.1 YLl variations 8004
2.l sacord 40 1950
3. YU variations 8019

1.0 Isacord 40 0150
2.l isacord 40 1902
3. lIsacord 40 0015

39x48 39x37
12478-03 < | - JREEE 12478-07 Rl 0 i 4lineh B o

1.0 Isacord 40 3910
2. lIsacord 40 0640
3.1 Isacord 40 5912

1.1 | Isacord 40 5912
2. lsacord 40 0015
3. Isacord 40 2810

39 x 55 43x38
12478-08 il 15 %22 inch - JERLE 12478-12 R - JEER

1.0 | lsacord 40 5912 1. [ 1sacord 40 0020
2.l Isacord 40 0941
3.1 Isacord 40 2530
4.| lsacord 40 3910

5.0 Isacord 40 0622

46 x 53 mm 119 x 174 mm
12478-13 <z 1.8 x 2.1 inch H a2 12555-02 s 4.7 x 6.9 inch n 7812
1. 1sacord 40 1902 & 1.l 1sacord 40 5400
2.l Isacord 40 2810 =) 2.l 'sacord 40 1902
3.1 | Isacord 40 5912 .\:;_\;,,"‘:" 3.l Isacord 40 3906
4. lIsacord 40 3910 ""\Q’) Q 4. Yenmet 7029
m‘ 5. [l 1sacord 40 5500
# 6.1l 1sacord 40 4122
—\‘
g f?\ 7., Yenmet 7030
o 8.l sacord 40 1730
115 x 117 mm 134 x 142 mm
12693-01 8 4.5 4.6inch -~ JRERER 12718-01 @l 5.3 x5.6inch - JRERCY

1.l 1sacord 40 4174 1. lsacord 40 0015
2.l 1sacord 40 4174
3.l 1sacord 40 4174

4. 1sacord 40 4174




Appendix

19 Embroidery Designs 201

97 x 125 mm 122 x 152 mm
51252-02 il 55 49inch H 24.063 51252-03 il 156 inch n 23.665
1.0 Isacord 40 2152 1.] | Isacord 40 2152 HIP HIP
2. lsacord 40 0015 : 2. lsacord 40 0015 4 P
3. Isacord 40 4430 B2 ) 3. Isacord 40 4430 ﬂ“ LY g S
4.1 lsacord 40 2152 4. [l 1sacord 40 0020 ; p:
5. lsacord 40 0015 5. lIsacord 40 0702 % ;'E:
6. lIsacord 40 0702 6. Isacord 40 2152 - '[’W‘ [I
7. 1sacord 40 0020 Bll-H o bAY
80 x 151 mm 97 x 154 mm
51252-07 B sone B 1458 51252-08 Al i B 21699
1. Isacord 40 4421 1.0 Isacord 40 2241
2. lsacord 40 4430 2., | lsacord 40 2152
3.] Isacord 40 2152 3. Isacord 40 0702
4. lsacord 40 0702 B 0.0 4. lsacord 40 0250
5. lsacord 40 0250 5. lsacord 40 0015
6. Isacord 40 0015 ' 6.1l 1sacord 40 0020
7.l sacord 40 0020 %o I
98 x 160 mm 102 x 153 mm
51252-09 B Cezinn B 20912 51252-10 il 4 6inch -~ JREESE

- 'sacord 40 0020
.l sacord 40 0132
Isacord 40 2152
Isacord 40 0702
Isacord 40 0250
. Isacord 40 0015
. 'sacord 40 0020

1. 1sacord 40 4421
2 Isacord 40 4430
3 Isacord 40 0702 : (
4. lsacord 40 0250 s
5 Isacord 40 0015
6. [l 1sacord 40 0020

No e w2

94 x 155 mm 102 x 151 mm
51252-11 il 37 x6.1inch B 20070 51252-12 il 4x5.9inch B o5

1.0 | lsacord 40 2241 1. 1sacord 40 0020
2.[ llsacord 40 2152 2.l isacord 40 0132
3. Isacord 40 0702 __-_LTT;] 3. lIsacord 40 0702
4. Isacord 40 0250 ; I"" g 4. lIsacord 40 0250
5. Isacord 40 0015 [:3_ N 5. lsacord 40 0015
6. [l lsacord 40 0020 \\ 6.l lsacord 40 0020
51252-13 - IR - BEEC 51252-14 3 emen B e

M isacord 40 4421
Isacord 40 4430
Isacord 40 0702

1 Isacord 40 2241
2

3

4. lsacord 40 0250

5

6

1
2 Isacord 40 2152
3. Isacord 40 0702 L .
4. lsacord 40 0250 \\
Isacord 40 0015 5
. 'sacord 40 0020 6

. Isacord 40 0015 2
. 'sacord 40 0020 p-
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202

100 x 150 mm 95 x 151 mm
51252-15 s 3.9 x 5.9 inch H el 51252-16 s 3.7 x 5.9 inch n el
1. [l 1sacord 40 0020 1. [ Isacord 40 4421
2.l sacord 40 0132 2.0 lsacord 40 4430
3. Isacord 40 4430 3. lIsacord 40 0702
4. lIsacord 40 0702 4. lsacord 40 0250
5. lsacord 40 0250 5. lIsacord 40 0015
6. Isacord 40 0015 6. [l 1sacord 40 0020
7. 1sacord 40 0020
102 x 94 mm
Pk50019-03 < 4 x 3.7 inch u [
1.l 1sacord 40 4174
2.l 1sacord 40 4174
3. [l 1sacord 40 4174
4. ] 1sacord 40 0020
5. Isacord 40 0870
6.1 Isacord 40 0622
7. [l sacord 40 4174
19.18 Travel
190 x 110 mm 148 x 104 mm
12446-18 < [y SPprRe -- ALY 3 12677-03 IR - R
1. lIsacord 40 0015 1. 1sacord 40 0108
2. lsacord 40 0015 2.8 Isacord 40 0108
3. Isacord 40 0108
4. 1sacord 40 0108
5. Isacord 40 0108
6. Isacord 40 0108
7./ Isacord 40 0108
8. Isacord 40 0108
9. Isacord 40 0108
10.  Isacord 40 5050 11.[Misacord40 1010 12. [l isacord 40 1332
13. [ Isacord 40 4610  14. [ Isacord 40 0132
85 x 30 mm 40 x 40 mm
12773-01 - [EOPRE - [EALC 12773-02 - [P - RRLT
1. [} 1sacord 40 0020 1. [ 1sacord 40 0020
32 x 82 mm 91 x 39 mm
12773-03 [PPSR -- IR 12773-09 s B 2972

1. ] 1sacord 40 0020

1. [ 1sacord 40 0020

Erglride



Appendix

19 Embroidery Designs 203

33x33 54 x 79
12773-10 - IEFORPV -- RE 12773-11 - [EVNCSIU -- IR

1. [l 1sacord 40 0020 1. [l isacord 40 0020

54 x 44 mm 40 x 19 mm
12773'17 7 2.1x 1.7 inch H 2.192 12773-18 i 1.6 x 0.8 inch u ey
1. [ 1sacord 40 0020 1. [ 1sacord 40 0020
L

Qo057

1277319 g oo, e 1217320 - A - R

1. ] 1sacord 40 0020 1. 1sacord 40 5730
2. lsacord 40 0230
3.1 Isacord 40 0874
4.l 1sacord 40 0722
5.  lsacord 40 0145
6.l lsacord 40 0138
7. lIsacord 40 5050
8. Isacord 40 5230

9. sacord 40 0020

| (7
A
II.,ll*

1 l,l’ NI
O

94 x 30 mm 29 x 32 mm
12773-21 < 3.7x 1.2 inch H SHsE 12773-22 <z 1.1 x 1.3 inch u 522
1. ] 1sacord 40 0020 1. 1sacord 40 0020
(]
94 x 30 mm 71 x 54 mm
12773-23 - ISP -- REIE 12773-24 2 [EORAAN -- JEEE
1. ] 1sacord 40 0020 1. lsacord 40 4071

2. lIsacord 40 4230
3.l lsacord 40 3815
4. 1sacord 40 1911
5.l 1sacord 40 1704
6. lsacord 40 0020
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12773-25

1. [l 1sacord 40 0020

12773-29

1. [ 1sacord 40 0020

12773-33

1. ] 1sacord 40 0020

12773-35

1. [ 1sacord 40 0020

12773-38

1. ] 1sacord 40 0020

7

7

s

7

s

93

X 33 mm

3.6 x 1.3 inch

78

X 38 mm

3.1x1.5inch

83

X 23 mm

3.3x0.9inch

84

X 32 mm

3.3x 1.3 inch

33

X 40 mm

1.3 x 1.6 inch

L5,

AU,

¥

NEDERLAND

H 1.944

12773-26

1. [l isacord 40 0020

12773-30

1. [ 1sacord 40 0020

12773-34

1. 1sacord 40 0020

12773-37

1. 1sacord 40 0020

12773-39

1. [ 1sacord 40 0020

204

2 46 x 32 mm
1.8 x 1.3 inch
= o) 5
=
(==
=
=
L ]
33 x 33 mm
2 [ -- T

s

2

s

216100,

40 x 40 mm
1.6 x 1.6 inch

100 x 27 mm
3.9x 1.1inch

THE

62 x 72 mm
2.4 x2.8inch

u 3.206

H 2.176
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205

128 x 119 mm 126 x 168 mm
m 12792-10 ul 5.1 x 4.7 inch H 9.777 12804-01s l 5 x 6.6 inch n 32.368
1. [l 1sacord 40 1800 1. [l isacord 40 0020
2.l 'sacord 40 1800 e
3. [l Isacord 40 1800 Ll
4. 1sacord 40 1800 '
5.l Isacord 40 1800 i
6.l 1sacord 40 2101
126 x 132 mm 152 x 252 mm
12804-04s < 5x5.2inch H 23372 51217-121 s 6 x 9.9 inch u Eoi=
1. [ 1sacord 40 0020 1.0 lIsacord 40 1133
2., lIsacord 40 3730
3.1 Isacord 40 3630
4. ] 1sacord 40 0020
67 x 134 mm 92 x 100 mm
51284-01 i 56 x53inch H IS 51296-04 i 36x3.9inch n 30.369
1.l 1sacord 40 4643 1.l 1sacord 40 3654
2. lIsacord 40 0221 2. Isacord 40 0800
3.1 Isacord 40 1114 3. lIsacord 40 0970
4. [ Isacord 40 1305
5.l lsacord 40 1055
6.1l 1sacord 40 1776
7. 'sacord 40 1776
91 x 92 mm
51296-10 - ISR -- 2
1.0 Isacord 40 0821
2. [l Isacord 40 0941
3.l Isacord 40 0941
19.19 Words and Sayings
97 x 158 mm 112 x 139 mm
12381-01 ~ IO HN I -- IREEY 12449-02 IR -- R
1.0 |lsacord 40 2153 1. [l Isacord 40 2920 2
2.l Isacord 40 2011 2.8 Isacord 40 0504
3. Isacord 40 0015
4. lsacord 40 2830
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12697-02

1. [l 1sacord 40
2.l 1sacord 40
3. [l Isacord 40
4. lsacord 40
5. lIsacord 40
6., Isacord 40
7.1 lIsacord 40
8. [ Isacord 40
9.  Isacord 40
10. [l 1sacord 40

3713
0555
4220
4240
0761
0442
1430
1311
1060
1321

12738-03

1.l 1sacord 40
2.1 Isacord 40
3. [ Isacord 40
4. lIsacord 40
5. [l 1sacord 40
6. Isacord 40

2500
4152
0643
0015
2944
5610

12770-08

1. lsacord 40
2. lsacord 40
3.l Isacord 40
4.l 1sacord 40
5. [l Isacord 40

1532
1840
1753
2320
1903

12809-04

1. lIsacord 40
2.l sacord 40
3. [l 1sacord 40

4240
4114
4116

12913-10L

1. lsacord 40
2.l sacord 40
3.1 Isacord 40
4. [l 1sacord 40
5.1 Isacord 40
6. [l 1sacord 40

0015
0132
0832
4423
1600
0132

7

s

7

123 x 153 mm
4.9 x 6 inch

113 x 139 mm
4.4 x 5.5 inch

116 x 112 mm
4.6 x 4.4 inch

A0
{ i ‘

B 19576

H 25182

7

7

127 x 160 mm
5x 6.3 inch

OF IT .

127 x 178 mm
5x 7 inch

H 10.381

IS WHRT YOU

H 3.929

12738-01
1.1 Isacord 40 4152
2.1 Isacord 40 0643
3. Isacord 40 5610
4.l 1sacord 40 2500
5. 1sacord 40 2944
12770-01
1. lIsacord 40 0800
2. lIsacord 40 3652
3. Isacord 40 1532
4. [l 1sacord 40 4174
12774-03
1.0 lsacord 40 0874
2.l 1sacord 40 1913
12843-04
1. lIsacord 40 0520
2. lsacord 40 0310
3.[l Isacord 40 5510
4. lsacord 40 5740
5. lsacord 40 5610
6. Isacord 40 0311
7. lIsacord 40 0010
8.[l Isacord 40 5510
9. lIsacord 40 0311
19999-029
1.0 Isacord 40 1840
2. lsacord 40 0800
3. |lsacord 40 1114
4. [l 1sacord 40 1704
5.0 lsacord 40 3951
6. Isacord 40 4952
7.8 Isacord 40 5210
8. Isacord 40 2650
9.l lsacord 40 1375
10. lsacord 40 0015

206

126 x 121 mm
5x 4.8 inch u 1618

Time
) to

138 x 140 mm
8 5.4x5.5inch B 60

126 x 136 mm
s 5x 5.4 inch u 9.656

126 x 199 mm
M 5 7.8inch B s

121 x 119 mm
il 4.8 x4.7inch B 2600

2 8




Appendix

19 Embroidery Designs

51209-02

1. |} 1sacord 40
2.l sacord 40
3. [l Isacord 40
4. 1sacord 40
5.1 Isacord 40
6.1 Isacord 40
7.l 1sacord 40
8. | 1sacord 40
9. Isacord 40
10.  lIsacord 40
13. [l 1sacord 40
16. ] 1sacord 40

0020
4410
4643
4610
3030
3150
2920
0020
0010
0608
1912
0020

51209-04

1. [ 1sacord 40
2. [l 1sacord 40
3. [l 1sacord 40
4. 1sacord 40
5. [l Isacord 40
6. Isacord 40
7. | 1sacord 40
8. Isacord 40
9. [ Isacord 40
10. [l Isacord 40
13. [l Isacord 40

0020
4643
4410
4610
4643
0182
0020
0608
0904
1321
1725

51209-09

1. [l 1sacord 40
2.l sacord 40

0020
4410

51248-12S

1.l 1sacord 40
2.| lIsacord 40
3.1 Isacord 40
4. 1sacord 40
5. [l Isacord 40
6. [l 1sacord 40
7.l 1sacord 40
8. [l 1sacord 40

3902
3630
3630
2723
3902
2715
0922
3645

171 x 196 mm
6.7 x 7.7 inch H 433K 51209-03
1. [l isacord 40 0020
2.l Isacord 40 2920
3.1 Isacord 40 3150
4.1 |lsacord 40 3030
5. lsacord 40 0182
6.1l 1sacord 40 2920
7. 'sacord 40 0020
8. Isacord 40 0010
11. [ 1sacord 40 0904  12. [l Isacord 40 1321
14. [l 1sacord 40 1902 15. [l Isacord 40 1725
17.  lsacord 40 0010
146 x 216 mm
il 57 x85inch -~ IERE 51209-08
1.1 | Isacord 40 3030
2. [Misacord 40 2920
3. [l 1sacord 40 0020
11. [l sacord 40 1912 12. [ 1sacord 40 1902
14. | 1sacord 40 0020  15.  Isacord 40 0010
68 x 162 mm
i o7 6.4 inch H [ 51248-02L
% 1. 1sacord 40 3902
S 2.1 1sacord 40 3630
I- 3 .I
b . sacord 40 2723
{ 4.l 1sacord 40 3902
bl
t) 5.1 Isacord 40 3630
Y 6. [l 1sacord 40 2715
ii:l'
110 x 171 mm
il 1.4x6.7inch -~ JERED 51278-05
1. lIsacord 40 1260
2.| |lsacord 40 0731

207

110 x 214 mm
z 4.3 x 8.4 inch n B2

50 x 163 mm
s 2x 6.4 inch u 15238

197 x 206 mm
z 7.7 x 8.1 inch n 17452

100 x 131 mm
il 30 x5.1inch B o
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127 x 155 mm
5x6.1inch

51300-01 2

Isacord 40 4740
Isacord 40 1362
Isacord 40 0520
Isacord 40 1860
. lsacord 40 2550
6.l 1sacord 40 2508
7.l Isacord 40 4531
8.1 Isacord 40 1220
9. lIsacord 40 0704
10. [ 1sacord 40 1753

v woN =

11. [ 1sacord 40 4220

106 x 173 mm
4.2 x 6.8 inch

Isacord 40 4740 /%

Isacord 40 2550 U4
lsacord 40 1362
4. lsacord 40 1220
5. [l 1sacord 40 2508
6.l Isacord 40 4220
7.l Isacord 40 4531

51300-04 2

woN =

131 x 136 mm
51300-11 il 51x5.4inch
1. Isacord 40 4220
2.1 Isacord 40 2550 &
3. lsacord 40 0520 (V]
4. [l sacord 40 2508 £ S

6./ Isacord 40 4740
7.l Isacord 40 4531
8. Isacord 40 1860
9. 1sacord 40 1753

A
5. lsacord 40 1362 l'Cl': @ i
—t '(_

3

o)

243 x 249
Pk10004-01I il 96x98inch

1.0 Isacord 40 4752

2.l 1sacord 40 2920 _ &
3. lIsacord 40 6051 : :
4. lsacord 40 0232
5.8 Isacord 40 6133
6.] Isacord 40 6071
7.l Isacord 40 2910
8. [l Isacord 40 0465
9. lIsacord 40 1755
10. [l 1sacord 40 3410  11.[llIsacord 40 2723 12, Isacord 40
13.[]Isacord 40 6071 14.[ Isacord 40 4752 15.|  Isacord 40
16. [ Isacord 40 6133 17.  Isacord 40 0010 18. [ Isacord 40
19. [l Isacord 40 2920  20. Isacord 40 6051 21. [l Isacord 40
22. [ 1sacord 40 2320  23.| Isacord 40 1352  24. [ 1sacord 40

B 29n2

H 12.911

H 67.094

0232
1352
4610
2910
0465

51300-02

1.0 | Isacord 40 4740
2. lIsacord 40 1220
3. Isacord 40 4220
4. lIsacord 40 0520
5.8 Isacord 40 1753
6. Isacord 40 0704
7. lIsacord 40 0015
8., Isacord 40 2550
9.[l Isacord 40 2508
10. [l Isacord 40 4531

51300-10

1. lIsacord 40 1362
2., lIsacord 40 1220
3., Isacord 40 2550
4. [l 1sacord 40 2508
5.0 lsacord 40 4740
6. Isacord 40 4220
7. lIsacord 40 0520
8. Isacord 40 0704
9.l Isacord 40 4531

Cm203_48

1.0 lIsacord 40 2550
2. lIsacord 40 2160
3.8 Isacord 40 2761
4.  lsacord 40 0640

208

135 x 155 mm

z 5.3 x 6.1 inch n 13.846
110 x 147 mm

il 43x538inch -~ JEREE
135 x 53 mm

il 532.1inch - JEREE
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209

19.20 Monograms

12863-01 2

1. [ 1sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

12863-03 2

1. [l 1sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

12863-05 2

1. [ 1sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

12863-07 4

1. ] 'sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

12863-09 2

1. [ 1sacord 40 0020
2.l 1sacord 40 0020
3.l 1sacord 40 0020

4.4 x 4.7 inch

4.4 x 4.7 inch

4.4 x 4.7 inch

4.4 x 4.7 inch

4.4 x 4.7 inch

12863-02

1. 1sacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

12863-04

1. [l isacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

12863-06

1. [ 1sacord 40 0020
2. 'sacord 40 0020
3. sacord 40 0020

12863-08

1. [ 1sacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

12863-10

1. [ 1sacord 40 0020
2. [l 1sacord 40 0020
3. [l 1sacord 40 0020

113 x 119 mm
Ml 4.4x4.7inch B o

113 x 119 mm
il 4447 inch B 0360

113 x 119 mm
4.4 x 4.7 inch u 1044

113 x 119 mm
4.4 x 4.7 inch n 10,261

113 x 119 mm
4.4 x 4.7 inch u Bl
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12863-11

1. [l 1sacord 40 0020
2. sacord 40 0020
3. Isacord 40 0020

12863-13

1. [ 1sacord 40 0020
2.l 1sacord 40 0020
3.l 1sacord 40 0020

12863-15

1. ] 1sacord 40 0020
2. [ sacord 40 0020
3. sacord 40 0020

12863-17

1. [ 1sacord 40 0020
2.l 1sacord 40 0020
3.l 1sacord 40 0020

12863-19

1. ] 1sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

7

s

7

s

113 x 119 mm
4.4 x 4.7 inch

Bl 10644

113 x 119 mm
4.4 x 4.7 inch

113 x 119 mm
4.4 x 4.7 inch

113 x 119 mm
4.4 x 4.7 inch

113 x 119 mm
4.4 x 4.7 inch

H 10.896

H 10.410

12863-12

1. [l isacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

12863-14

1. [ 1sacord 40 0020
2. [l 1sacord 40 0020
3. [l 1sacord 40 0020

12863-16

1. 1sacord 40 0020
2. isacord 40 0020
3. 'sacord 40 0020

12863-18

1. 1sacord 40 0020
2. [l 1sacord 40 0020
3. [l 1sacord 40 0020

12863-20

1. [ 1sacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

210

113 x 119 mm
4.4 x 4.7 inch

B 0019

113 x 119 mm
4.4 x 4.7 inch

u 10.622

113 x 119 mm
4.4 x 4.7 inch

u 10.539

113 x 119 mm

il 4.4 x4.7inch B oo
113 x 119 mm

Ml 4.4x4.7inch B o
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12863-21

1. [l 1sacord 40 0020
2. sacord 40 0020
3. Isacord 40 0020

12863-23

1. [ 1sacord 40 0020
2.l 1sacord 40 0020
3.l 1sacord 40 0020

12863-25

1. ] 1sacord 40 0020
2. [ sacord 40 0020
3. sacord 40 0020

12863-27

1. [ 1sacord 40 0020
2.l 1sacord 40 0020
3.l 1sacord 40 0020

12863-29

1. ] 1sacord 40 0020
2. sacord 40 0020
3. sacord 40 0020

113 x 119 mm
4.4 x 4.7 inch

B 10410

113 x 119 mm
4.4 x 4.7 inch

H 10.738

113 x 119 mm
4.4 x 4.7 inch

u 10.206

113 x 119 mm
4.4 x 4.7 inch

H 11.934

113 x 119 mm

< 4.4 x 4.7 inch

H 9.850

12863-22

1. [l isacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

12863-24

1. [ 1sacord 40 0020
2. [l 1sacord 40 0020
3. [l 1sacord 40 0020

12863-26

1. 1sacord 40 0020
2. isacord 40 0020
3. 'sacord 40 0020

12863-28

1. 1sacord 40 0020
2. [l 1sacord 40 0020
3. [l 1sacord 40 0020

12863-30

1. [ 1sacord 40 0020
2. 'sacord 40 0020
3. 'sacord 40 0020

211

113 x 119 mm
4.4 x 4.7 inch

Bl 0169

113 x 119 mm
4.4 x 4.7 inch

u 10.728

113 x 119 mm
4.4 x 4.7 inch

u 10.367

113 x 119 mm

il 4.4 x4.7inch ﬂ 023
113 x 119 mm

Ml 4.4x4.7inch - JRIREE
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19.21 In the Hoop

You can find the detailed embroidery instructions at
bernina.com/990-designs.

100 x 192 mm 114 x 133 mm
12751-03 < [ SpeR -- JERER 19999-019 - [T -- X0
1. lsacord 40 2550 Y 1. [l isacord 40 0020 e
2.0 Isacord 40 2550 [ 7 ¥ ‘-.l 2. lIsacord 40 2550 / \\
A )
3.| lIsacord 40 2550 ]' } 3. [l 1sacord 40 0020 I;'f \
4.] lsacord 40 2550 4.[l isacord 40 0020 | @ |
5.0 Isacord 40 2550 | \ -
6./ lsacord 40 2550 ' \ /
7. |lsacord 40 2550 \\
8.] lsacord 40 2550 \x____/
110 x 125 mm 98 x 113 mm
12888-01 B isome B 10220 12888-02 [N -- X
1. lIsacord 40 2520 - 1. lIsacord 40 2520
2. lIsacord 40 2520 2. lsacord 40 2520
3. Isacord 40 2520 3. lsacord 40 2520
4. lsacord 40 2520 4. lsacord 40 2520
5. lsacord 40 0010
150 x 165 mm 122 x 141 mm
12888-03 B coiesinn B 14122 12888-04 2 [P -- R
1. [l Isacord 40 2905 1. [l 1sacord 40 2905
2. [ 1sacord 40 2905 2.l 1sacord 40 2905
3. [l Isacord 40 2905 3. [l Isacord 40 2905
4.l 1sacord 40 2905 4. [l 1sacord 40 2905
5. lsacord 40 0010
125 x 190 mm 98 x 113 mm
12888-05 <~ Irpereh -- RECE 12888-06 TSN -- X
1. Isacord 40 4032 1. 1sacord 40 4032
2.l Isacord 40 4032 2. Isacord 40 4032
3. Isacord 40 4032 3. 1sacord 40 4032
4.l Isacord 40 4032 i 4.l 1sacord 40 4032
5. lsacord 40 0010
b
=
99 x 129 mm 83 x 82 mm
51298-02 <z 3.9 x5.1inch u 0275 51298-03 z 3.3x3.2inch n S
1. Isacord 40 0630 - 1. lIsacord 40 0870
2. Isacord 40 0630 » o Ny 2. lsacord 40 0870 Y
3. Isacord 40 0630 // . 3. Isacord 40 0870 o (o]
4. lsacord 40 6051 4. [l 1sacord 40 1565 i o o
\ %09,


https://www.bernina.com/990-designs
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38 x 230 mm 83 x 82 mm
51298-04 z 1.5 x 9.1inch u 17356 51298-05 z 3.3x3.2inch n 4.439

1. lIsacord 40 0630 1. [l Isacord 40 1565
2. lsacord 40 0630 2.l 'sacord 40 1565
3. Isacord 40 0630 3.l Isacord 40 1565
4. lIsacord 40 1220

5.l lsacord 40 1565
6. Isacord 40 0870

110 x 199 mm 88 x 129 mm
51298-06 Bl s B 34440 51298-01 [P TNA -- EER
1. lsacord 40 0630 " 1. lIsacord 40 6051 -
2. llsacord 40 1220 N 2. lsacord 40 6051 v Ny
3. lIsacord 40 1860 b 3. lsacord 40 6051 / ;

Y
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Stitch Plate «vvveee 50, 80

Upper Thread Tension SEWING .........ccccceeevvveeenn, 50

Upper Thread Tension Stitching ...........cccooeeen. 80
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Dispose of the machine.............c..cccoeooeiiiie 108
Distance

TRread ..., 94
DISTOI oo, 63
Dual Feed ..o, 41

Optimize Balance..........coooeviiiiiiiiii 64

Switching On/Off ..., 41
Duplicate

Embroider Design .......coccvviiiiiiiiiiiiie 84

Stitch Pattern......oooeei 69
E
Edit

StItCh DeSIGN .o, 75

Stitch Pattern.........ooooeeiiiiiic 49, 62

Stitch Pattern Combination................cooceeen 68

Tapering Stitches .......ccccooviiiiii 66

Xt 92
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Dual Feed ..o, 64
Editing
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Darning Program .........ccccccooiiiiiiiiiiiiicee 67
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AlIGN o, 85
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CNTET i 86
Change Color ..ot 87
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Check .o, 86
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Delete ..o, 85
DUPHICAE v 84
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Editing ..oooii 79, 84
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GIOUD et 85
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SelECt .., 83
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UNGrOUD e 85
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SAVING ettt 93
USB SHICK e, 82
Embroidery Module
CONNECHING ..vviiiiie e 42
REMOVING ... 42
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AJUST ., 79
Embroidery Speed
SEHINGS .ot 47
Embroidery TeSt ....ovvviiiiiiiiiiece e, 78
ENAIESS ..o 90
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FEEA DO ... it 41
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Feed Dog Up/Down
DiSPIlaY ..o 50, 80
SEttiNG. oo 50, 80
File
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MOVING ..t 23
Rename ... 23
File FOrmat.........ooooiiiiiii e, 77
File Manager........coooovviiiioiiiceee e 51, 81
Embroidery Design.......ccccoooeiiiiiiiii 82
Navigation Bar.........cccccoooviiiiii 52, 82
Quick Access Bar Embroidery Mode .................... 82
Sewing Mode Quick Access Bar.........cccccooeevnn... 52
TOOIDAN .. 51, 81
File Manger
Stitch Pattern ... 52
Folder
COPYING ettt 23
DeIETE .o 23
MOVING .. 23
Rename ... 23
FONT . 82, 91
EMbroidery ..o 82
Foot CoNtrol ........cocveiiiiicce e, 26
CONNECEING ...t 26
Programming the Back Kick Function.................. 46
H
HelD. o, 23
Help Center ..., 24
Home SCreen ... 21
Hook
CleaNING ... 99
Lubricating .....ooovvviiiiii 100
HOOD 42
AAChING ..o, 42
Calibrating........oooviiiiiiiii 47
DISPIaY ... 80
REMOVING .. 42
SETHING i 80
Hovering Position, Presser Foot
AJUSTING ..o, 45
I
Icon Bar
File Manager........ccccoooviiioiiiiiiece e, 52
J
Jumbo StitCh ..o, 62

216

K
KNee Lifter ..o 28

ATACN . 29

Lower Presser FOOt .........ooovvvieeiiiiiiiiieee 29

Raise Presser FOOt..........oovvviiiiiiiiceeeeeeeeeeeee 29
L
LaNQUAGE ... 44
Laser

Switching On/Off ... 51, 81
Lettering

Creating....cooveeeiicec e 92

Eiting ..o 92

Line SPACiNg.....veiiiiiiiiiie e, 92

SPACING ettt 92

SEYIING e 92

TransformM ..o 92
LetrS . 52
Light in Bobbin Area

Switching On/Off ..o 50, 80
Loading

Embroidery Design ........ccccoooiviiiiiiiiiiiiieeee 83

Own Stitch Pattern........ccoooooeieiii 52

Own Stitch Patterns ........cccooooeiiiiii 52

Saved Stitch Patterns..........coooooviiii 52

Stitch Pattern ... 61
Lock

SCIEBN ... 22

Sewing FUNCHION .....ooviiiiic e 22
Lock Sewing FUNCtion............coooiiiiiiiiiiice e, 22
LOG File oo 101
LONg SHECh ..o, 62
Lower Thred Bobbin Fill Capacity........................ 50, 80
M
Machine

Switching On/Off ..o, 25
Machine Name ..., 43
Maintenance Information ..., 98
Mirror

Embroidery Design ......ccccoovvviieiiiiiiiieie e, 84

Stitch Pattern ... 62
Move

Embroidery Design ......ccccoovviiiiiiiiiiiiiecie e, 84

Stitch Pattern ... 68
Moving

il 23

Folder .o 23
N

Navigation Bar
File Manager ........coccooiiiiiiiiic, 52, 82
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Needle

AAChING ..o, 32

Changing ...oveeiiiii 32

DiSPlaY..ccoieiiiieeie 50, 80

SeleCtiNg...oi o 32

SETING i 50, 80

SIZE 30
Needle Minder........cccccoviiiiiiiiiie e, 32
Needle OVEIVIEW........ccoiiiiiiiiiiiieeeeee e, 30
Needle Position Left/Right ..............cccooiiiiiiie, 33

BUTTON . 15
Needle Position Up/DOWN ........cccoeeviiiiiiiiiiiiiiiee, 33

BUTTON . 14
Needle Stop

DISPIaY ... 50

SETHING i 50

UDR/DOWN .. 33
Needle Threader ..........cooviiiiiiiiiiieee e, 34
Needle-Thread

CombiNation .......oovviiiiii 30
O
Optimize Balance ...........ooooviiiiii e 63
Overview of Embroidery Designs............ccccceeeeen.nn. 119
Own Embroidery Designs

Personal Folder ..........ooooiiiiiiiiii 82

USB STICK 1.t 82
Own Stitch Pattern. ..o 52
Own Stitch Patternr

DSIGN ettt 74
Own Stitch Patterns

TO USB SHCK .. 52
P
Pattern Begin

BUTTON .o 14
Pattern End

BUTTON .o 14
Pattern Repeat.........ccoooiiiiiiiiiii 62
Power Cable ..o 25
Power SWitCh ..., 25
Practical Stitches ... 52,53
Preparation

Embroidery ..o 26
Preparing the Machine

SEWING ittt 25
Presser Foot

AHaching ..o 40

Changing ....ooooiiiii 40

DiSPIlaY ..o 50, 80

LOWETING .o 40

Raise, with Knee Lifter ........cccooooiii 29

RAISING ..ot 40

Selection......ooii i 40

SEttiNG..oiiii i 50, 80
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Presser Foot Hovering Position

AJUSTING e, 45
Presser Foot Pressure

AJUST .o 41

DiSPlaY ..o 50

SEHING i 50
Presser Foot Up/Down

BUTtON Lo 13
Presser Foots

Lower, with Knee Lifter...........cccccooeiiiiiiiie, 29
Programming

Foot Control .......ccoeeeiiiiiiii e 46

Pattern ENd .......ooovviiiiiic 45

Presser FOOt Up/DOWN ... 46

QUICK REVEISE ..o 46

Securing Stitches ... 46
Programming External Buttons ...............cccoeeieenn, 45
Programming the Button

Pattern ENd .......oovvviiiiiic 45

Presser FOOt Up/DOWN ..o, 46

QUICK REVEISE ..o 46

Securing Stitches.........oovii 46

Thread CUtter ..ovviiiiice e, 46
Q
QUICK HElp oo 23
Quick Reverse

BUTTON Lo 14
QUICK Start ..o 24
QUIlt SHECheS. ..o 52, 59
R
Raise/Lower the Feed DOg ........cccccooviiiiiiiiiiicc 41
Raising/Lowering the Presser FOOt...............cccoeeen 40
Rename

DEIETE ..o 23

Il 23

FOIAET oo 23
Reset

SETtINGS. ..o 22,97

Stitch Settings ....vooioiii 70
Reset Default Settings .........oocoooviiiiiiiiiii 70
Reset Settings .....ooovviiiiiii e, 97
S
Safety INStruCtionsS.........ccccoovviiiiiicceee e 5
Save

Embroidery Design ........cc.ccoooiviiiiiiiiiieeei 79

Personal Data...........coooiiiiiiiiic e 97

Stitch Pattern ... 49, 69
Saved Embroidery Designs

Personal Folder..........ccoovviiiiiiiie 82

TO USB SHICK. ..o, 52

USB SHICK e, 82
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Saved Stitch Patterns

Personal Folder ... 52
Saving
Embroidery Designs ...........cooviiiiiiiiiiiiieiii 93
Screen
CleanINg . ..ot 99
LOCK oo 22
Setting the Color Scheme ........ccccciiviiiiii 44
Seam Guide
AJUSE. o, 28
ATtACN Lo, 28
REMOVE ... 28
SECUMNNG 1ot 71
BUTtON L. 14
Securing Stitches
SETHINGS oo 45
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Own Stitch Pattern ......ccooooeeeiiiiiiii 52
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Saved Embroidery Designs ........cccccooevviiiiiiiinnnn.. 82
Saved Stitch Patterns ... 52
Sewing SHIChEeS ..o 82
Stitch Pattern ... 61
Selectig
Own Stitch Patterns ......cccooeeeeeiiieiiii 52
Selecting
Needle. ..o 32
Saved Stitch Patterns ..., 52
Stitch Plate ..o 32
Selection
Presser FOOt ... 40
Set Al .. 44
Set UNIt oo 48
Set Unit of Measurement...........cooovvoiiiiiiii 48
Setting
ACOUSTIC SIgNAIS ..., 43
AlGIMN Lo 44
Alarm ClocK. ... 44
BSR FUNCLIONS ... 72
ClOCK e 44
Date oo 44
Feed Dog Up/DOWN ........cooevviiiiiiiiiiiiieee, 50, 80
HOOD .. 80
Language ..o 44
Needle. ... 50, 80
Needle Stop Up/DOWN .......oooiiiiiiiiiiiiiiiiiiiie 50

Presser FOOT . ..o 50, 80
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Presser FOOt Pressure..........cocccvviviii, 50
Reminder ..., 44
Screen ColOrS .., 44
Slide-on Table ..o 27
SOUNDS ..t 43
Stitch Regulation...........cococciiiiiiii 72
Thread Change ........coooeiiiiiiiiiicee, 94, 96
TIME e 44
Setting Acoustic Signals..........cooovviiiiiiiiiie, 43
Setting an Alarm ClocK.........cccooviiiiiiii 44
Setting Reminder...........ooooiiiiiiii 44
Setting SOUNAS ....cooiiiiiiiiii e 43
Settingthe Date......oovviiiiii 44
Settings
Embroidery Speed........cccccoiiiiiiiiiii 47
Securing Stitches ... 45
SEWING SPEEA ... 45
Upper Thread Tension, Embroidery...................... 47
Upper Thread Tension, SEWiNg............cccccovvveenn. 44
Welcome MeSSage ..........ocovvvviiiiiiiiiiieeeiiiieee, 44
Sewing Light
Adjusting the Brightness ............ccooeciiiiiiiinn, 44
Switching On/Off ..., 44
SEWING SCrEEN ...iiiiiiiiiiiee e 49
AJUST ., 50
SEWING SPEEA ....iiiiiiiiiiice e 14
SEHINGS. .o 45
Size
Needle . ..o 30
Slide-on Table ... 27
AAChING .o, 27
Setting the Height........oooooiiii 27
Speed CoNtrol ... ..o 14
Start/Stop
BUTLON oo, 13
Stitch Counter.....oooiii 62
USING e 63
Stitch Density
Embroidery Design ........cccccooiviiiiiiiiiiieee 84
Stitch Pattern ..o 64
Stitch Design
Bt 75
StItCh DESIGNET ..o 74
Stitch Length
AJUSTING e, 49
QUIIt DESIGN . 48
Stitch Pattern
Combi MOde......ooiiiiiii 68
CombINING ...viiiii 68
DESING oo 52
Directional SEWING .......cccceeeiiiiiiiiiiiiiiiece, 62
DISTOM ..o 63
DUPHICAE oo 69
Bt 49, 62
File Manager......ccovviiiiie e 52
Jumbo Stitch . 62
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LOAAING 1 61
LONg SHILCh oo 62
VIFTOT o, 62
MOVE ... 68
Optimize Balance.........ccoooeiiiiiiiii 63
Pattern Repeat........cccooiiiiiiiii 62
Personal Folder ..., 52
SAVE i 49, 69
SeleCt 1o 61
Stitch Counter ... 62, 63
StItch Density.....oooeiiiiiiicc 64
Stitch Pattern Combination
Bt 68
Stitch Patterns
CombINING vvveiiici 68
OPLIMIZING.. e 63
Stitch Plate.....ooii 29
AAChING ..o, 29
Changing ...oveviiiiic e 29
DiSPlaY...ccoeiiiieiiie e 50, 80
SeleCtiNg...oo i 32
Stitch Preview
AJUSE. o, 50
Stitch Regulation
SETHING i 72
Stitch Width
AJUSE. o, 61
AdJUSTING ..o, 49
Stitching Sewing Stitches ..........cocociiiiii 82
StONNG ACCESSOTIES ..ot 27
Storing the Machine .........ccccccciviiiiii 108
Switching On/Off
Bobbin Thread Indicator..........ccccoiiiiiiiiie, 43
CaMEeIa oot 51,80
Dual Feed ... 41
LAY et 51, 81
Light in Bobbin Area............ooooiiiiii, 50, 80
Maching ..., 25
Sewing Light......oooiiiii 44
Upper Thread Indicator .........cccccoeeviiiiiiiiinnn, 43
WWIFI o, 44, 50, 80
Switching On/Off the Camera..........cccccoevveenn.. 51, 80
T
Tapering Stitches
Bt 66
Technical Specifications..........c...cccooeviieieiiicee, 109
Text
Bt 92
EAiting ..o 92
LiNe SPaCING ...ooiiviiiiiiii e 92
SPACING i 92
SEYIING oo, 92

TranstormM ..o 92
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Thread

DiStANCE ... 94
Thread Change

SEHING i 94, 96
Thread Cutter

BUTtON Lo 13
Thread Guide, Retractable............cccoooviiiiiiiiiene, 33
Thread Lubrication Unit..........cocociiiiiiiiii, 36
Threading

Bobbin Thread ............ooooiii 38

Horizontal Spool Pin..........cccoovvviiiii, 37

Single Needle ........cocoeiiiiiiiii 34

Special Threads ......cccoooiiiiii 36

Triple Needle.........ooooiiiiiiiiicc e, 36

Twin Needle.....oooiiiiiii e, 36
Threading Special Threads........cccccooovvviiiiiiiiee, 36
Threading the Triple Needle.............ccoocviiiiiiiiiene, 36
Threading the Twin Needle..............coooeiiiiiiiiicen, 36
TIMIE e 50, 80

SEHING i 44
TOUCh GESTUIES ..., 20
Troubleshooting .........coovviiiiiiie e, 102
u
Update Firmware...........cooovveeiiiiiiceeeeeeee e, 97
Update Software ..........ccoovveeeiiieeeeeeeeee e, 97
Upper Thread

Threading ....ooovveeeiiiiiee e 34

Threading the Single Needle...............cc..cooie. 34

Threading the Triple Needle ..............cooeeiviiinn. 36

Threading the Twin Needle .............c.cooeeiviirnn. 36
Upper Thread Indicator...........ccoooeeiiiiiiiiiicec, 43
Upper Thread Tension

Display, SEWING ......c.oooiiiiiiiiiieiieee e, 50

Display, Stitching.........ccccooviiiiiii, 80

Settings, Embroidery ..........cccccoooiiiiiiiii, 47

Settings, SEWING ... 44
USB STICK oo 52
Use Of Data......couviiiiiieiiiieee e 43
User Interface Operation

MOUSE e 20

ToUCh GESTUIES ... 20
User Manual ........oooooiiiiiiiiii e 24
W
WiFi

Connecting to a Network............cccooeiiiiii, 44

ConNectiVity......ooove 50, 80

Switching On/Off ..., 44, 50, 80
WIFI NETWOTK ..o, 44
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